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MULTI-AD CREATOR2™ REFERENCE MANUAL
Welcome to The Multi-Ad ™ Reference Manual.
This manual provides detailed descriptions of the com-
mands, features, and options available in .

The manual is divided into two main chapters, but it also
contains several appendices. Each chapter provides
explanations of specific features. The chapters include:

• Chapter 1—Creator2 menus
Chapter 1 provides an in-depth explanation of
every menu, submenu, command, and dialog box
that you can access from the pull-down menus at
the top of the screen.

• Chapter 2—Creator2 palettes
To make your work as easy as possible, 
places key features on palettes. These palettes are
floating windows that you can position anywhere
in the Document Window. If you like, you can even
hide palettes until you need them. 

A variety of palettes exists to help you with your
tasks. One palette contains “tools” for creating or
manipulating elements, like ovals or text blocks.
Other palettes let you modify text characteristics
or change object dimensions. You decide what
palettes you need for any particular document.

A basic understanding of the Macintosh computer is very
important before beginning this manual. If necessary,
familiarize yourself with such terms as clicking, dragging,
pull-down menus, and the desktop before proceeding.
Consult your Macintosh documentation if you have any
questions about these or other Macintosh basics.

Keyboard commands

You can always access several of 's special fea-
tures through the keyboard. You cannot access hese fea-
tures through the menus or palettes. Be aware that many
of these keys—such as the Tab key—operate differently if
you press them after placing an insertion point inside a
text block. For the most part, only use these keys when
you have the Arrow tool selected. 

Some of these keyboard command let you select elements
within a spread (a set of pages). Generally,
arranges elements in a front-to-back order. The keyboard
commands let you cycle through the element order.

Keyboard Shortcuts

Many Creator2 features have
keyboard shortcuts. T h e s e
keystrokes let you activate a
command from the keyboard.
The assigned shortcut keys
appear to the right of a com-
mand’s name on a menu.

For instance, to create a new
file without pulling down the
File menu, press the
Command key and the N key.
Note that the N appears capi-
talized by convention only.You
should not press the Shif t key
unless the keyboard com-
mand says to do so.

A modifier key refers to a key
you press in conjunction with
another key or a mouse click.
The modifier key changes the
effect of the key stroke or the
mouse click. The abbrevia-
tions used in the documenta-
tion include:

Command key Cmd

Shif t key Shif t

Option key Opt

Control key Ctrl
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The special keyboard commands include:

• Tab ( )
Pressing Tab deselects the current element and
selects the next element.

• Shift-tab ( - )
Pressing Shift-tab adds the next element to the
current selection.

• Option-tab ( - )
Pressing Option-tab deselects the current element
and selects the previous element.

• Shift-option-tab ( )
Pressing Shift-option-tab adds the previous ele-
ment to the selection. Note that you must have
selected a partially obscured element to add a
higher element to a selection.

• Cmd-tab ( )
Pressing Command-tab activates the Text tool
when you have another tool selected.

• Control-tab ( )
Pressing Control-tab activates the Arrow tool
when you have another tool selected.

• Control ( )
Holding Control activates the Hand tool for as long
as you press the key. The Hand tool lets you scroll
the entire contents of the Document Window. With
the Hand tool, you can view elements currently
outside the visible Document Window without
resorting to the scroll bars. You can press the Hand
tool's shortcut key with any tool on the Tools
palette selected.

Using the Hand tool

1. Press and hold the Control key. The pointer
changes into a Hand pointer.

2. Click anywhere on the screen and drag in any
direction. Notice that the contents of the entire
window move, not just selected elements.

3. Release the mouse button. The area you
stopped dragging becomes the center of the
Document Window.
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• Control-shift ( )
Holding Control-shif t activates the Magnification
tool. The Magnification tool lets you increase the
display to the next view scale interval. The view
scale intervals include: 25 percent, 50 percent, 75
percent, 100 percent, 150 percent, 200 percent,
300 percent, 400 percent, and 800 percent. You
can press the Magnification tool's shortcut keys
with any tool on the Tools palette selected.

Using the Magnification tool

1. Hold Control-Shif t . The pointer turns into a
Magnification glass with a plus (+) symbol.

2. Click on the area you want to zoom in on, or
use the Magnification tool to draw a selection
box around the section of the screen you want
to magnify.

When using the Magnification tool, you zoom in
on the elements in the Document Window, but
your view remains centered on the point you
clicked. Dragging a selection rectangle with the
magnifying glass increases the scale of the
selected area to fit the Document Window.

• Control-option ( )
Holding Control-option activates the
Demagnification tool. The Demagnification tool
lets you reduce the display to the next view scale
interval. The view scale intervals include: 25 per-
cent, 50 percent, 75 percent, 100 percent, 150 per-
cent, 200 percent, 300 percent, 400 percent, and
800 percent. You can press the Demagnification
tool's shortcut keys with any tool on the Tools
palette selected.

Using the Demagnification tool

1. Hold Control-option and move your pointer to
the Document Window. The pointer turns into
a magnifying glass with a minus (-) symbol.

2. Click in the Window to zoom out.
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CHAPTER 1: MULTI-AD CREATOR2 MENUS
This chapter discusses the application menus
in order from left to right. Some menus—like the File,
Edit, Font, Style, and Size menus—may seem familiar,
but has several menus unique to itself. These
include the Elements, Arrange, Document, Format, and
View menus.

The Reference Manualhas a section devoted to each
menu. The title of each menu section has a line above
and below  it. The menu section title appears offset from
the main text. An explanation of the menu follows each
menu name.

Each menu command or submenu heading also appears
with a line above and below it. Each heading also
appears offset from the main text. If a menu command
has a keyboard equivalent, the keyboard symbols appear
next to the command name. Menu items appear in the
same order in which they appear on the menu—from top
to bottom.

A description of each command or submenu follows the
menu item name. Some of these descriptions can be
lengthy and are divided into several sections. The head-
ings of important sections appear above a line and offset
from the main text.

If an ellipsis (…) follows a menu command, choosing it
opens a dialog box that contains even more options.
Additional explanations of these dialog boxes accompany
the menu descriptions. In this way, every item in each

menu is fully documented.

You can differentiate references to menus, submenus, and
buttons from command keys, check boxes, pop-up menus,
and other options. Menus, submenus, and button refer-
ences appear in the Chicago font. Command keys, check
boxes, pop-up menus, and other options appear in the
Geneva font.
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The New… command lets you create a new document.
Choosing the New… command from the File menu opens
the New Document dialog box. 

The dialog box's options include:

• Number of pages
The Number of pages text field lets you decide
how many pages you want in a document.

• Number pages from
The Number pages from text field lets you start
counting a document’s pages from a specified
number. For example, if you enter 5 into the
Number pages from text field, lists the
first page of the document as page 5, the second
page appears listed as page 6, and so on.

The File Menu

The File menu lets you access commands to
print hard copies of your documents, save your docu-
ments to disk, create new documents, or import previ-
ously saved documents.

In addition to these typical File menu features, the
File menu offers several other options. For

example, the File menu has commands that
let you add graphics or text from other applications to
your documents. A full description of the commands in
the File menu follows.

New… ( N)
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• Width
The Width text field lets you specify the desired
width of a new document.

• Height
The Height text field lets you specify the desired
height of a new document.

• Choose Page Size…
The Choose Page Size… button opens the Choose
a Size dialog box. The Set pop-up menu lets you
choose a particular grouping of document sizes. 

Each set's document sizes appears in the scroll
list. The available sets include a Standard
Advertising Unit (SAU) set…
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a Television Magazine Advertising Unit (TMAU)
set…

and an Other set, which includes commonly used
document sizes, like US letter.

To pick a document size, double-click on a size in
the scroll list, or click on a document size and
then click the OK button. To discard a selected
document size and return to the New Document
dialog box, click the Cancel button. You can
choose page sizes from three different sets of
sizes. 



8 Multi-Ad Creator2

• Facing Pages
Selecting the Facing Pages check box tells

to create right and left-sided pages. 

When you select the Facing Pages check box, two
radio buttons become activated. Click the Lef t
Page radio button if you want the first page in a
document to appear as a left-hand page. Click the
Right Page radio button if you want the first page
in a document to appear as a right-hand page.

• Make default master spread
Selecting the Make default master spread check
box tells to automatically create and
link a master spread to each page in your docu-
ment. When you modify this master spread, the
application places the elements of the master
spread on all linked pages.

For more information, see the Master Spreads…
command entry in the Document menu section.

• Use Default Document Settings File
The Use Default Document Settings File check box
lets you use your own specified default settings
each time you create a new document.
Deselecting the check box directs to
use its standard default settings.

For more information about creating your own
default document settings, see the Save Default
Document Settings command entry in the File
menu section.
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Open… ( O)

The Open… command lets you open a saved document.
After choosing Open…, a directory dialog box appears. 

To find and open a saved document

1. Locate the saved file in the directory dialog box. You
may have to change folders or volumes by selecting
the pull-down directory option or clicking on the
Desktop button. Then select the appropriate volume
(disk, hard drive, networked volume, etc.).

2. Scroll through the list of files in the appropriate
folder. Click on the name of the file you wish to open. 

Click the Show Preview check box at the bottom of the
directory dialog box. This displays a thumbnail of the
selected file in the Preview section. 

3. Double-click on the filename to open the file. You can
also click on the filename and then click the Open
button.

Click the Cancel button if you decide not to open a
file.

You can keep as many Document Windows open at one
time as your memory allows.

Note: Do not increase the amount of memory allocated
to unless you receive a dialog box that
expressly tells you to do so.

The Mac Filing System

The Macintosh hierarchical fil-
ing system (HFS) organizes
your documents much like
traditional filing systems. You
can create folders to hold
your files. You can then place
these folders inside other
folders to create multiple filing
levels.

Directory dialog boxes let you
move quickly through filing
levels from within programs.
By choosing an entry from the
directory name menu, you can
move into a higher level folder.

By double-clicking on a folder
in the scroll list, you can move
into a lower level folder. You
can also move into a lower
level folder by clicking on a
folder and then clicking the
Open button.



10 Multi-Ad Creator2

Close ( W)

The Close command lets you remove the active window
from the screen. You can also click on a window’s close box
to remove the window from the screen. To close a nonac-
tive window, click on that document’s window to make it
active. You can also make a window active by choosing the
document’s name in the View menu.

If you close all the windows for a document, but you
haven’t saved it, a dialog box appears asking if you want
to save the document. You get the same message if you
make changes to a document but haven’t saved them. If
you want to save the document, click the Save button.
Otherwise click the Don’t Save button to close the file or
the Cancel button if you want to return to the document.

Save… ( S)

The Save… command lets you place the contents of the
active window on a disk for later retrieval. 

Saving a new document

1. Choose the Save… command from the File menu. A
directory dialog box appears.

2. Enter a name for your document in the Save the 
document as field.
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3. Select a location to save the file using the directory
dialog box. The directory dialog box uses the
Macintosh Hierarchical Filing System (HFS). For
more information, see The Mac filing system sidebar
with the Open… command entry or your Macintosh
documentation.

4. Click the Save button.

Saving an existing document

To save changes to an existing file, choose Save from the
File menu. This stores any modifications you made to the
disk. Each time you save an existing file, your changes
replace the previously saved version. To maintain an
older version of a document, use the Save As… command.

Frequently save your files

If you lose power or your computer crashes while you work
on a document, you may lose all your work. For this rea-
son, you need to save your work frequently. Decide how
much time you are willing to spend recreating lost work
and then save your file based on that time. If you can
spend 10 to 15 minutes recreating lost data, then save
your file every 10 to 15 minutes. Start saving after every
major operation, such as a complicated place session.

Save As…

The Save As… command works much like the Save… com-
mand, but lets you modify the name of a file every time you
save. In this way, you can preserve earlier versions of a file
or save a file to a different location. 

Saving a new version of a document

1. Choose Save As… from the File menu. A directory
dialog box opens with the name of the document high-
lighted.

2. Enter a new name for the document, or modify the
current name. To enter a new name, highlight the
current document name and then type in the new
name. You may want to add a date or a version num-
ber to the current document name. 

3. Select a location to save the file—if different from the
original—using the directory dialog box. 

4. Click the Save button.
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Save Default Document Settings

The Save Default Document Settingscommand lets you
open new documents with your own default settings
rather than ’s built-in defaults. Every time you
choose New… from the File menu, the new document
opens with your specified defaults. The settings you can
save include:

• All document settings

• All colors on the Colors palette

• All defined element styles

• All defined type styles

• All defined paragraph styles

• All defined style models

• All files on the Files palette

When you choose Save Default Document Settings from
the File menu, saves a file called Default
Document Settings in the Add-ons folder in the Creator2
folder. However, the filename on the document title bar
does not change. The Save Default Document Settings
command only saves your document settings. It does not
save any other information. 

Saving a default document settings file

1. Open or create a document.

2. Make the desired changes to the document settings.

3. Choose Save Default Document Settings from the
File menu.

Changing an existing default document

Open a document and make the desired setting changes.
Choose Save Default Document Settingsfrom the File
menu. This replaces the old file with the newer version.

Note: You can bypass your default document settings by
deselecting the Use Default Document Settings File
check box in the New Document dialog box in the
File menu.
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When you place EPS, JPEG, GIF, TIFF, or other graphic
file formats, those files do notbecome part of the docu-
ment. Instead, a low resolution representation of the
graphic image appears in the file’s place. 

When you save the document, also saves a ref-
erence to the graphic file’s location. By saving a reference
to the graphic file and not actually adding the graphic
information to the document, you keep your document
files small and manageable.

About Placing Graphic Files

Place Graphic… ( I)

The Place Graphic… command lets you import graphic
files into the Document Window. You can also place
graphics by dragging the graphics file from the
Macintosh desktop into a document.

lets you place:

• EPS files (including DCS 1 and DCS 2 files)

• JPEG files

• GIF files

• TIFF files

• MacPaint files

• Border files

• RIFF files

• Adobe Photoshop 2.0 and Photoshop 3.0 files

• PICT files

Note: For a description of each file format—including a
list of accepted TIFF formats—see Appendix B.
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To print a document with placed graphics, the graphic
files must reside on a currently available volume. If you
do not have your graphic files on hand when you print
your document, the graphic images do not print. Instead,
graphic place holders appear in place of the images on
the printout.

Note: If you place an EPS file that contains fonts you do
not have installed, displays a warning
dialog when you try to print the document with
the graphic.

Placing a graphic file

1. Choose the Place Graphic… command from the File
menu. A directory dialog box appears.

2. Locate the graphic file you wish to place.

3. Set the Place Graphic… options. The options you can
select include:

• File Types
This pop-up lets you set the graphic file types
that appear in the scroll list. The File Types
pop-up initially reads All Types , but you can
change the setting to read: MacPaint , Creator2
Border , TIFF , JPEG , EPS , Compuserve ® GIF ,
Adobe Photoshop ®, and Macintosh PICT .

Selecting a file type tells to only dis-
play filenames of that type. To list two or more
file types at once, make your selections from
the pop-up menu one at a time. Each selected
item appears on the pop-up. 
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• Show Preview
This option tells to display a pre-
view of the selected filename. can
display thumbnail previews of Paint, PICT,
EPS, GIF, TIFF, and JPEG files, but only if
the program that created those files also made
thumbnail previews.

Note: When you export EPS, GIF, and TIFF
files, automatically saves a
thumbnail preview with the file.

• Place with cursor
This option lets you place a graphic file with a
mouse click. When you select this option and
then click the Place button, your arrow pointer
turns into a crosshair with a graphics symbol. 

Position the pointer where you want the graphic
to appear. Then click and drag a rectangle.

scales the graphic to appear in the
rectangle you created. To scale the graphic pro-
portionally, press the Shif t key while clicking
and dragging. You can also click on the screen to
place the center of the graphic, in its original
size, at the click point. 

• Add file to palette
This button places the name of the selected file
onto the Files palette. Choosing this button
does not immediately import the file and keeps
the Place Graphic dialog box on-screen. Click
the Done button to exit the dialog after you
have added a graphic to the Files palette.

• Add all
This button places all the files in a particular
folder onto the Files palette. Choosing this
button does not import any of the files in the
directory and keeps the Place Graphic dialog
box on-screen. Click the Done button to exit
the dialog after you have added all the graph-
ics to the Files palette.

3. Double-click on the filename. You can also click the
filename and then click the Place button to place the
graphic in the center of the Document Window.
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The Create new text flow radio button lets you place the
selected text file in a text block centered on the document
page. automatically creates a new text block
for the selected file. If you place your cursor into a text
block before selecting Import Text…, the radio button
reads Insert into active text flow .

Creating a New Text Flow

Multi-Ad Creator2

The Import Text… command lets you place a word pro-
cessing or text file in your Document Window. Choosing
the Import Text… command from the File menu opens
the Import Text directory dialog box.

uses the Translation Manager/Mac Easy Open
to import word processing files. The Translation Manager
gives you access to MacLink Plus translators, which sup-
ports a large number of word processing applications.

Import Text… ( J)

Placing a graphic file from the desktop

1. Open the document in which you want to place a file.

2. Drag the graphic file’s icon into the Document
Window, and the window becomes highlighted. 

3. Release the mouse button when you have positioned the
graphic file’s icon in its proper place in the Document
Window. now imports the graphic.

If the Document Window does not highlight when you
drag the graphic file’s icon onto it, cannot
import that file type.
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Breaking Text

The Break Tex t radio button in the Import Text dialog
lets you import a text file in segments. This lets you place
sections of the same text file in different text blocks.

Click the Break Tex t radio button in the Import Text dia-
log box and click the Place button. This displays the
Break Text dialog box.

Placing Text with the Cursor

When you import a text file with the Place with cursor
radio button selected, lets you determine the
location and size of the block the text appears in with your
pointer. This option changes your arrow pointer into a
crosshair with a text block symbol. You can use the Place
Text pointer to position the text in two different ways:

• Click and drag the Text Block pointer to create a
text block. The text file automatically flows into
the resulting text block.

• Press the Command key and click on an existing
text block to flow the text file into that block.

After you have imported a file, you can modify the block
or its text however you wish.
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In this dialog, you need to specify how you want to break
text blocks. You can break a text file after each instance
of a certain delimiter or a certain number of paragraphs.

Formatting and breaking text with delimiters

When you select the At delimiter radio button in the Break
Text dialog box, you need to enter a special character into
the At delimiter text field. This character, a delimiter, tells

where to break a text file. If you like, you can
make delimiters of more than one character. After you
enter your delimiter, a line appears below the field indi-
cating how many text blocks result from your break.

To place delimiters in a text document, you need to open
a text file in the program that created it and place your
delimiters at the points where you want to break the file.
You must enter the same delimiter characters in the
Break Text dialog box that you entered into the text file. 

When you choose your delimiter, select a unique character
or characters. A delimiter should not appear in a document
as anything other than a delimiter. breaks text
at every occurrence of a delimiter.

Some standard delimiters include \, ^, and >. Since you
might use these characters as something other than a
delimiter, lets you set delimiters of more than
one character, such as <BREAK> .

Formatting and breaking text using the Every ____

paragraphs

When you select the Every ___ paragraphs radio button in
the Break Text dialog box, you must enter the number of
paragraphs needs for breaking the text file.
After you enter the number of paragraphs, a line appears
below the field indicating how many text blocks result. If
the resulting number does not match the number of text
blocks you want, modify the text file in the application
that created it.

When you create a text block, the specified number of
paragraphs flow into the block in their correct order.

defines a paragraph as any text followed by a
return character. The text following the last return char-
acter is also considered a paragraph.
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Formatting imported text

If you break imported text, also lets you for-
mat that text. You can format broken text in one of three
ways:

• Format as is
The Format as is radio button imports the
selected file as text. No formatting appears in the
imported text.

• Apply tags
The Apply tags radio button tells to
automatically apply any tags it finds in the file.
To use this feature, you must enter tags into the
text document before importing it. For more
information on tags, see the Apply Tags entry in
the Format menu section.

• Apply style model
The Apply style model radio button lets you apply
one style model to the entire imported text file.
Choose the style model from the Apply style
model pop-up menu.

Placing text by hand

If you wish to create your own text blocks for the
selected text file, click the Place by hand radio button
located below the Break Text and Format areas. Click
the OK button in the Break Text dialog box. The Break
Text palette opens and your pointer changes into a
crosshair with an A (+A). The pointer indicates that

has loaded the text into your pointer. When
you draw a text block, the loaded paragraph automati-
cally flows into it. 
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The Break Text palette displays the paragraph you cur-
rently need to place. The palette also tells you how many
paragraphs you have left to place.

Breaking text with the Make array of blocks feature

Choosing the Make array of blocks radio button, below
the Break Text and Format areas, lets you arrange text
in an array. When you select this option, the bottom half
of the Break Text dialog box becomes active. The options
in this section include:

• Sequence
The Sequence buttons let you set a pattern for text
block placement. With this option, you determine
the order in which the paragraphs of the imported
file appear in the array.

• Blocks in a row
The Blocks in a row text field lets you enter the
number of blocks you wish in each row.

• Block size
The Block size option lets you set the size of the
text blocks. By entering values into the Width and
Height fields you determine the size of each text
block created. If you don’t enter any values into
these fields, prompts you for informa-
tion before creating any text blocks.

• Spacing
The Spacing option lets you set the amount of
space that separates one text block from another.
You can set both the horizontal and vertical spac-
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ing. If you don’t enter any values into these fields,
prompts you for information before

creating any text blocks.

• Group
The Group option lets you put the created text
blocks in a group. This allows you to move a num-
ber of text blocks as one element.

• Fit to text
The Fit to tex t option tells to shrink
the text block to the size of the text. This option
lets you create a text block with a larger width
and depth than necessary. When the text flows
into the text block, the block automatically
adjusts to fit the amount of text.

The Fit to tex t option may prove helpful if you
have different sized text blocks to place. The
option lets you place text in orderly rows and
columns while the text blocks vary in length and
width.

Note: The Fit to tex t option only shrinks a text
block to fit around the available text. It
does not enlarge text blocks.

When you finish setting your text break options, click the
OK button. automatically creates text blocks
and imports the selected text file.
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The Export submenu lets you export spreads, text, or ele-
ments in several different file formats. This feature helps
you place graphic or text files from into other
applications or documents.

The different export options available appear on the
Export submenu. You can export selected elements or
spreads as a TIFF, GIF, EPS, or text file.

For a full description of the file types sup-
ports, see Appendix B.

TIFF…

The TIFF… command lets you export spreads or elements
as a TIFF file, a bitmap format that supports black and
white, grayscale, and color images. 

Choose the TIFF… command in the Export submenu of
the File menu to open the Export TIFF dialog box.

Export
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You can define the file’s attributes by selecting the
options in the dialog box. The Export TIFF dialog box
options include:

• Color
The Color pop-up menu lets you specify a color
depth for the exported file. You can choose from
Millions of Colors , 256 Colors , 256 Grays , and
Black and Whit e. The Black and Whit e option
makes smaller files than the 256 Grays , 256
Color , or Millions of Colors options.

• Resolution
The Resolution pop-up menu lets you specify the
resolution of the exported file. Remember that
the higher the resolution, the larger the file and
the more memory required. You can choose from
72 dpi , 144 dpi , and 288 dpi options.

Note: automatically saves a thumb-
nail preview—which you can view in

’s Place dialog box—whenever
you export a TIFF file.
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• Export
The Export pop-up menu lets you choose the ele-
ment or area of a document that you need to
export. The Export pop-up menu's options
include:

♦ Selection
The Selection option lets you export only those
items you have selected in your document.

♦ Spread
The Spread option lets you export the active
facing pages of a Document Window as a TIFF
file. Since TIFF files can only save one page in
each file, you cannot save an entire document
as a TIFF file.

♦ Right Page
The Right Page option lets you export the
active right page of a Document Window as a
TIFF file. Since TIFF files can only save one
page in each file, you cannot save an entire
document as a TIFF file.

♦ Left Page
The Left Page option lets you export the active
left page of a Document Window as a TIFF
file. Since TIFF files can only save one page in
each file, you cannot save an entire document
as a TIFF file.

GIF…

The GIF… command lets you export a document or an
element as a GIF file, a bitmap format created by
Compuserve® that minimize file transfer times from on-
line services. 

Choose the GIF… command in the Export submenu of the
File menu to open the Export GIF dialog box.
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You can define the file’s attributes by selecting the
options in the dialog box. The Export GIF dialog box
options include:

• Color
The Color pop-up menu lets you specify a color
depth for the exported file. You can choose from
256 colors (8 bit), 256 grays (8 bit), and Black
and Whit e (1 bit). The Black and Whit e option
makes smaller files than the 256 grays or 256
color options.

• Size
The Size pop-up menu lets you specify the size of
the exported file. Remember that the higher the
size, the larger the file and the more memory
required. You can choose from Full Size , 2x Size ,
and 4x Size options.

Note: automatically saves a thumb-
nail preview—which you can view in

’s Place dialog box—whenever
you export a GIFfile.
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• Export
The Export pop-up menu lets you choose the ele-
ment or area of a document that you need to
export. The Export pop-up menu's options
include:

♦ Selection
The Selection option lets you export only those
items you have selected in your document.

♦ Spread
The Spread option lets you export the active
facing pages of a Document Window as a GIF
file. Since GIF files can only save one page in
each file, you cannot save an entire document
as a GIF file.

♦ Right Page
The Right Page option lets you export the
active right page of a Document Window as a
GIF file. Since GIF files can only save one
page in each file, you cannot save an entire
document as a GIF file.

♦ Left Page
The Left Page option lets you export the active
left page of a Document Window as a GIF file.
Since GIF files can only save one page in each
file, you cannot save an entire document as a
GIF file.

• Save using interlaced row ordering
The Save using interlaced row ordering check box
lets you download an on-line graphic in waves,
instead of line-by-line. This lets you view a repre-
sentation of a graphic quickly. You might want to
select this check box only if you wish to create
graphics for web browsing.

EPS…

The EPS… command lets you export elements, pages, or
spreads as an EPS file, which describes the image using
PostScript. This lets printers recreate the image regard-
less of resolution. Choose the EPS… command, in the
Export submenu of the File menu, to open the Export EPS
dialog box.
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You can define the file’s attributes by selecting the
options in the dialog box. The Export EPS dialog box
options include:

• Preview Type
The Preview Type pop-up menu lets you select the
previewing mode for an EPS file. Choices include
Color/Grayscale , Black & Whit e, None , PC Black &
White (EPSP) , PC Grayscale (EPSP) , and PC Color
(EPSP) .

• Method
The Method pop-up menu lets you tell the appli-
cation what type of EPS file to create. The options
available include Composit e, DCS v1.0 (5 files),
and DCS v2.0 (1 file).
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The Composit e option creates a PostScript file
that contains all the color information of a docu-
ment. This option creates one stand-alone file.

The DCS v1.0 option creates four preseparated
files (one file for each of the four process color
plates—cyan, magenta, yellow, and black) and a
composite file suitable for placement. Any spot
colors used in the document are included in the
composite file. 

The DCS v2.0 builds only one file which contains
preseparated sections for all relevant plates
(including spot colors). 

Note: Not all applications support DCS 2. If you
intend to place a DCS 2 EPS file in
another application, make sure that appli-
cation supports DCS 2.

Trapping information included with the EPS files
varies with the option selected in the Method pop-
up menu. In , composite EPS files
include overprint information (set in the Print
Attributes dialog box). This means that the appli-
cation includes that information in the EPS file.
To include information on chokes and spreads,
however, use the DCS v1.0 or DCS v2.0 options.

• Export
The Expor t pop-up menu lets you choose the ele-
ment or area of a document that you need to
export. The Expor t pop-up menu's options include:

♦ Selected items only
The Selected items onl y option lets you export
only those items you have selected in your doc-
ument.

Note: If you want to warn you of
any text that has flowed beyond the
boundaries of text blocks, select the
Check for text overflow: on exporting as
a graphic option in the Tex t panel of the
Preferences dialog boxin the Edit
menu.
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♦ Spread
The Spread option lets you export the selected
facing pages of a Document Window as an EPS
file. Since EPS files can only save one page in
each file, you cannot save an entire document
as an EPS file.

♦ Right Page
The Right page option lets you export the
selected right page of a Document Window as
an EPS file. Since EPS files can only save one
page in each file, you cannot save an entire
document as an EPS file.

♦ Left Page
The Left page option lets you export the
selected left page of a Document Window as an
EPS file. Since EPS files can only save one
page in each file, you cannot save an entire
document as an EPS file.

• Include Fonts
The Include Fonts pop-up menu lets you encapsu-
late fonts into the EPS file. The options in the
Include Fonts pop-up menu include:

♦ None
The None option does not encapsulate any ref-
erenced fonts into the EPS file. When you
select this option, if the next person who opens
the EPS file does not have the correct fonts, a
dialog box appears notifying the user of the
missing fonts.

♦ All
The All option encapsulates all referenced
fonts into the EPS file. With this option
selected, the next person who opens the EPS
file does not have to worry about missing
fonts.

♦ All but base 13
The All but base 13 option encapsulates all
referenced fonts, except the 13 fonts that exist
on all PostScript laser printers. With this
option selected, the next person to open the
EPS file does not have to worry about missing
fonts if they use a PostScript printer.
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♦ All but base 35
The All but base 35 option encapsulates all
referenced fonts, except the 35 fonts that exist
on all second generation PostScript laser print-
ers. All PostScript-capable laser printers made
since 1989 contain the base 35 fonts.  All color
PostScript laser printers also contain the base
35 fonts. With this option selected, the next
person to open the EPS file does not have to
worry about missing fonts if they use a
PostScript printer.

Note: Encapsulating fonts into EPS files
makes the files larger.

• Use Binary Encoding 
The Use Binary Encoding check box lets you save
sampled image files using binary, rather than
hexadecimal, encoding. This can result in
smaller—possibly 50 percent smaller—EPS files
that print significantly faster. However, not all
networks and RIPs support binary encoding. If in
doubt, leave this option unselected.

• Use Level 2 PostScript
The Use Level 2 PostScript ® check box lets you
use PostScript Level 2 commands to create an
EPS file. 

If you always use PostScript Level 2 printing
devices, creating an EPS file with Level 2 com-
mands improves printing performance and speed.
However, saving an EPS file with Level 2 com-
mands introduces a Level 2 device dependency
into the graphic. As a result, you may experience
much slower printing, or PostScript errors, if you
try to print a Level 2 PostScript EPS file with a
device other than a PostScript Level 2 printer.

• Use Color PostScript
The Use Color PostScript check box generates
PostScript code that includes all the color infor-
mation for the exported graphic in the EPS file. If
you do not select this check box, 
exports all your EPS files as black and white
images.

• Use Resolution Limiting
The Use Resolution Limiting check box lets you
specify the resolution of any graphic images
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(TIFF and RIFF) contained in the file you want to
export. For instance, if you know that your final
printing device prints at a resolution of 1200 dpi,
you can limit the graphics to 1200 dpi in the Limit
t o: text field.

Unlike the Limit Resolution t o option in the Page
Setup dialog box in the File menu, 
doesn't get a default for the Use Resolution
Limiting field from a PPD. You must enter a num-
ber in the Limit to: text field.

Limiting the resolution of image graphics in an
EPS file yields a smaller EPS file that prints
faster. However, you may get some loss of quality
depending on the settings used, the graphics
included, and the printer type you use.

• Use flatness limiting
Selecting the Use flatness limiting check box lets
you set the number of lines used by PostScript
devices to recreate graphics. PostScript recreates
curved segments by linking series of straight
lines. The the value in the Limit t o text field
determines how closely the straight line segments
approximate the curve.

Values can range from 0.2 to 100. In general,
enter a flatness setting from 8 to 10 when using
high resolution (1200 to 2400 dpi) printers; enter
a flatness setting from 1 to 3 when using low res-
olution (300 to 600 dpi) printers. If you do not
select the Use flatness limiting check box,

uses the printer ’s default setting.

• Always add OPI comments for TIFF files
The Always add OPI comments for TIFF files check
box lets you export only those parts of a document
that are not in TIFF format. If you use OPI (Open
Prepress Interface), sends comments
that refer to the actual TIFF data. If you don’t
use OPI, the TIFF information does not save.

• Omit PostScript for TIFF files
The Omit PostScript for TIFF files check box lets
you remove any PostScript information contained
in TIFF files.
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• Substitute OPI comments for EPS files
The Substitute OPI comments for EPS files check
box lets you export only those parts of a document
that are not in EPS format. If you use OPI (Open
Prepress Interface), sends OPI com-
ments in place of EPS data. If you don’t use OPI,
the EPS information does not save.

Some important notes

When exporting an EPS file, you need to remember some
additional concepts:

First, the new file becomes a graphic and is no longer an
editable document file. You can only crop, resize, rotate,
and so forth.

Second, the exported EPS file does not replace your exist-
ing document file. Keep both your new EPS file and the
original document in case future changes
become necessary.

Third, when using the DCS (Desktop Color Separation)
v1.0 option, you create five files. For example, if you
export the contents of an existing document to a file
named Color Puppy Graphic , the DCS option creates the
following five files:

1. Color Puppy Graphic (composite file, used for placing
into other documents/applications)

2. Color Puppy Graphic.C (for cyan)

3. Color Puppy Graphic.M (for magenta)

4. Color Puppy Graphic.Y (for yellow)

5. Color Puppy Graphic.K (for black)

Only the composite file contains a preview image. Do not
place individual separation files into application programs.

If you use the DCS v2.0 option, you create only one file,
but it contains all the separation information, including
trapping.

Note: Not all applications support DCS 2. If you intend
to place a DCS 2 EPS file in another application,
make sure that application supports DCS 2.
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Text…

The Text… command lets you export your document text,
or portions of your document text, in one of several differ-
ent formats. Choose the Text… command, in the Export
submenu of the File menu, to open the Export Text dia-
log box.

The options in the Export Text dialog box include:

• Export text as…
The Export text as… pop-up menu lets you choose
the file format in which you want to save your
text. You can select from Creator2 Tex t ,
SimpleTex t , and RTF Styled Tex t options.

Finally, Export as EPS creates a single, stand-alone piece
of art that you can place in other documents using a vari-
ety of desktop publishing programs (including

). This EPS file is not a document;
it is a graphic file in EPS format.
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♦ Creator2 text
The Creator2 tex t option lets you export text
in the format native to the application. Other

users can open text files
with no loss of formatting. 

♦ SimpleText
The SimpleTex t option lets you export text in
an extended plain text format. You can import
SimpleText documents into a large number of
word processors and desktop publishing pro-
grams. However, most applications ignore
SimpleText formatting attributes and import
documents as plain text. 

♦ RTF Styled Text
The RTF Styled Tex t option lets you import for-
matted text into a large number of word
processor and desktop publishing programs.
Most applications support RTF and you can
translate it into other formats using the
Macintosh Translation Manager/Mac Easy
Open.

• Entire document
The Entire document radio button lets you save
all the text in your document to a text or word
processing file format.

• Active text flow
The Active text flow radio button lets you save all
the text in an active text block to a text or word
processing file format. 

Note: The Selected flow radio button not only
exports the text in the active text block, but
it also exports all text in linked blocks.

• Selection only
The Selection onl y radio button lets you save any
highlighted text to a text or word processing file
format.
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The Page Setup… command lets you set a variety of page
attributes, such as page orientation, paper size, reproduc-
tion scale, and more. To find out what page setup options
are available on your printer, choose the Page Setup…
command to open the Page Setup dialog box. 

The appearance of the Page Setup dialog box depends
mainly on what printer driver you have installed in your
System Folder and selected in the Chooser. In addition,
each printer driver includes page setup options. For more
information about your Page Setup dialog layout and
options, see your printer driver documentation.

adds some page setup options to the Page
Setup dialog box that give let you control features unique
to this application. Some of these features only support
PostScript printers. For this reason, different Page Setup
dialog box sections exist. One section covers the features
available on non-PostScript printers (usually referred to
as QuickDraw printers). Another section covers the fea-
tures available on PostScript printers. 

In the following illustrations, this Reference Manualuses
the StyleWriter II printer driver to provide an example of
the application’s page setup options for QuickDraw print-
ers.  This Reference Manualalso uses illustrations of
Apple's LaserWriter 8 printer driver to provide an exam-
ple of the application's page setup options for PostScript
printers.

Page Setup … ( P)

Selecting Paper Size

The Page Setup dialog box lets you choose the paper size
you want for printing your document. The paper sizes
available depend on the type of printer driver you use.
When using a PostScript printer driver, the available
paper sizes may even vary from printer to printer. For
more information about the paper sizes available to you,
consult your printer driver documentation.

In , you can select a paper size that does not
match the page size of your document. You can select any
paper size your printer driver offers in the Page Setup
dialog box. Changing paper sizes does not affect a docu-
ment’s page size. However, changing your document’s
paper size may change the position of the document page
on the printed paper.
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To help you view the position of a page on the selected
paper size, can display optional outlines that
represent the paper size and printable area you selected
in the Page Setup dialog. To display these outlines, select
the Show page outlines on screen check box in the Page
Options panel of the Document Settings dialog box in the
Document menu.

In the illustration below, the white area centered in the
Document Window represents the document’s page size.
As mentioned, this can be different than the selected
paper size. The blue outline represents the physical size
of the paper you selected in the Page Setup dialog box.
The red outline represents the area, within the paper
size, in which you can print (the printable area). 

If the printable area equals the paper size, 
replaces the red and blue outlines with a single purple
outline, representing both the paper size and the print-
able area.

Paper size
outline

Paper's printable
area outline

Document page size
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adds several options to the Page Setup dialog
box of QuickDraw printers. These options let you affect
the appearance of your document’s hardcopy.

Selecting separation plates

The Plates pop-up menu lets you choose separations, or
individual separation plates, to output. The pop-up lets
you choose from: 

• Composite
The Composit e option lets you print a composite
representation of the document in its final form.
All the colors in a document appear on the com-
posite plate.

Page Setup Options on QuickDraw Printers
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• All Process Separation Plates
The All Process Separation Plates option lets you
break a document into four component color
plates of cyan, magenta, yellow, and black. 

• All Spot Separation Plates
The All Spot Separation Plates option lets you
break a document into plates for each spot color
you use. Each spot color represents one color of
ink.

• Black
The Black option lets you print only those plates
that contain the color black.

• Process Cyan
The Process Cyan option lets you print only those
plates that contain the color cyan.

• Process Magenta
The Process Magent a option lets you print only
those plates that contain the color magenta.

• Process Yellow
The Process Yellow option lets you print only
those plates that contain the color yellow.

• Spot color name
The Spot color name option lets you print only the
named spot color separation plate. Exaclty as
many spot color options appear in the Plates pop-
up menu as you have used in your document.

Other options that appear in the Page Setup dialog box
on QuickDraw printers include:

• Use custom paper size
The Use custom paper size check box only
appears active when printing to a PostScript
printer. For more information, see the Page
Setup section for PostScript printers.

• Use resolution limiting
The Use resolution limiting check box only appears
active when printing to a PostScript printer. For
more information, see the Page Setup section for
PostScript printers.

• For composite printing set a screen
The For composite printing set a screen check box
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only appears active when printing to a PostScript
printer. For more information, see the Page
Setup section for PostScript printers.

• Use tiling
Select the Use tiling check box to break oversized
documents into tiled segments that can fit on
your selected paper size. When you select the Use
tiling check box, the Overlap text field appears
next to it. The Overlap field lets you set your tile
segments so they overlap (have repeating edges in
corresponding tiles). This lets you overlap tiles
instead of matching up their edges. Type the
amount of overlap you want into the text field.

When you select the Use tiling check box, the
application displays red outlines around each
tiled area.

Page Setup Options on PostScript Printers

In order to take full advantage of the features of your
PostScript laser printer, needs to locate your
printer’s PostScript Printer Description (PPD). This file,
created by the printer manufacturer, contains a list of the
features and recommended settings of your laser printer.

uses your printer ’s PPD file to determine your
printer’s support of:

• Level 2 PostScript

• Color

• Variable paper sizes support

• Binary encoding

also uses the PPD file to determine your
printer’s:

• Suggested angles, frequencies, and spot functions
for separations

• Default printer resolution

• Default screen frequency or density

• Installed fonts
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Apple’s LaserWriter 8 printer driver automatically points
to your printer ’s PPD. If LaserWriter 8 cannot

find your PPD, it points to a general PPD
instead. In any case, LaserWriter 8 provides a PPD for
the printer in use.

If you do not use LaserWriter 8, cannot locate
your printer’s PPD file. Without your PPD file, the appli-
cation must assume your printer has certain features it
may or may not have. When cannot locate
your PPD, it assumes your printer:

• Supports Level 2 PostScript

• Supports Color

• Contains variable paper sizes

• Contains a default printer resolution of 300 dpi

• Contains a default screen setting of 60 lpi

• Supports binary encoding

• Contains the base 13 fonts

In other words, gives you the widest possible
selection of features possible. In reality, your printer may
support any combination of these features. At this point,
you mustactivate those features your printer supports.

For the best use of your PostScript printer, it is strongly
suggested that you install LaserWriter 8, or better, on
your computer.
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The Creator2 page setup panel lets you control printer
features that affect how the hardcopy of your document
appears.

Selecting plates

The Plates pop-up menu lets you choose a separation
plate, or plates, to output. The pop-up lets you choose
from: 

• Composite
The Composit e option lets you print a composite
representation of the document in its final form.
All the colors in a document appear on the com-
posite plate.

Setting Creator2 Page Setup Attributes
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• All Process Separation Plates
The All Process Separation Plates option lets you
break a document into four component color
plates of cyan, magenta, yellow, and black. 

• All Spot Separation Plates
The All Spot Separation Plates option lets you
break a document into plates for each spot color
you use. Each spot color represents one color of
ink.

• Black
The Black option lets you print only those plates
that contain the color black.

• Process Cyan
The Process Cyan option lets you print only those
plates that contain the color cyan.

• Process Magenta
The Process Magent a option lets you print only
those plates that contain the color magenta.

• Process Yellow
The Process Yellow option lets you print only
those plates that contain the color yellow.

• Spot color name
The Spot color name option lets you print only the
named spot color plate. Exactly as many spot
color options appear in the Plates pop-up menu as
you have used in your document.

Other options in the Creator2 panel include:

• Use custom paper size
Selecting the Use custom paper size check box
lets you create your own paper size. When you
have selected this option, three text fields appear.
The Height and Width fields let you enter the
dimensions of your custom paper size. The Offset
field lets you set the distance between the custom
paper edge and the film edge when printing to a
device that supports variable paper sizes. 

Click the OK button, or choose a new panel, to get
to recognize a new paper size. The

paper size and printable area outlines in the
Document Window change to reflect your custom
paper size.
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Note: This option only appears active if you use
a PostScript device that supports variable
paper size output.

• Use resolution limiting
The Use resolution limiting check box tells

to downsample TIFF, or other high
resolution graphic images, to a specified lower
resolution. Limiting the resolution of graphics
reduces print times. The correct resolution setting
for your printer does not cause a loss of quality.

When you select the Use resolution limiting check
box, enters a default dpi setting into
the dpi text field. bases the default dpi
setting on the PPD for your printer. For example,
if your PPD tells that you have a 300
dpi printer, 300 dpi appears as the default setting
for the Use resolution limiting option. 

For example, when you print a 600 dpi graphic,
scales the image to 300 dpi without sac-

rificing quality. The Use resolution limiting option
does not affect graphics with lower than the speci-
fied limit.

• Use flatness limiting
Selecting the Use flatness limiting check box lets
you set the error tolerance used by PostScript
devices to render curves. PostScript recreates
curved segments by linking series of straight lines. 

The value in the Limit t o text field determines
how closely, in device pixels, a PostScript
Interpreter approximates a curve. A device pixel
equals one dot on a printing device: a 600 dpi
printer has a smaller device pixel than a 300 dpi
printer. If a curve looks good with a flatness limit
of 3 on a 300 dpi printer, you may want to
increase the flatness value when printing to a
1200 dpi printer. This can speed up printing time. 

Every PostScript device uses a default flatness,
determined by the device manufacturer, that pro-
duces the best results. Normally, you don’t need
to adjust the flatness limit (overriding the manu-
facturer’s default). However, increasing the flat-
ness value may let you print complex graphics
that normally generate PostScript errors.
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• For composite printing set a screen
The For composite printing set a screen check box
lets you specify the screen density of your com-
posite print jobs (in lines per inch). 

Enter the desired number of lines per inch into
the text field that appears when you select the
check box. This feature does not affect the screen
settings used when separating your documents
(see below).

• Use tiling
Select the Use tiling check box to break oversized
documents into tiled segments that can fit on
your selected paper size. When you select the Use
tiling check box, the Overlap text field appears
next to it. The Overlap field lets you set your tile
segments so they overlap (have repeating edges in
corresponding tiles). This lets you overlap tiles
instead of matching up their edges. Type the
amount of overlap you want into the text field.

When you select the Use tiling check box, the
application displays red outlines around each
tiled area.

• Revert to defaults
Click the Revert to defaults button to return the
settings of the page setup panel to the
application’s determined settings.

• Separation Options…
Click the Separation Options… button to open
the Separation Options dialog box. This dialog
box lets you set the screen densities, angles, and

The illustration above
has a screen of 30
lines per inch (lpi).

The illustration above
has a screen of 60
lines per inch (lpi).

The illustration above
has a screen of 120
lines per inch (lpi).
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spot functions to use when process or spot sepa-
rating your documents. This dialog also lets you
select suggested values from your printer manu-
facturer (via your printer ’s PPD file).

♦ Suggested settings from PPD file
The Suggested settings from PPD file pop-up
menu lets you select the manufacturer-deter-
mined best density, angle, and spot function
settings for your printer. Normally, several
options appear available at different densities.
For printers that support multiple resolutions,
several sets of options for each resolution may
also appear. For these printers, you need to
know the resolution of the printer so that you
can select from the proper set of options.

♦ lpi
The lpi text field lets you define the screen
density (in lines per inch) for each plate.

{abs  exch abs  2 copy add 1 gt  {1 .  sub dup mu l  exch 1 .sub dup mu l  add 1 .  sub}{dup mu l  exch dup mu l

{exch pop abs 1.  exch sub}

{dup mul  exch dup mul  .4  mul  add 1.  exch sub}

{abs exch abs 2 copy gt {exch} i f  pop}

Custom
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♦ angle
The angle text field lets you specify the screen
angle (in degrees) to use for each separation
plate.

♦ Spot Function
The Spot Function pop-up menu lets you set
the shape of the dot for the specified color
plate. The options available include: Printer
Default , Dot , Line , Ellipse , Squar e, Tri-dot , and
Custom .

When you choose a spot function option, the
PostScript code for the chosen option appears
in the text field beneath the specified color
plate name. 

The Custom option usually appears dimmed.
The Custom option appears only if your printer
includes a spot function option other than the
ones mentioned above.

In the illustration
above, one of the
two color plates has
been rotated six
degrees.

In the illustration
above, one of the two
color plates has been
rotated 15 degrees.

In the illustration
above, one of the two
color plates has been
rotated 30 degrees.

The illustration above
shows a dot spot func-
tion (at a low lpi).

The illustration above
shows a line spot func-
tion (at a low lpi).

The illustration above
shows a square spot
function (at a low lpi).
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Print… ( P)

The Print… command lets you send a document, or pages
of a document, to a printer. Typically, the Print… com-
mand gives you access to a variety of other options.
These options give you greater control over how your doc-
ument prints. To find out what print options are avail-
able on your printer, choose the Print… command to open
the Print… dialog box.  

The appearance of the Print dialog box depends on what
printer driver you have installed in your System Folder
and have selected in the Chooser. In addition, each
printer driver includes a unique set of page setup options.
For more information about your Print dialog layout and
options, see your printer driver documentation.

However, does have some special printing
options that you can take advantage of. In the following
illustrations, this Reference Manualuses Apple's
LaserWriter 8 printer driver to provide an example of the
application's printing options.

offers a variety of printing options for you to
use. For example, you can make various marks and
printer information appear on the page. Just as you can
tell what elements to include on hardcopy, you
can also specify what elements should not print. 

Setting Creator2 Printing Options
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Note: The ornamentoptions—like registration marks,
crop marks, and color bars—return to their default
settings after each print job. You can change the
ornament default settings in the Print Defaults
panel, in the Document Settings dialog box in the
Document menu, after each print job.

The printing options offered by include:

• Plates
The Plates pop-up menu lets you choose the plate,
or plates, to output. The pop-up lets you choose
from Composite, All Process Separation Plates,
All Spot Separation Plates, All Process and Spot
Plates, Black, Process Cyan, Process Magenta,
and Process Yellow options. More options appear
for each spot color used in your document.

• Print text blocks only
Selecting the Print text blocks onlycheck box
sends only the text blocks within the selected page
range to the printer. Graphic elements do not print
when you have selected this option.

• Print selected items only
Selecting the Print selected items onlycheck box
sends to the printer only those items currently
selected. Deselecting this option prints all the ele-
ments in the selected print range.

• Print registration marks
Select the Print registration marks check box
when you print color separations. This option
places up to 12 registration marks on a page to aid
in aligning the color separations.

also prints two GATF (Graphic Arts
Technical Foundation) control targets on two cor-
ners. These 1/2 inch pinwheels helps measure
image resolution during plate production, as well
as plate degradation, dot doubling, grain, and slur-
ring during printing.

• Print document description
Selecting the Print document description check
box lets you print any information in the
Description field of the Document Info panel of the
Document Settings dialog box in the Document
menu. These notes appear at the top of the print-
out.
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• Print crop marks
Select the Print crop marks check box when you
want crop marks to print on document edges and
tile overlaps. Use crop marks if you expect your
print job needs trimming during post-processing
or finishing.

• Print plate information
Selecting the Print plate information check box
lets you print the document name and plate infor-
mation at the top of the document.

• Print color bars
Selecting the Print color bars check box lets you
place four rectangles at the bottom of each color
separation plate. Each rectangle represents one of
the four process separation components of cyan,
magenta, yellow, black—in that order.

• Print EPS spot colors as process
Selecting the Print EPS spot colors as process
check box tells to use the cyan,
magenta, yellow, and black process colors to recre-
ate all individual spot colors embeded in EPS files. 
You can only use this option with PostScript Level
2 printers.

• Use binary encoding
Selecting the Use Binary Encoding check box
prints sampled image files using binary, rather
than hexadecimal, encoding. Binary encoding can
make PostScript job streams 50 percent smaller
and make them print significantly faster. However,
not all networks and RIPs support binary encoding.

You can only use this option with PostScript
printers.

• Use level 2 PostScript ®

Selecting the Use level 2 PostScript® check box
tells to apply PostScript Level 2 com-
mands when it builds a PostScript file for your
printer. Using Level 2 PostScript can improve print-
ing time and reduce network traffic significantly.

You can only use this option with Level 2
PostScript printers.

• Use color PostScript ® for color printers
Select the Use color PostScript® for color
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printers check box when you want to print a doc-
ument in color. Selecting the Use color
PostScript® for color printers option tells

to generate PostScript code for use
with color PostScript printers. 

You can only use this option with color PostScript
printers.

The Creator2 print panel also includes several OPI (Open
Prepress Interface) options. Only use these features when
printing documents through an OPI server.

From the “Open Prepress Interface Specification 1.3,”
©Copyright 1989-1993 Aldus Corporation:

The Open Prepress Interface (OPI) is a collection of
PostScript-language comment conventions that
allows a page-layout program to use low or medium
resolution TIFF images for layout and proofing,
and have a prepress system or OPI server automat-
ically substitute a high resolution TIFF or other
image when the final film or plates are generated.
Both desktop prepress software and high-end pre-
press systems can use OPI comments to minimize
network traffic and image storage requirements.

In practice, OPI servers are usually implemented in one of
two methods.

In the first method, the OPI server offers a facility to con-
vert high-resolution graphic files into a low resolution
‘proxy’ files intended for placement into layout applications.
These ‘proxy’ files (which usually appear as EPS files) con-
tain OPI comments embedded within each one. At print
time, the OPI server processes these comments to do
graphic substitution (to the high resolution original).

For OPI servers that provide ‘proxy’ facilities, layout appli-
cations do not need to know that OPI substitution occurs.
For this type of OPI, layout applications treat proxy files as
they would any other files. When using this type of OPI
server, you do not need to use any of the OPI
printing options.

In the second method, the OPI server does not offer a
‘proxy’ facility and only scans incoming PostScript print
job streams for PostScript OPI comments. If the server
encounters a PostScript OPI comment, it attempts to sub-
stitute a graphic. With this type of OPI server, you must
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instruct layout applications as to when and how to gener-
ate PostScript OPI comments.

lets you add PostScript OPI comments to your
PostScript print job streams for use by this type of OPI
server. also lets you omit the PostScript code
normally generated when printing TIFF or EPS files.

Since OPI servers are very complicated systems, it is
important to talk to your system administrator or produc-
tion manager when choosing OPI options.

The OPI options in the printing panel include:

• Send OPI comments for all TIFF files
Select the Send OPI comments for all TIFF files 
check box when you want to include OPI comments
with, or in place of, TIFF graphics.

• Omit PostScript ® for TIFF files
Select Omit PostScript ® for TIFF files if you do not
want your TIFF files converted into PostScript. 

Note: You can include both OPI comments and
PostScript code in TIFF files. However,
including both OPI comments and
PostScript code may cause printing prob-
lems, depending on the type of server you
use. Talk to your system administrator to
find out the correct TIFF OPI settings for
your network.

• Substitute OPI comments for EPS files
Select the Substitute OPI comments for EPS files
check box if you want to put OPI comments in
place of EPS files in your document. Unlike TIFF
files, you cannot include both OPI comments and
EPS files in a document.

Quit ( Q)

The Quit command lets you exit the applica-
tion and return to the Finder.

If you quit the program still have open, unsaved docu-
ments, prompts you to save your files before it
closes. refers to each file by name and asks
you to save each one. Each Save dialog box contains a
Save button (to the save the file), a Don't Save button (to
not save the file), and a Cancel button (to return to the

document).
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The Edit Menu

The Undo command lets you remove the last change you
made to the document. You can undo all actions per-
formed during your current work session. You cannot
undo actions performed during earlier work sessions.

If you cannot remember the order of your actions, a
description of the last sequential action appears with the
Undo command in the Edit menu. For example, if you
move an element, but then want it back in its original
position, pull down the Edit menu to see an Undo Move
command.

The Undo command appears dimmed when you cannot
apply the command to the document.

Undo ( Z)

The Edit menu contains the commands you need to dupli-
cate, remove, or place document elements. For example,
you can copy and paste sections of text, duplicate ele-
ments, and copy and paste text attributes. The Edit menu
also contains commands that let you decide how you want
dialog boxes to appear, and the type and size of font you
wish to appear first.

A complete description of the commands available in the
Edit menu follows.
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Redo ( -Z)

The Redo command lets you recreate an action you
removed from the document with the Undo command.
Each redo replaces the last sequential undo you made to
the document. You can only redo a continuous series of
undos. If you open a document that you have previously
worked on, you cannot redo actions from the earlier work
session.

A description of the last sequential action undone
appears with the Redo command under the Edit menu.
For example, you may move an item to a new location,
and then decide you liked it better in its original location.
You can select Undo to replace the item in its original
location. If you change your mind again, you can select
Redo to move the element back to its second location. If
you make further modifications to the document, you can
no longer go back and select the Redo command to relo-
cate this item.

Cut ( X)

The Cut command lets you remove selected elements or
text from the document, but reserves them for later use. 

To cut an element, simply select it with the Arrow tool
and choose the Cut command from the Edit menu. To
select more than one element, press the Shif t key while
clicking on elements. To cut text, highlight the text with
the I-beam pointer and choose the Cut command from the
Edit menu.

Tip: places any element or text you cut into
the Clipboard. The Clipboard, however, only holds
the last item you placed in it. Any item you cut
replaces the previous item you cut on the
Clipboard. The older item cannot be retrieved.
Moreover, you lose items on the Clipboard if you
choose Copy, or should you crash or lose power.
For these reasons, you should paste your cut selec-
tion somewhere else in the document or into the
Scrapbook (under the Apple menu) for more per-
manent storage.

You can select both text blocks and graphics elements
when cutting groups of elements. treats text
blocks the same as any other element.



54 Multi-Ad Creator2

The Copy command makes a duplicate of a selected ele-
ment without removing the original element from the
document. The Copy command doesn’t automatically
place a duplicate of a selected element into the document.
Instead, it places a duplicate in the Clipboard for later
use.

To copy an element, simply select an element with the
Arrow tool and then choose the Copy command from the
Edit menu. To copy a group of elements, press the Shif t
key while clicking on the elements you want to copy, and
then choose the Copy command from the Edit menu. To
copy text, highlight the text you want to copy with the I-
beam pointer and choose Copy from the Edit menu.

You can select both text blocks and graphics elements
when copying groups of elements. treats text
blocks the same as any other element.

Copy ( C)

Paste ( V)

The Paste command lets you put any item currently on
the Clipboard into a document. Use the Cut or Copy com-
mands to place an item on the Clipboard. When you
choose the Paste command, places a duplicate
of the element in the center of the Document Window. If
you press the Shif t key while choosing the Paste com-
mand, pastes the copied object directly over
the original element.

Pasting text into a text block

1. Click the Text tool on the Tools palette.

2. Click inside an existing text block with the Text tool.

Or

Click and drag a new text block.

3. Move the insertion point to where you want the text
to appear.

4. Choose Paste from the Edit menu, and the text
appears to the right of the insertion point.
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Clear

The Clear command removes selected elements or text
from the document. Essentially, the Clear command pro-
vides a menu equivalent of the Delet e key.

To clear an element from a document, click on the element
with the Arrow pointer. Choose Clear from the Edit menu
to delete the element. To remove more than one element,
press the Shif t key while clicking on the elements you
want to clear. Then choose the Clear command. 

To clear text, highlight the text with the I-beam and
choose Clear from the Edit menu or press the Delet e key.

If you want to recover an item you just cleared, immedi-
ately select the Undo command or press Cmd-Z .

Select All ( A)

The Select All command—when you have a insertion
point in a text block—highlights all text in that block and
connected blocks. Likewise, choosing the Select All com-
mand with a tool other than the Text tool selects all the
elements in the active Document Window. This includes
elements in the Desk Area.

The Select All command appears dimmed when you have
selected all the available elements or text.

Duplicate… ( D)

The Duplicate… command works much like the Copy
command, but offers greater flexibility and control over
the selected elements. With the Duplicate command, you
can set the number of duplicates, the distance of the
duplicates from the original selected item, the scale of the
duplicates, and the rotation of the duplicates.

Duplicating an element or a group or elements

1. Select the element(s) that you want to duplicate.

2. Choose Duplicate… from the Edit menu. The
Duplicate Element dialog box appears.

3. Enter the number of duplicates you wish to make into
the Times field.

4. Enter the distance from the original that you wish
the duplicates to appear in the Offset fields. You can
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enter distances for both the horizontal and vertical
offset.

5. Click in the check boxes in the On Each Duplicate
area to modify each succeeding duplicate. The options
available include:

• Scale by
Enter a percentage into the Scale By field to
adjust the size of each duplicate based on the
preceding duplicate. For example, entering 25
percent into the Scale By field makes a duplicate
25 percent larger than the original selection.
Each succeeding duplicate appears 25 percent
larger than the immediately preceding duplicate.

• Rotate by
Enter a degree into the Rotate by field to
rotate each succeeding duplicate that many
degrees from the position of the preceding
duplicate. For example, entering 45 degrees
into the Rotate By field rotates the first dupli-
cate 45 degrees clockwise from the original.

rotates each succeeding duplicate
45 degrees more than the previous duplicate.

• Increase offset by
Enter a measurement into the Increase offset
by text fields and adds that mea-
surement to the offset of the preceding dupli-
cate. For example, if an element has an offset
of 1/4 inch (in the Offset fields in the Duplicate
area) and you enter 1/4 inch into Increase of f-
set by fields, the first duplicate appears 1/4
inch from the horizontal and vertical planes of
the original element. The second duplicate
appears 1/2 inch from the horizontal and verti-
cal planes of the first duplicate, and so on.

• Link Text Blocks
Click on the Link Text Blocks check box to con-
nect every text block created through the
Duplicate Element dialog box.

6. Click the OK button to create the duplicate images.

Pressing the Shif t key while selecting Duplicate… from
the Edit menu bypasses the Duplicate Element dialog
box. Instead, duplicates the currently selected
image with the last entered duplicate settings.
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Make Matrix… ( M)

The Make Matrix… command lets you duplicate any
selected element, or group of elements, in a user-defined
array. Unlike the Duplicate… command, the Make
Matrix… command does not create copies the same size
as the original item. Instead, it scales the duplicates to fit
the dimensions of a specified array. To define an array,
choose Make Matrix… from the Edit menu to open the
Make Matrix dialog box.

The Make Matrix dialog box options include:

• Rows
Enter the number of horizontal rows you want in
the matrix.

• Columns
Enter the number of vertical columns you wish in
the matrix.

• Spacing
Type the amount of space you wish to appear
between rows and columns.

• Group
Select the Group check box if you want to group
the resulting matrix as one element. By default,

does not select this check box.

• Scale text
Select this box if you wish to create a matrix that
includes text blocks and have the text inside these
blocks scaled to fit the resulting block size.
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Note: Scale text appears dimmed if you do not
have any text blocks selected.

• Delete original
Selecting the Delete original check box erases the
element, or group of elements, used as the master
for creating the matrix when the matrix is com-
plete.

• Scale to fit
The Scale to fit radio button lets you adjust the
size of your elements to fit exactly in the rectan-
gle’s frame.

• Proportional
The Proportional radio button lets you proportion-
ally scale the size of the elements in the array.

• Adjust spacing
You can only select the Adjust spacing check box
with the Proportional radio button selected. With
Adjust spacing on, adjusts the row or
column spacing so that elements appear as close
to the sides of the guiding rectangle as practical
(given all other parameters). It makes such
adjustments only by increasing the spacing and
only in one direction (either vertical or horizon-
tal), according to how you draw the guiding rec-
tangle. With Adjust spacing off, may
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not fill the entire rectangle you created, but it
does scale the elements proportionally and uses
the specified row and column spacing.

• Drag bounds
The Drag bounds radio button lets you draw an
array. By selecting Drag bounds and then clicking
the OK button, changes the pointer
into a crosshair. You can use the crosshair to drag
an array of the desired size.

• Use size
The Use size radio button lets you specify the
dimensions of the desired array. Simply enter the
appropriate values into the Height and Width text
fields. When you click the OK button, 
places an array of the desired dimensions in the
Document Window.

Use the Macintosh matrix in the lower right-hand corner
of the Make Matrix dialog to help you remember the
effect the Scale to fit , Proportional , and Adjust spacing
options have on matrices.

When you click the OK button, the pointer turns into a
crosshair. Click and drag anywhere to create an element
of the size you want for the finished matrix. When you
release the mouse button, places an array
with the designated spacing, rows of elements, and
columns of elements within the selection rectangle’s
frame.

Making a matrix

1. Draw a square in the Document Window.

2. Choose Make Matrix… from the Edit menu or press
Cmd-M . The Make Matrix dialog box opens.
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3. Enter the following attributes into the Make Matrix
dialog box:

• Type 3 in the Rows field.

• Type 3 in the Columns field.

• Type 1/8” into each of the Spacing fields. You
can also enter the decimal value or a value in
another measurement, like picas.

• Check the Group check box to create a unified
graphic element for easier manipulation in the
future.

• Check the Delete Original check box, so an
extra square doesn't appear in the document.

• Choose the Proportional option.

4. Click the OK button.

5. Choose Rulers from the View menu (if not already
visible). Set your ruler measurements to inches, or
the appropriate measurement, in the General panel of
the Preferences dialog in the Edit menu. 
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You can use the rulers to help you drag an array of
the appropriate size.

6. Position your crosshair pointer in the area where you
want to place the matrix.

7. Click and drag the crosshair diagonally (down and
right), until the pointer indicators show that you have
advanced 2 inches on their respective rulers. As you
drag, a rectangle appears on the screen to show you
the area you’ve selected.

You can also place guides to mark the dimensions of
the array. Select the Snap To Guides Toggle, in the
upper left-hand corner of the Document Window, and
draw the selection rectangle. In this manner, you can
quickly create an array.

8. Release the mouse button. draws nine pro-
portional squares in the rectangle you just defined.

The placement rectangle for this matrix-to-be was drawn
so that the resulting array would be contained in a 1 7/8
inch square—allowing an 1/8 inch of white space to sur-
round the original 2 inch void.
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You can also use the Make Matrix… command to
arrange text blocks into columns. This can prove espe-
cially helpful when you want to create a document with
several columns of text on a page, or when you want to
include features like sidebars in a document. 

Making a matrix of text blocks

1. Click on the Text tool on the Tools palette.

2. Draw a text block 2” wide x 4” tall. Place guides if
you need to.

3. Click on the Arrow tool on the Tools palette.

4. Choose the Make Matrix… command from the Edit
menu or press Cmd-M . The Make Matrix dialog box
opens.

5. Enter the following attributes into the Make Matrix
dialog box:

• Enter 1 into the Rows field.

• Enter 3 into the Columns field.

• Type 1/4" into the Spacing fields.

• Select only the Delete original and Link tex t
blocks check boxes. Deselect the other check
boxes.

The Scale tex t check box would resize all the
text to fit within the text block; the text would
not appear in its selected point size.

• Click the Scale to fit radio button.

• Click the Use size radio button.
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• Enter 4" into the Height text field and 6 1/2"
into the Width text field.

6. Click the OK button. removes the original
text block and places three text blocks in the
Document Window.
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The Copy Type Specs command lets you copy the type
format of the selected text (or of the character to the left
of the insertion point), without copying the text itself. You
can then apply these type attributes to other text using
the Paste Type Specs command below.

The character attributes the Copy Type Specs command
copies include: font, style, size, leading, color, horizontal
scale, tracking, word spacing, and offset settings. You can-
not copy paragraph attributes with this command.
However, you can copy paragraph attributes using the
Copy ¶ Specs command, described below.

does not store the copied attributes on the
Clipboard, so you can retrieve them even after many
intervening Cut or Copy commands. However, you can
lose a copied type format by using the Copy Type Specs
command on another selection of text.

Copy Type Specs ( -G)

The Paste Type Specs command lets you apply character
attributes that you have copied using the Copy Type
Specs command to selected text. Using the Paste Type
Specs command does not change the content of the text.

Example: The word Sale appears in your document in 24
pt Bold Helvetica, and the words Free Offer appear in the
same document in 10 pt Plain Geneva. You want to
change the text attributes of Free Offer to the attributes
of Sale . To do so, you need to:

1. Select the Text tool.

2. Highlight the word Sale .

3. Choose Copy Type Specs from the Edit menu, or
press Cmd-G .

4. Highlight the words Free Offer and choose Paste
Type Specs from the Edit menu, or press Cmd-D . This
changes the format of Free Offer to 24 pt Bold
Helvetica.

Paste Type Specs ( -D)
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The Paste ¶ Specs command lets you apply paragraph
formats, that you have copied using the Copy ¶ Specs
command, to all selected paragraphs without changing the
content of the paragraphs. Selected paragraphs are either
all paragraphs containing at least one selected character
or the paragraph containing the insertion point.

Example: You’ve formatted the paragraphs in one text
block with 12 pts before each, a 1/4 inch indent at the
beginning of each, and you have justified the text. Now
you need to create another text block with similarly for-
matted paragraphs, and you need to import a text file
that has no formatting of its own.

Copy ¶ Specs ( - -G)

The Copy ¶ Specs command lets you copy a selected para-
graph’s formatting attributes without copying the text of
the paragraph. If the selection doesn’t include a whole
paragraph, includes more than one paragraph, or if only
an insertion point exists, the copied attributes come from
the paragraph with the first selected character or the
insertion point. See Paste ¶ Specs, below, for an example.

Paragraph attributes include alignment, margins and
indentation, hyphenation and tabs. You cannot copy char-
acter attributes with this command; however, you can
copy character attributes using the Copy Type Specs
command, described above.

does not store the copied attributes on the
Clipboard, so you can still retrieve them even after many
intervening Cut or Copy commands. They don’t conflict
with copied character attributes. However, you can lose a
copied type format by using the Copy ¶ Specs command
on another selection of text.

Paste ¶ Specs ( - -D)

The Paragraph dialog box lets you set such formatting
options as alignment, space between paragraphs, and
indentation.
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To replicate the formatting of the first paragraph, follow
these steps:

1. Select the Text tool.

2. Click the formatted text block with the Text tool. 

3. Place the blinking insertion point inside one of the
correctly formatted paragraphs.

4. Select Copy ¶ Specs from the Edit menu. Or press
Cmd-Shift-G .

5. Highlight all the paragraphs you wish to reformat. If
you only have one paragraph to reformat, simply place
the insertion point anywhere in that paragraph. For
multiple paragraphs, click and drag with the text
pointer to select them or use the Select All command
to highlight all paragraphs within the text block.
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6. Choose Paste ¶ Specs from the Edit menu, or press
Cmd-Shift-D . The new paragraphs become justified,
with  1/4 inch indents at the beginning of each and
with a 12 pt space before each paragraph.
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Find/Change

The Find/Change submenu contains commands that let
you search for particular words or phrases and then lets
you change them. A full description of the commands
available in the Find/Change submenu follows.

Find… ( - -F)

The Find… command lets you find designated text and/or
text attributes and replace them as desired with new text
and/or text attributes. Choosing the Find… command from
the Edit menu opens the Find/Change dialog box. In this
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dialog box you can change instances of one word to
another, find instances of a word and change its character
format, find everything in one format and change it to
another, or any combination of these.

Using the Find/Change command

1. Choose Find… from the Find/Change submenu in the
Edit menu. The Find/Change dialog box opens.

2. Enter the text you want to find into the Search for
text field. If you want to replace the designated text
with other text, enter the new text into the Change t o
text field.

Note: If you have not entered anything into the
Change t o text field, or selected the check
box next to the Change t o text field, then

finds all instances of the desig-
nated text but does not change it. 

3. Click the Find button to locate the desired text.
takes you to the appropriate section of the

document and highlights the designated text. 

If you want to change the text, go to Step 5. To find
the next occurrence of the designated text, click the
Find button again.

4. Click the Change button to change the highlighted
text to the new text entered into the Change t o text
field. To change the selection and then find the next
occurrence of the designated text, click the
Change/Find button. To change every occurrence of
the designated text, click the Change All button.

5. Click the Done button to exit the dialog box and
return to the Document Window.
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If you like, you can change the formatting of every
instance of a particular word or phrase without changing
the text. Click the Font , Style , and/or Size check boxes in
the Change t o area. Select the desired font and style from
the pop-up menu and then click the Find button to locate
the designated text. Click the Change button to change
the designated text to the new format.

In addition to the text fields and pop-up menus already
mentioned, the Find/Change dialog box has several other
options that you can select to help your search. These
options include:

• Whole words
The Whole words check box tells to
treat the search-for text as a whole word or
words. Therefore, the application ignores all
instances of the designated word contained within
other words. For example, if you look for the word
creator with the Whole wor d check box selected,

ignores the word creators , even if it
has all the same text attributes. 

• Ignore case
The Ignore case check box tells to
search for all occurrences of the designated text
regardless of capitalization. Deselecting the
Ignore case check box forces to look for
occurrences of the designated text that exactly
match the text in the Search for field.

• Match exact style
The Match exact style check box tells 
to find only those instances where the style
searched for exactly matches the chosen style
parameters. For example, if you want to find an
italicized word, ignores occurrences of
the same word that are bold and italic.

• Active blocks only
The Active blocks onl y check box forces 
to search only the active text block and linked
text blocks. The application ignores all unlinked
text blocks.
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Example: To change all instances of the word Creator2
that appear in 18 pt Helvetica Italic Underline to the
phrase Multi-Ad Creator2 in 24 pt Helvetica Bold Italic.

In the Search for section:

• Type the word Creator2 in the Search for text
field. Notice the check box to its left becomes
selected.

• Choose Helvetica from the Font pop-up menu.
This selects the Font check box.
If you deselect the check box, Helvetica becomes
dimmed in the Font pop-up menu. Click the check
box to select it again and make the Font pop-up
menu available. 

The same conventions apply to the Style pop-up
menu and the Size text field, as well as the Font
and Style pop-ups and the Size text field in the
Change t o section. Selecting a check box lets you
search for the named feature.

• Choose Italic from the Style pop-up menu.

• Enter 18 pt into the Size text field.

• Select the Match exact style check box to find
only those instances where the searched for style
exactly matches the chosen style parameters.

Selecting the various check boxes in the Search for area of the
Find/Change dialog box lets you define the attributes
Creator2 looks for. In this example, Creator2 looks for text with
a specified font, style, and size.
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• Select the Whole words check box.

• Select the Active blocks onl y check box.

In the Change to section:

• Type Multi-Ad Creator2 in the Change t o field. 

• Since you don’t need to change the font, do not
select anything from the Font pop-up. Make sure
you have the Font check box deselected so

knows not to apply this change.

• Choose Bold and Italic from the Style pop-up menu.

When you choose a combination of text styles, the
word Mixed appears in the Style pop-up menu.
The note just below Style displays all of your
choices, so you can see what you’ve selected with-
out popping up the menu again. This note serves
the same purpose in the Search for section.

• Enter 24 pt into the Size text field.

• Once you’ve set your search parameters and cho-
sen all your desired options, click Find to start the
search.

If you know that you want to change every occur-
rence of a word or selection of text, click the
Change All button.

The Change to area of the Find/Change dialog box lets you
change selected text attributes. In this example, the style and
point size of text are to change.
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• When the application finds the first instance of
the search text, click the Change All button if you
want all instances of Creator2 appearing in 18 pt
Helvetica Italic Underline—in every text block in
your document—to be changed to Multi-Ad
Creator2 appearing in 24 pt Bold Italic. The font
(Helvetica) remains unchanged.

• If you anticipate one or more instances where you
won’t want to change the search item, you can
exercise greater control by going through and
changing each individual instance with the
Change button. If and when you come upon an
instance where you don’t want to change, click the
Find button instead of clicking the Change button.

then moves on to the next instance.

• When you have completed your search, put the
Find/Change dialog box away by clicking on the
Done button or you can just bring the Document
Window to the front.

Searching for special characters

Some characters you may wish to include in your Search
for or Change t o fields can’t be typed into the dialog box’s
text fields, because they have special meanings or are
invisible characters. For instance, pressing Return starts
the find operation and pressing Tab changes to the other
text edit field. 

Luckily, you can search for these characters by selecting
them from the Insert special character pop-up menu. The
pop-up menu places special keyboard equivalents into the
Search for or Change t o fields. The keyboard equivalents
include:

Return equivalent Return ^p

Tab equivalent Tab ^t

Newline equivalent Shift-Return ^n

Block break ^b

Em space equivalent Shift-Control-Space ^M

En space equivalent Shift-Space ^N

Thin space equivalent Control-Space ^T

Quad equivalent Shift-Tab ^q

Page number equivalent ^P
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Change ( - -=)

The Change command lets you change a selected word or
phrase without searching for the next occurrence of that
same word or phrase.

You can choose the Change command after you have
found a word using the Find… or Find Again commands.
When you highlight a word or phrase and choose the
Change command from the Find/Change submenu in the
Edit menu, changes it into a new word or
phrase. The new word or phrase is the same text you
entered into the Change t o text field when you last used
the Find… command. 

To find another occurrence of the original word or phrase,
use the Find Again command.

Multi-Ad Creator2

Find Again ( - -G)

The Find Again command finds another occurrence of the
word or phrase entered into the Find/Change dialog box.
Note that the Find Again command does not open the
Find/Change dialog box. It merely locates the next occur-
rence of the word or phrase last entered into the dialog box.

Find Selection… ( - -S)

The Find Selection… command lets you find the next
occurrence of a word or phrase that you have highlighted
in a text block. When you choose the Find Selection…
command from the Find/Change submenu in the Edit
menu, the Find/Change dialog box opens. The word or
phrase you highlighted in your text block appears in the
Search for text field of the dialog box.

You can enter these equivalents into the Search for or
Change t o fields as well as selecting one from the Inser t
special character pop-up menu. To search for a carrot (^),
enter a double carrot (^^) into the appropriate field.
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Change All

The Change All command changes every occurrence of a
designated word or phrase in a document into another
word or phrase.

You can choose the Change All command after you have
found a word using the Find… or Find Again commands.
When you highlight the word or phrase and choose the
Change All command from the Find/Change submenu in
the Edit menu, changes each occurrence of
that word or phrase in the document into a new word or
phrase. The new word or phrase is the same text you
entered into the Change t o text field when you last used
the Find… command. 

Remember, you can change all the font, styles, and sizes
of words or phrases, too. 

Change & Find Again ( - -L)

The Change & Find Again command changes a word or
phrase and then continues on to find the next occurrence
of the original word or phrase. 

You can choose the Change & Find Again command after
you have found a word using the Find… or Find Again
commands. When you highlight a word or phrase and
choose the Change & Find Again command from the
Find/Change submenu in the Edit menu, 
changes it into a new word or phrase. The new word or
phrase is the same text you entered into the Change t o
text field when you last used the Find… command. 

After the application makes the change, it continues on to
find the next occurrence of the original word or phrase.
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The General panel lets you set application-specific inter-
face attributes. 

Entering your User name

lets you enter your name in the General area
of the General panel. After you enter your name, it
appears in the Author field of any file created in your
application. The Author field appears in the Document
Info panel of the Document Settings dialog box in the
Document menu. By checking the Author field of any doc-
ument, you can find out who first created it.

Preferences…

The Preferences… command lets you set attributes for the
interface. These attributes generally control

how the application presents textual and graphic informa-
tion. To set document specific preferences, choose the
Document Settings… command in the Document menu.

When you select Preferences…, a dialog box appears.
Several panel icons appear in the scroll area on the left
side of the dialog box. You can control applica-
tion attributes by setting various options available on
each panel. By default, the Preferences dialog box opens
to the last panel used.

Setting Application Attributes in the General Panel
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By default, the application takes the Macintosh owner’s
name from the Sharing Setup control panel and places it
in the User Name field. You can replace this name by
entering a new one into the text field. 

Setting Measurement Units

lets you decide what horizontal and vertical
units should appear on the rulers in your documents. You
can choose from: Agates , Centimenters , Inches (Decimal) ,
Inches (Fractional) , Millimeters , Picas , Picas & Points ,
Points , and Printer ’s Points . You can select measurements
for both the horizontal and vertical rulers.

Note: Most computer programs consider 72 points equal
to an inch. However, typesetters consider 72.27
points equal to an inch. lets you select
the measurement you desire. Choose the Points
option if you want 72 points in an inch or the
Printer ’s Points option if you want 72.27 points in
an inch. 

By default, the application appears with its rulers set to
inches (fractional).

Setting Screen Margins

lets you determine the distance between the
outer edges of a Document Window and the edges of the
monitor screen. When you enter a pixel value into the
Right and Bottom fields, the Document Window resizes so
that the right and bottom edges of the window appear
that many pixels away from the screen edge.

Typically, the application places the palettes in their
default positions at the right and bottom of the screen.
Then it makes a Document Window that fits the remain-
ing area. If necessary, overlaps the palettes at
the bottom of the screen. The palettes at the right of the
screen resize to fill any extra space. The application
never places any palettes in the bottom right corner of
the screen. This lets you drag items to the Trash Can.

Setting the check box attributes

can display information in several different
ways. Selecting a check box tells the application to:

• Use dynamic scrolling
Selecting the Use dynamic scrolling check box
makes the items in a scroll list or window move
at the same time you move a scroll box. If you do
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not select the check box, the scroll list or window
jumps to the appropriate place only after you
release the scroll box.

• Remember window positions
The Remember window positions check box tells
the application to remember the on-screen posi-
tion of the palettes. This places the palettes
where you want them to appear every time you
open a new document.

• Use grayscale appearance in dialog
The Use grayscale appearance in dialog check box
grays the background of most dialog boxes. Some
dialog boxes—such as the Print, Page Setup,
Open, and directory dialog boxes—never appear
grayed. If you do not select this option, all dialog
boxes appear with a white background

• Keep file palettes visible while in the back -
ground
The Keep file palettes visible while in background
check box prevents from hiding
palettes when you switch to the Finder. This
makes it easy to drag files from the Finder to the
Files palette.

• Revert to arrow tool after creating shape
The Revert to arrow tool af t er creating shape
check box tells the application to immediately
select the arrow tool upon completion of a drawing
action. This lets you select an element for resizing,
moving, etc. If you do not select the check box,

keeps the selected drawing tool active.

• Keep backup when saving
The Keep backup when saving check box tells the
application to save a second copy of the document.
The application saves the copy to the same folder
as the main document. The backup file has the
same name as the main document but ends in
.bak . You must save a document before the appli-
cation makes a backup copy.

• New elements overprint black by default
The New elements overprint black by default
check box tells to print all newly
drawn black elements over other elements. If you
do not select the check box, the application
knocks out all black elements. 
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For a discussion of overprint, knockout, and other
trapping features, see the Trapping command in
the Elements menu.

Importing CIF starbursts

The application lets you determine how you want to
import starbursts created in Multi-Ad Creator. Click the
Starbursts radio button if you want to import Creator
starbursts in a format that recognizes as a
starburst. Click the Polygons radio button if you want to
import Creator starbursts as polygons.

Setting startup attributes

The On startup pop-up menu lets you determine how
acts when you launch the application. The

Create New Document option opens the New Document
dialog box. The Bring up “Open” Dialog option opens a direc-
tory dialog box that lets you choose a pre-existing docu-
ment to work on. The Do Nothing option displays the menu
bar with all the menus except the File menu dimmed.

Setting Attributes in the Graphics Panel

The Graphics panel lets you set graphic attributes for the
application. You can set preview attributes and
Photoshop masks.

Setting Preview Resolution

The Preview Resolution area lets you set the amount of
detail displayed when you place a graphic file in your
document. The higher the dpi, the higher the preview
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detail. However, a higher dpi preview setting also takes
longer to display. The selected preview resolution does
not affect the print quality of the graphic.

If you plan to mask graphics, you may want to select a
high preview resolution. The more detailed the graphic,
the more accurate the mask. Masking a graphic with a
low preview resolution may look good on screen, but the
printed image may have areas that also need masking.

By default, sets the preview resolution to 72
dpi.

Setting Preview Depth

The Preview Depth area lets you set the number of colors
displayed when you place a graphic file in your document.
The more colors displayed, the more realistic the preview
becomes. However, the more colors you include in the pre-
view, the longer it takes to display. The selected preview
depth does not affect the print quality of the graphic. By
default, sets the preview depth to 256 colors. 

Setting other graphic options

has four more options that you can set in the
Graphics panel. These options include:

• Use Rough Previews
The Use Rough Previews check box tells the appli-
cation that you do not want to import an image of
the graphic file. Instead, places the
graphic’s filename and dimensions in place of the
image in the document. Using rough previews can
significantly improve your computer ’s handling of
the document.

If you do not select the Use Rough Previews check
box, the application always imports the graphic
image into your document. 

• Always use Adobe Photoshop™ masks
The Always use Adobe Photoshop™ masks check
box lets you import graphics with masks created
in Adobe Photoshop. If you do not select the check
box, imports graphics in their original
form.
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The Document Sizes panel, lets you add your own custom
document sizes and group them together. When you enter
a customized document size, or set of document sizes, you
can access them when you open a new document.

When you select the Document Sizes panel the available
sizes appear in a scroll list. You can select a different set
of sizes in the Set pop-up menu above the scroll list. If
you like, you can create your own set of frequently used
sizes, or even create a customized size and add it to a set.

Setting attributes in the Document Sizes panel

• Set print spots as process when placing EPS
files
The Set print spots as process when placing EPS
files check box converts all spot colors in an EPS
file into their process color equivalents. You may
want to select this check box if your document
already contains more than three colors.

• Add spot colors to colors palette when plac -
ing EPS files
The Add spot colors to colors palette when placing
EPS files check box tells to add any
spot colors in an EPS file to the Colors palette.
This lets you reference or use those same colors
later in your document.
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Creating and modifying document sets

To create your own set, click the New Set button in the
upper right corner of the dialog box. A dialog box opens
that lets you to name the new set. The set’s name
appears in the pop-up menu above the scroll list. 

To remove a set from the pop-up menu, select a set name
and then click the Delete button. Make sure you have
selected the set name that you want to delete, because

does not ask you to verify the set.

Should you wish to change a set’s name, select the set
and click the Rename button. A dialog box appears
prompting you for a new name. Enter the new set name
and click the OK button. Notice that the name in the Set
pop-up menu changes.

Creating and modifying document sizes

If you wish to enter a customized document size into a
document set, select the desired set from the pop-up
menu. Now enter a name for the new document size in
the Name field below the scroll list. Also enter the desired
width and height values. Once you have entered informa-
tion into all the fields, the Add button becomes active.
Click the Add button to place the document size name in
the scroll list.

Should you wish to change the document size’s name,
select the size and click the Replace button. A dialog box
appears prompting you for a new name. Enter the new
size name and click the OK button. Notice that the name
in the scroll list changes.

To remove a document size from the scroll list, select a
document size from the scroll list and then click the
Delete button.

Finally, you can rearrange the order of the size entries.
Simply click on a listing and drag it to a new position.
Notice that a highlighted line appears in place of the list-
ing. Place the line where you want the listing to appear.
When you release the mouse button, the selected size
entry appears in place of the highlighted line.
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The Tex t panel lets you determine how the application
handles text and sets the behavior of text editing tools.

Checking for text overflow

The check boxes in the Check for text overflow area lets
you determine when should check for text that
has gone beyond text block boundaries. If text overflow
does occur, the application warns you so you can reshape
the block. This feature helps prevent text from getting
chopped off after you resize a text block, add text to a
text block, or reformat a text block. You can tell

to notify you of text overflow:

• on printing

• on printing from AppleEvent

• on exporting as a graphic

• on opening document

• on saving document

Setting delimiters

The Tex t panel contains text fields where you can enter
special characters—called delimiters—for use in docu-
ments. When the application encounters these special

Setting Attributes in the Text Panel
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characters while performing some action, it knows that it
needs to modify the text contained between the charac-
ters. The delimiter fields available in the Tex t panel
include:

• Style Model delimiters
You use style model delimiters when creating and
applying style models. You can use any of the
default delimiters shown in the text field (\, |, ~ ,
`, or ^) or you can enter a character of your own
choosing. Style model delimiters delete them-
selves after encounters them and
makes the designated format change. 

For more information on style model delimiters,
see the Style Model command entry.

• Tag delimiters
You use tag delimiters in text files to indicate
style tags. When you import a file into the appli-
cation and apply Use Tags, the application strips
the file of its tags and applies specified formats in
their place. You can use the default delimiters
shown in the text field (« and ») or you can enter
a character of your own choosing.

Note: If any of the delimiter characters in the Style
Model delimiters or Tag delimiters text fields
appear in the text you want to model, you need to
remove those character from the delimiter field. If
you do not remove them from the text field,

deletes the characters after it has made
the format change.

Setting Type Specification Increments

The Type Specification Increments area of the Text panel
lets you set the behavior of text formatting dialog boxes.
Specifically, type specification increments refers to the
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amount of change made by the buttons in text formatting
dialog boxes. The Type Specification Increment area text
fields include:

• Size
By default, increases font size by 1 pt.
for each button click.

• Auto leading
By default, the application increases the auto
leading size by increments of 5 percent for each
button click.

• Fixed leading
By default, increases the fixed leading
size by 1 pt. for each button click.

• Horizontal Scale
By default, the application increases the horizon-
tal scale by 20 percent for each button click.

• Tracking
By default, increases the tracking by
50 ems for each button click. Tracking is some-
times referred to as kerning.

• Vertical Offset
By default, the application increases the vertical
offset by 5 percent for each button click.

For more information on each type of text formatting—
tracking, leading, etc.—see the appropriate section of the
Reference Manual.
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Setting Attributes in the Status Labels Panel

The Status Labels panel lets you add, change, or delete
the labels that designate a document’s stage in the pro-
duction process. The status labels you currently have in
your document appear in a scroll list within the Status
Labels area.

To add a status label to the scroll list, type the label into
the Label text field to the right of the scroll box and click
the Add button. If you have a status label selected when
you add a new label, the new status label appears after
the selected one. If you don’t have a status label selected,
the new label appears at the end of the list.

To remove a status label from the list, select the label and
click the Delete button. To replace a status label with a
new one, type the new label into the text field, select the
label you want to replace, and then click the Replace but-
ton.

Note that you can only modify status labels in the Status
Labels panel. To assign a label to a document, you must
select the proper label from the Status pop-up menu in
the Document Info panel of the Document Settings dialog
box in the Document menu.
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The Elements Menu

The Elements menu contains the commands you need to
manipulate the appearance of elements. With the com-
mands available under the Elements menu, you can
increase or decrease pen weight, apply fill colors to ele-
ments, design shadows, and more.

The Elements menu also lets you manipulate each ele-
ment with exacting precision. The Element Info… com-
mand gives a series of dialog box panels that let you
adjust nearly every aspect of a selected element.

A complete description of the commands available in the
Elements menu follows.

Element Info…

The Element Info… command lets you modify almost
any characteristic of a element. Element
Info… even lets you make changes to graphic images. 

When you choose the Element Info… command from the
Elements menu, the Element Info dialog box appears.
This dialog box looks much like the Preferences dialog
box in the Edit menu. A scroll list containing panels
appears along the left side of the dialog. By clicking on
one of these panels, you can modify any number of ele-
ment attributes. 

The Apply, Cancel, and OK buttons appear in the lower
right corner of the dialog box in any panel selection. Click
the Apply button to view your changes in the Document
Window. To approve your changes and return to the
Document Window, click the OK button. If you want to
discard your changes and return to the Document
Window, click the Cancel button.

You cannot see all the panels with any element. Only the
most applicable panels for the selected element appear in
the Element Info dialog box. You can only open the
Element Info dialog box for one element at a time.
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Setting Element Attributes in the General Info Panel

The General Info panel of the Element Info dialog box
lets you enter information about the selected element and
its position in the document. 

The text fields in the General Info panel include:

• Name
The Name field lets you name individual elements
or graphic files. For example, you can use the
name field to order elements in a stack—Square

Rectangles, ovals, starbursts, freehand drawings, and
path shapes all display General Info , Fill , Frame , and
Shadow panels. Rectangles also display Corners panel.
Graphic images display General Info , Shadow , Graphic ,
and File Info panels. Borders display General Info ,
Fill/Frame , Shadow , and Border panels. Lines display
General Info , Frame , and Shadow panels. 

Since treats text blocks like any other ele-
ment, you can manipulate them using the Element
Info… command. Text blocks display the General Info , the
Fill , the Frame , the Shadow , and the Tex t panels.
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1, Square 2, etc.—or to name graphic files—Big 3
at Yalta. Naming elements lets you manipulate
them with AppleScript. For more information on
AppleScript see Appendix E: Scripting.

• Description
The Description field lets you enter any informa-
tion you feel is significant. 

• Top
The Top field represents how far an element sits
from the top of a page. The value you enter into
the field reflects the element’s position on the ver-
tical ruler.

• Left
The Lef t field represents how far an element sits
from the left edge of a page. The value you enter
into the field reflects the element’s position on the
horizontal ruler.

• Height
The Height field represents the length of a
selected element. 

• Width
The Width field represents the width of a selected
element.

• Bottom
The Bottom field represents how far an element
sits from the bottom of a page. The value you
enter into the field reflects the element’s position
on the vertical ruler.

• Right
The Right field represents how far an element sits
from the right edge of a page. The value you enter
into the field reflects the element’s position on the
horizontal ruler.

• Rot
The Rot field represents the number of degrees
an element is rotated.

• Skew
The Skew field represents the number of degrees
an element is skewed.
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The Fill panel of the Element Info dialog box lets you
modify the internal color of any element. The panel
groups color options in the Ink area and provides trap-
ping options as well. Finally, a preview box appears on
the right side of the dialog box so you can view your pro-
posed changes. 

The Fill panel options include:

• Tint
Selecting the Tint radio button lets you fill the
internal area of an element with a solid color.
When you select Tint , two additional options, the
Color pop-up and the Shade text field, appear on
the right side of the Ink area. You can select a fill
color from the Color pop-up menu and shade the
color by entering a percentage in the Shade field.

• Texture
Selecting the Textur e radio button opens a direc-
tory dialog box. You can use the dialog box to
choose a fill texture. You can select a texture from
the Texture Files folder (in the same folder con-
taining the application) or another
folder of your own choosing.

After you have chosen a texture, the Choose
Texture… button appears on the right side of the
Ink area. Click the Choose Texture… button to

Setting Element Attributes in the Fill Panel
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return to the directory dialog box. For more infor-
mation on textures, see the Frame Texture…
command below.

• Gradient
Selecting the Gradient radio button opens the Edit
Gradient dialog box. Set your desired attributes
in the dialog box and then click OK to return to
the Fill panel. 

After you have chosen a gradient, the Choose
Gradient… button appears on the right side of
the Ink area. Click the Choose Gradient… button
to return to the Edit Gradient dialog box. For
more information on gradients, see the Fill
Gradient… command below.

• Trapping
The Trapping pop-up menu lets you set the print
size of the fill color in relation to other element
attributes. You can choose from Overprint ,
Knockout , Choke Knockout , and Spread Knockout
options. 

Selecting the Knockout , Choke Knockout , and
Spread Knockout options activates the text field
and arrow buttons to the right of the Trapping
pop-up. This text field lets you define the fill color
print size for these options in points.

For more information on trapping, see the
Trapping command below.

• Overprint Black
The Overprint Black check box tells to
always print black ink over another color for that
element only.
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The Frame panel of the Element Info dialog box lets you
modify the boundary of any element. In addition to typi-
cal frame options like color and weight, the Frame panel
also lets you set a frame’s trapping attributes. Finally, a
preview box appears on the right side of the dialog box so
you can view your proposed changes. 

The options available in the Frame panel include:

• Tint
Selecting the Tint radio button lets you frame an
element with a solid color. When you select Tint ,
two additional options, the Color pop-up and the
Shade text field, appear on the right side of the
Ink area. You can select a fill color from the Color
pop-up menu and shade the color by entering a
percentage in the Shade field.

• Texture
Selecting the Textur e radio button opens a direc-
tory dialog box. You can use the dialog box to
choose a fill texture. You can select a texture from
the Texture Files folder (in the same folder con-
taining the application) or another
folder of your own choosing.

Setting Attributes in the Frame Panel
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After you have chosen a texture, the Choose
Texture… button appears on the right side of the
Ink area. 

Click the Choose Texture… button to return to
the directory dialog box. For more information,
see the Frame Texture… command below.

• Type
The Type area of the Frame panel includes two
features. A preview field displays the current bor-
der type. The Choose Type button to the right of
the preview field lets you open a dialog box. This
dialog box contains all the available frame types.
Select a frame from the scroll list and click the OK
button to return to the Frame panel. Click the
Cancel button to discard your selection and
return to the Frame panel.

• Weight
The Weight text field lets you enter a desired
point size for the frame in the text field.

• Trapping
The Trapping pop-up menu lets you set the print
size of the fill color in relation to other element
attributes. You can choose from Overprint , Knockout ,
Choke Knockout , and Spread Knockout options. 

Selecting the Knockout , Choke Knockout , and
Spread Knockout options activates the text field
and arrow buttons to the right of the Trapping
pop-up. This text field lets you define the fill color
print size for these options in points.

For more information on trapping, see the
Trapping command below.

• Overprint Black
The Overprint Black check box tells to
always print black ink over another color for that
element only.

You can place a texture from the Ink area of the Frame panel. Notice the
selected texture’s file name appears below the Choose Texture button.
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The Fill/Frame panel of the Element Info dialog box lets
you modify the internal color of borders. 

Note: The Fill/Frame panel only appears when you have
selected a border.

The Fill/Frame panel groups color and trapping options
for both the fill and frame areas. Finally, a preview box
appears on the right side of the dialog box so you can
view your proposed changes. 

The Fill/Frame panel options include:

• Tint
Selecting the Tint radio button lets you fill the
internal area of an element with a solid color.
When you select Tint , two additional options, the
Color pop-up and the Shade text field, appear on
the right side of the Fill area. You can select a fill
color from the Color pop-up menu and shade the
color by entering a percentage in the Shade field.

• Texture
Selecting the Textur e radio button opens a direc-
tory dialog box. You can use the dialog box to
choose a fill texture. You can select a texture from
the Texture Files folder (in the same folder con-
taining the application) or another
folder of your own choosing.

Setting Attributes in the Fill/Frame Oanel
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After you have chosen a texture, the Choose
Texture… button appears on the right side of the
Fill area. Click the Choose Texture… button to
return to the directory dialog box. For more infor-
mation on textures, see the Frame Texture…
command below.

• Gradient
Selecting the Gradient radio button opens the Edit
Gradient dialog box. Set your desired attributes
in the dialog box and then click OK to return to
the Fill panel. 

After you have chosen a gradient, the Choose
Gradient… button appears on the right side of
the Fill area. Click the Choose Gradient… button
to return to the Edit Gradient dialog box. For
more information on gradients, see the Fill
Gradient… command below.

• Color
The Color pop-up in the Frame area lets you
apply a color to the selected border. You can even
shade the color by entering a percentage in the
Shade field.

• Trapping
The Trapping pop-up menu, which appears in both
the Fill and Frame areas, lets you set the print
size of the fill color in relation to other element
attributes. You can choose from Overprint ,
Knockout , Choke Knockout , and Spread Knockout
options. 

Selecting the Knockout , Choke Knockout , and
Spread Knockout options activates the text field
and arrow buttons to the right of the Trapping
pop-up. This text field lets you define the fill color
print size for these options in points.

For more information on trapping, see the
Trapping command below.

• Overprint Black
The Overprint Black check box tells to
always print black ink over another color for that
element only.
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The Shadow panel of the Element Info dialog box lets
you set and modify the shadow of any element. The panel
groups color options in the Ink area and provides offset,
outset, and trapping options as well. Finally, a preview
box appears on the right side of the dialog box so you can
view your proposed changes. 

The Shadow panel options include:

• Tint
Selecting the Tint radio button lets you fill the
internal area of an element with a solid color.
When you select Tint , two additional options, the
Color pop-up and the Shade text field, appear on
the right side of the Ink area. You can select a fill
color from the Color pop-up menu and shade the
color by entering a percentage in the Shade field.

• Texture
Selecting the Textur e radio button opens a direc-
tory dialog box. You can use the dialog box to
choose a fill texture. You can select a texture from
the Texture Files folder (in the same folder con-
taining the application) or another
folder of your own choosing.

After you have chosen a texture, the Choose
Texture… button appears on the right side of the
Ink area. Click the Choose Texture… button to
return to the directory dialog box. For more infor-
mation, see the Frame Texture… command below.

Setting Attributes in the Shadow Panel
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• Gradient
Selecting the Gradient radio button opens the Edit
Gradient dialog box. Set your desired attributes
in the dialog box and then click OK to return to
the Fill panel. After you have chosen a gradient,
the Choose Gradient… button appears on the
right side of the Ink area. Click the Choose
Gradient… button to return to the Edit Gradient
dialog box. For more information on gradients,
see the Fill Gradient… command below.

• Offset
The Offset option contains two different text
fields, the Horiz and Vert fields. To determine how
far away a shadow rests from its original element
on the horizontal plane, enter a value in the Horiz
field. To determine how far away a shadow rests
from its original element on the vertical plane,
enter a value in the Vert field. To choose your
default measurement value, see the
Preferences… command entry.

• Outset
The Outset text field lets you determine the size
of the shadow element. To make the shadow ele-
ment larger than the original element, enter a
positive value. To make the shadow element
smaller than the original element, enter a nega-
tive value.

• Trapping
The Trapping pop-up menu lets you set the fill
color's print size in relation to other element
attributes. You can choose from Overprint ,
Knockout , Choke Knockout , and Spread Knockout
options. 

Selecting the Knockout , Choke Knockout , and
Spread Knockout options activates the text field
and arrow buttons to the right of the Trapping
pop-up. This text field lets you define the
shadow’s print size in points.

For more information on trapping, see the
Trapping command below.

• Overprint Black
The Overprint Black check box tells to
always print black ink over another color for that
element only.
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The Tex t panel of the Element Info dialog box lets you
modify the arrangement of text and provides you with
some information about the text in the selected block. 

The options in the Text panel include:

• Horizontal Scale
The Horizontal Scale text field lets you adjust the
width of characters. Increasing the percentage
makes text characters thicker, while decreasing
the percentage makes text characters thinner.
The values in these fields may change if you
choose the Copy Fit… command from the Format
menu.

• Vertical Scale
The Vertical Scale text field lets you adjust the
height of characters. Increasing the percentage
makes text characters taller, while decreasing the
percentage makes text characters shorter. The
values in these fields may change if you choose
the Copy Fit… command from the Format menu.

• Text Inset
The Text Inset text field lets you determine how
far in from the frame of a text block to start the
text. Enter the distance, in any measurement sys-
tem, that you want text set in from all the bor-
ders of a text block.

Setting Attributes in the Text Panel
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• Editing background color
The Editing background color field lets you deter-
mine the color of an active text block. 
displays this color to help you separate text
blocks from other elements, as long as the text
block does not have a solid fill color.

Note: This text block background color appears
for display purposes only. It does not
appear on the printed copy of your docu-
ment.

Clicking on the white box that follows Editing
Background color opens a dialog box that lets you
choose a background color.

The dialog box lets you access the color system
panels installed on your computer. For more
information, see the Colors… command entry.

• Text flow name field
The Text flow name field lets you identify a flow of
text across different text blocks. You can use the
text flow name to make changes to particular text
using AppleScript.

The Text Counts area of the Text panel lets you know the
amount of information contained in the selected block.
The Text Counts area provides you with information on:

• Characters
The Characters count tells you the number of text
characters in the selected block and in linked
blocks.

• Words
The Words count tells you the number of words in
the selected block and in linked blocks.

• Lines
The Lines count tells you the number of lines in
the selected block and in linked blocks.

• Paragraph
The Paragraph count tells you the number of
paragraphs in the selected block and in linked
blocks.
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The Border panel of the Element Info dialog box lets you
apply different types of borders to frames created with
the Border tool. Click on a border element in the
Document Window and then choose Element Info… from
the Elements menu and select the Border panel in the
Border Info dialog box. You can also double-click on the
border element to open the Border Info dialog box.

Select the border category you want from the Border pop-
up menu. Each border category contains many different
styles of borders. The different border styles available for
the chosen category appear in the scroll list above the
Border pop-up menu. If the selected element already has
a border applied to it, the Border panel automatically
appears with the appropriate category selected and the
border highlighted.

Click on the desired border after you have located it in
the scroll list. Click the Apply button to see how the bor-
der would appear on the chosen frame. Click the OK but-
ton to approve the border and return to the Document
Window. Click the Cancel button to discard the selected
border and return to the Document Window.

Setting Attributes in the Border Panel
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Setting Attributes in the Corners Panel

The Corners panel of the Element Info dialog box lets
you apply different corner styles and set the corner size
of rectangles.

The Corner panel options include:

• Type
The Type pop-up menu lets you specify what cor-
ner style you want to appear on the selected rec-
tangle. You can choose from Plain , Rounded ,
Inver ted, Rounded + Inver ted, and Beveled corner
styles.

• Horiz radius
The Horiz radius text field lets you set the hori-
zontal dimension of the selected corner style.

• Vert radius
The Vert radius text field lets you set the vertical
dimension of the selected corner style.

• Link
The Link button lets you proportionally change
the dimensions of a rectangle’s corners. To unlink
a corner, click the Link button and a broken chain
appears on the button. You can how modify the
selected corner without affecting any of the other
corners.
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Setting Attributes in the File Info Panel

The File Info panel of the Element Info dialog box pro-
vides you with information about the selected graphic
file. 

The options in the File Info panel include:

• Technical
The Technical text field provides you with infor-
mation on a graphic file’s name, location, file
type, the program it originated from, its date of
creation, and its last modification date.

• Description
The Description text field lets you add notes about
the file yourself. You can give the graphic a name,
discuss its significance to your document, or add
whatever information you like.

• Keywords
The Keywords text field lets you associate your
document with certain words. When you catalog

documents using Multi-Ad Search,
Search references the keywords with the docu-
ment name. This lets your retrieve documents
using a keyword.



103Reference Manual

The Graphics panel of the Element Info dialog box lets
you modify the appearance of imported graphics in a vari-
ety of ways. You can alter a graphic’s size, mask a
graphic, and—in some cases—color a graphic. 

The options in the Graphic panel include:

• Horizontal Scale
The Horizontal Scale text field lets you increase or
decrease the width of a graphic. Just enter the
percentage by which you want to increase or
decrease the graphic.

• Vertical Scale
The Vertical Scale text field lets you increase or
decrease the height of a graphic. Just enter the
percentage by which you want to increase or
decrease the graphic.

• Mask with Bitmap
The Mask with Bitmap check box lets you apply a
mask to one-bit graphic images. Click the Apply
button to mask a graphic and Click the OK button
to accept the mask.

• Select New Graphic
The Select New Graphic… button opens the
Place Graphic dialog box. You can use the dialog
box to find a new graphic file to use in place of an
old one.

Setting Attributes in the Graphic Panel
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• Foreground Color
The Foreground Color pop-up menu lets you
choose a color to replace the black portion of a
one-bit graphic, colorizable PICT, or bitmap
image. You can also enter a shade percentage.

If you cannot color the foreground of an imported
graphic, the Foreground Color pop-up menu
appears dimmed.

• Background Color
The Background Color pop-up menu lets you
choose a color to replace the white portion of a
one-bit graphic, colorizable PICT, or bitmap
image. You can also enter a shade percentage.

If you cannot color the foreground of an imported
graphic, the Background Color pop-up menu
appears dimmed.
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The Open Element command places the contents of a
selected container element in a new window for editing.

All changes you make to an element's contents in the
Open Element window affect the Document Window, too.
If you want, you can drag elements between the Open
Element window and the Document Window.  This lets
you add or remove elements from the container. You can
also add or remove contents by using the Containment
tool.

Open Element ( - -0)

The Open Element window displays the selected rectan-
gle and its contained oval. Notice that you can select and
modify the oval in the element window.
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Make Element Style… ( - -T)

The Make Element Style… command lets you create an
element style based on an element you have already for-
matted. The Make Element Style… command opens the
Edit Element Style dialog box with the attributes of the
selected element already set.

Making an Element Style from a formatted element

1. Click on the element whose formatting you want to
make into an element style.

2. Choose the Make Element Style… command in the
Elements menu. The Edit Element Style dialog box
appears with the selected element’s formatting
already entered in the appropriate fields.

3. Set additional formatting information, if any.

4. Enter a name into the Style Name text field.

5. Click the OK button to place the element style in the
Styles palette. Click the Cancel button if you do not
want to save the style.

The Key Equivalent text field lets you create a keyboard
shortcut that automatically applies the specified style to
an element. The specified key shortcut appears next to
the style's name on the Styles palette. You should not use
a keyboard shortcut used by another style or by

.
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Trapping

The Trapping command lets you set trapping attributes
for a selected element. When you choose the Trapping
command from the Elements menu, the Trapping palette
appears. 

With the Trapping palette, you can set trapping attributes
for an element’s frame, fill, and/or shadow. Selecting the
Overprint Black check box tells to always print
black ink over another color for that element only.

Trapping an element

1. Click on the element whose printing attributes you
want to set.

2. Choose the Trapping command from the Elements
menu. The Trapping palette appears.

3. Select the desired trapping option from the appropri-
ate pop-up menu. 

Pre-press Definitions:

• Trapping
Trapping refers to
the intentional over-
lapping of adjacent
colors to prevent
misregistration. 

• Misregistration
Misregistration, or
out of registration,
occurs when the
foreground element
and its knockout do
not exactly match.
This leaves white
gaps between an
element and its
background color.

• Overprint
An overprint refers
to the process of
printing one color on
top of another. If the
background color is
darker than the fore-
ground element, the
background color
may show through
the foreground ele-
ment, changing its
color.

Continued on page 108…
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Each pop-up menu on the Trapping palette lets you
choose one of several printing attributes. The pop-up
menu options include:

• Overprint
Selecting the Overprint option causes the color of
the selected element to print over another color.
In other words, overprint means that a color
prints on an area of paper previously printed on
by another color.

You may find that you can overprint a dark color
on a light color. For example, you might want to
put a black circle over a light blue background.
You can do this because the blue background
doesn’t significantly change the circle’s black ink.

You should not, however, overprint a light color
on a dark color, because you may get an undesir-
able color mix. For example, you may not want to
place a yellow circle on a blue background
because the overlapping area of the circle appears
green when it prints.

Overprinted area

Light 
foreground
color

Dark 
background
color

Dark color
overprinted on
a light color

…continued from page 107

• Knockout
A knockout refers
to a black shape on
a color plate. An
element of the
same shape, but of
another color can
be located over the
knockout area.

• Choke
A choke refers to
the slight reduction
of an element’s
knockout on a
background color.
Since the element
prints at regular
size, the back-
ground color over-
laps the element’s
color.

• Spread
A spread refers to
the slight enlarge-
ment of a fore-
ground element.
Since the element’s
knockout prints at
regular size, the
element’s color
slightly overlaps
that of the back-
ground color.
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• Knockout
Selecting the Knockout option cuts the shape of
the selected feature out of the background color.
This solves the problem of overprinting a light
color foreground over another color. To get a true
representation of the desired foreground color, it
must print on white paper (this is true of all
process inks).

• Choke Knockout
Selecting the Choke Knockout option makes the
knockout area of an element slightly smaller than
the element’s actual size. Because paper shrinks
or stretches after ink is applied during printing,
your foreground color may shift “out of registra-
tion”—white lines appear between the foreground
and background colors. Choking the knockout can
fix this problem.

You may want to choke an item if the background
color is lighter than the foreground color.

Background color

Foreground color Knockout
area
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• Spread Knockout
Selecting the Spread Knockout option makes the
foreground element slightly larger than its knock-
out area. Because paper shrinks or stretches after
ink is applied, your foreground color may shift
“out of registration”—white lines appear between
the foreground and background colors. Spreading
the knockout can fix this problem.

You may want to spread an item if the foreground
element is lighter than the background color.

Elements and their trapping capabilities

By default, assumes you want to Knockout all
elements. If you select the New elements overprint black
by default check box in the General panel of the
Preferences dialog box in the Edit menu, all black ele-
ments default to Overprint .

Note: only defaults to Overprint when you
have selected a black element and have selected
the New elements overprint black by default check
box. regularly defaults to Knockout .

You can knockout, choke, and overprint imported graph-
ics. You cannot, however, spread an imported graphic.

You can trap the shape of an element that has a gradient
applied to it. The trap does not apply to the gradient
itself.
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The Convert Text to Paths command lets you make a
duplicate of a text block that you can manipulate as a
shape element. You can alter the appearance of the text by
editing the element’s control points with the Reshape tool .
Turning text into a path lets you contain graphics inside
letters, apply fill gradients to letters, or create other spe-
cial effects.

Note: You can only convert one text block to a shape ele-
ment at a time. The Convert Text to Paths com-
mand is intended for use on small sections of text. If
you select a linked text block and then select the
Convert Text to Path command from the Elements
menu, only converts the selected block.

Convert Text to Paths

The Convert Shapes to Path command lets you turn two
or more shape elements into a single element. 

When you select a single path element, you can edit both
elements as one with the Reshape tool.

Convert Shapes to Path
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Converting elements into a single path

1. Select the elements you want to make into a path.

2. Choose the Convert Shapes to Path command from
the Elements menu. This turns all the selected ele-
ments into a single element.

3. Click the Reshape tool on the Tools palette.

4. Click the converted element to display its control
points. Notice that the element now has only one set of
control points.

5. Edit the control points with the Reshape tool.

You can use the Convert Shapes to Path command to
create multiple contour containers and other special
effects. For example, you can convert a rectangle element
and an oval element into a single path element. Then you
can contain another element, like a starburst, inside the
path element.



113Reference Manual

Mask Graphic ( - -M)

The Mask Graphic command lets you hide, or “mask”
excess background from graphic images. ana-
lyzes a selected graphic image, finds the most appropri-
ate outline, and masks the background automatically.
This lets you match the background of an image to the
background you place it on. 

For example, you import a graphic to use in a document.
However, the area surrounding the image, as represented
by the selection box, appears as a white rectangle when
you place it on a dark background. 

A mask as a path element

Since uses a path element to mask a graphic’s
background, you can modify the mask using the Reshape
tool, just as you would an ordinary path shape. 

Double-clicking on a masked graphic acts in the same
manner as double-clicking on a graphic inside a con-
tainer. Double-clicking on a masked graphic with the
Arrow tool opens an element info dialog box, but double-
clicking on a masked graphic with the Containment tool
opens a graphic info dialog box. 

Masking a graphic

1. Click on the graphic you want to mask. You can mask
any placed graphic file, such as: EPS, TIFF, RIFF,
JPEG, and GIF files.
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2. Select Mask Graphic from the Element menu. The
AutoMask dialog box appears.

The Tolerance in pixels field lets you determine how
closely the mask follows the edge of the graphic. The
smaller the tolerance, the more accurate the mask.
However, small tolerances also slow the screen display
and can cause printing troubles.

uses a tolerance default of 1.000. You can
either accept this value or enter your own. Values of 0
to 5 generally provide good results.

3. Click the OK button to create a mask with the entered
tolerance and return to the Document Window. Click
the Cancel button to discard the entered value and
return to the Document Window.

Removing a mask

You can remove a mask from a graphic by clicking on the
graphic with the Containment tool and dragging the
graphic out of the path element. After you do this, simply
delete the path element.

Using masks from other programs

The Mask Graphic… command in usually pro-
vides the desired result, but you may find that other spe-
cialized programs, like Adobe Photoshop, provide better
masks. To take advantage of images with Photoshop
masks, import the graphic and choose the Mask Graphic…
command from the Elements menu. When the AutoMask
dialog box appears, click the Use Photoshop™ mask check
box, the check box appears dimmed unless an imported
graphic has a Photoshop mask. Click the OK button to
return to the Document Window. Notice that 
has applied the Photoshop mask to the graphic.
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The Pen Weight… command lets you set the thickness,
or weight, of lines and frames. 

Choosing the Pen Weight… command from the Elements
menu opens the Pen Width dialog box. You can select a
thickness of a line or frame by clicking on the options.
The options include: Hair (hairline), 1 pt , 2 pt , 4 pt , 6 pt ,
or 8 pt . By default, sets all lines and frames
to 1 pt . If you want to create a custom pen width, enter
your desired point size into the Other text field.

To see how your new pen weight appears in the document,
click the Apply button. To approve the new pen weight
and return to the Document Window, click the OK button.
To discard your changes, click the Cancel button.

Pen Weight… ( -W)

Mask with bitmap

The Mask Graphic command creates a mask by placing a
path element around the selected graphic. However,

offers another masking method that you can
use on certain types of graphics.

Selecting the Mask with bitmap check box in the Graphics
panel of the Element Info dialog box tells to
mask the active element. Notice that this check box only
appears active when you have one-bit graphic images
selected—such as Paint, one-bit TIFF, and one-bit GIF
graphics. 

Instead of placing a path element around the graphic in
order to mask it, the Mask with bitmap check box tells the
application to actually change the content of the image.

physically removes the masked area of the one-
bit graphic.
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Frame Types…

The Frame Types… command lets you modify the appear-
ance of element frames. When you select the Frame
Types… command from the Elements menu, the Frame
Types dialog box opens. 

Changing element frames

1. Click on an element whose frame you want to change.

2. Choose the Frame Types… command from the
Elements menu. The Frame Types dialog box opens.

3. Double-click on one of the frame options that appear
in the scroll list. Or click on an option and then click
the OK button to apply a frame type and return to the
Document Window.

Note: You cannot apply multi-line frames to a line ele-
ment. Use several line elements to create a multi-
line effect.
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Frame Texture…

The Frame Texture… command lets you apply a texture to
an element’s frame. Although comes with many
different textures, you can make your own.

You can use any graphic file type that the application can
import, except PICT or EPS, as a texture. Simply locate
the file you want to use in the Frame Texture… directory
dialog box. then places the graphic image on
the element frame. repeats the graphic pat-
tern throughout the available frame area.

Selecting a frame texture

1. Select an element to apply a frame texture to.

2. Choose Frame Texture… from the Elements menu. A
directory dialog box opens.

3. Select the desired texture from the dialog box.

4. Click the Open button to apply the selected texture to
the frame and return to the Document Window. Click
the Cancel button to return to the Document Window
without selecting a texture.

A 12 pt frame with an applied texture. Although you
can apply textures to frames of any width, textures
look best on thick frames.
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Fill Texture…

The Fill Texture… command lets you apply a texture to an
element’s interior. Although comes with many
different textures, you can make your own.

You can use any graphic file type that the application can
import, except PICT or EPS, as a texture. Simply locate the
file you want to use in the Frame Texture… directory dia-
log box. then places the graphic image inside
the element. repeats the graphic pattern
throughout the elements interior area.

Selecting a fill texture

1. Select an element that you to apply a fill texture to.

2. Choose Fill Texture… from the Elements menu. A
directory dialog box opens.

3. Select the desired texture from the dialog box.

4. Click the Open button to apply the selected fill tex-
ture and return to the Document Window. Click the
Cancel button to return to the Document Window
without selecting a texture.
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Fill Gradient… ( -G)

The Fill Gradient… command lets you fill an element
with a color ramp. You can create a color ramp using any
two colors or two shades of the same color.

Selecting the Fill Gradient… command from the
Elements menu opens the Edit Gradient dialog box. The
Edit Gradient dialog box lets you set a number of gradi-
ent options, like the direction of the gradient, the angle of
the gradient, how many times the gradient repeats, and
so on. The options available depend on the type of gradi-
ent you choose.
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Applying a gradient

1. Click on an element to apply a gradient to.

2. Select the Fill Gradient… command from the
Elements menu. The Edit Gradient dialog box opens.

3. Enter the attributes of the gradient you want to
apply.

4. Click the Apply button to view your settings in the
selected element.

5. Adjust the gradient settings, if necessary.

6. Click the OK button to approve your settings and
return to the Document Window. Click the Cancel
button to discard your settings.

Setting the Gradient Type

The seven buttons along the top of the Edit Gradient dia-
log box represent the available gradient types. Click on a
button, and applies the relating gradient to
the element. The gradient options include:

• None
The None button fills an element with a solid
color. The None button does not apply “no fill” to
an element, it only applies “no gradient.”

• Linear
The Linear button applies a smooth, even gradi-
ent across an element, similar to a straight wave.

• Oval
The Oval button applies a series of blended circles
that radiate outward from a central point.

• Rectangle
The Rectangle button applies a series of blended
rectangles that radiate outward from a central
point.
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The Options area of the Edit Gradient dialog box lets you
determine the direction, angle, and the number of gradi-
ents for an element. 

Setting a gradient’s direction or starting angle

You can set the starting angle of certain types of gradi-
ents with the Starting angle dial. You can only set start-
ing angles for linear and radial blends. For any other
type of blend, the angle pointer does not appear.

For linear blends, the angle pointer determines the direc-
tion of the blend. For radial blends, the angle pointer
determines the starting angle.

To change the angle, click and drag the pointer’s tip to
the desired angle. You can also click at your desired angle
on the dial, and the pointer automatically swings around
to that mark. This helps create blends of 0°, 45°, 90°, and
so on. Pressing the Shift key while clicking constrains the
Starting angle dial to multiples of 15 degrees.

• Shape
The Shape button applies a series of blended
shapes that follow the outline of the element.
These shapes radiate outward from a central
point.

• Radial
The Radial button applies a clockwise gradient
that sweeps through the element from a central
point.

• Linear: Shape
The Linear: Shape button applies a gradient that
follows the outline of the element instead of a
straight line.

Setting Gradient Options

After you select a
new angle on the
S ta r ting angle
d i a l in the Edit
Gradient d i a l o g
box, look in the
P r eview box for
desired effect.
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When you select a radial, oval, rectangle, or shape button, a
crosshair appears at the center of the gradient in the
Preview box. By clicking and dragging on the crosshair, you
can adjust the gradient’s center point. You can also click
where you want the center point located. The crosshair
jumps immediately to the point where you clicked.

As you drag the crosshair, a scale appears in the upper left
corner of the Preview box. This scale tracks the position of
the gradient’s focal point. By default, centers a
gradient’s focal point both horizontally and vertically.

Repeating a gradient

To repeat a gradient a certain number of times, click in
the Repeat Gradient check box. Selecting this check box
lets you enter the number of gradients to repeat into the
text field directly below the Repeat Gradient check box.
You can enter any number between 2 and 127. By
default, repeats a gradient 2 times. 

Clicking in the Back-to-back check box lets you reverse
the starting and ending colors of the next gradient. This
lets you ramp all the colors of a gradient into each other.

Setting a Gradient’s Center Point

Select the Re p e a t
Gradient check box,
in the Edit Gradient
dialog, to activate the
Back-to-back check
box.

In the illustration above, the
P re v i e w box of the Edit
Gradient dialog box displays an
oval gradient with a shifted focal
point.
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You can set the starting and ending colors of a blend by
clicking on one of the end boxes on the Gradient Range
bar. You can choose any color currently available on your
Colors palette for your starting and ending colors. To cre-
ate a blend, you must choose at least two different colors
or two different shades of the same color.

Setting start and end colors

1. Click the Starting Color marker on the left side of the
Range bar. By default, colors this marker
black.

2. Select a color from the pop-up menu. The color
appears on the Range bar and in the Preview box.

3. Select a percentage from the pop-up menu to shade
the color. You can also enter your desired percentage
into the text field.

4. Click the Ending Color marker on the right side of the
Range bar.

5. Repeat Steps 2 and 3.

6. Click the Apply button to view your settings on the
selected element.

The Range bar lets you determine the amount of solid
color that appears before and after the gradient. Click on
a point on the Range bar to insert a slider.

By clicking and dragging sliders, you can decrease the
amount of gradient between the starting and ending col-
ors. By default, fills an entire element with a
gradient. To evenly space sliders on the Range bar, click
the Center button to the right of the Shade field in the
Colors area.

Setting a Gradient’s Color

The Colors area of the Edit Gradientdialog box contains the tools
and commands you need to apply gradient colors, shades, and multiple
gradients. The Center button appears at the bottom right of the Colors
area.



124 Multi-Ad Creator2

Up to now you’ve learned how to make gradients of just
two colors. However, lets you make gradients
with as many colors as you like. To add another color to a
gradient, click on the Range bar to add a slider. Now with
the slider activated, select a color from the pop-up menu.
On your Range bar you can see your starting color blend
into the color you just added. This color, in turn, blends
into the ending color.

For example, you may want to create a blend of white to
green to blue. To create this blend, click the Starting
Color marker and choose Whit e from the pop-up menu.
Now, click on the center of the Range bar and place a
slider. With the slider highlighted, choose green from the
pop-up menu. Click the Ending Color marker and choose
Blue from the pop-up menu. 

Click the Apply button to view your blend. Click the OK
button to place the gradient in the element and return to
the Document Window. Click the Cancel button to dis-
card your changes and return to the Document Window.

Setting Multiple Gradients

The illustration above contains a blend of white to green to blue. The
selected color is represented by the largest marker. As you can see, it
applies a 20 percent blue to the gradient.
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The Shadow Options… command lets you determine the
size and distance of a shadow from its original element.
Choosing the Shadow Options… command from the
Elements menu opens the Shadow Options dialog box.

You adjust a shadow’s position along both the horizontal
and vertical axes in the Offset area of the Shadow Options
dialog box. Simply enter a new value into the Horiz or Vert
text fields. By default, makes a shadow the
same size as its original element. To change the size of the
shadow, enter a new value into the Outset text field. 

Click the Apply button to view your changes on the
selected element. Click the OK button to approve your
changes and return to the Document Window. Click the
Cancel button to discard your settings.

Shadow Textures…

The Shadow Texture… command lets you apply a texture
to an element’s shadow. Although comes with
many textures, you can also make your own textures.

You can use any graphic file type that the application can
import, except a PICT or EPS, as a texture.
then places the graphic image on the element’s shadow.
The graphic appears in its actual preview size. 
repeats the graphic pattern throughout the element’s
shadow area.

Shadow Options…
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Selecting a shadow texture

1. Select the element that you want to apply a shadow
texture to.

2. Choose Shadow Texture… from the Elements menu.
A directory dialog box opens.

3. Select the desired texture from the dialog box.

4. Click the Open button to apply the selected shadow
texture and return to the Document Window. Click the
Cancel button to discard the selected shadow texture
and return to the Document Window.

Shadow Gradient… ( - - -G)

The Shadow Gradient… command lets you fill an ele-
ment’s shadow with a gradient. You can create a blend
using any number of colors or shades. 

Choosing the Shadow Gradient… command from the
Elements menu opens the Edit Gradient dialog box. The
Edit Gradient dialog box lets you set a number of gradi-
ent options, such as the direction of the gradient, the
angle of the gradient, how many times the gradient
repeats, and so on. The options available depend on the
type of gradient you choose.

For more information on gradients, see the Fill
Gradient… command above.

Lock

The Lock command lets you lock selected elements, pre-
venting any changes to those elements' positions or
appearance.

Locking elements

1. Click on the element or elements you want to lock. If
you have no elements chosen or if the chosen ele-
ments are already locked, the Lock command appears
dimmed.
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2. Choose Lock from the Elements menu. The element’s
selection handles appear outlined to indicate the ele-
ment is locked.

You cannot move or edit locked elements in any way. If
you attempt to resize a locked element, dis-
plays a dialog box telling you that the item is locked.

When you click and drag inside a locked element, it acts
as if the click was on the document’s background. You can
drag a selection marquee around other elements, but

ignores any attempt to select a locked ele-
ment.

Unlock

The Unlock command lets you unlock previously locked
elements.

Unlocking elements

1. Click on the element or elements you wish to unlock.
If you have no elements chosen, or if the chosen ele-
ments are not locked, the Unlock appears dimmed.

2. Choose Unlock from the Elements menu. The ele-
ment’s selection handles become solid once again. The
elements can now be moved and edited.
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The Arrange Menu

The Arrange menu contains the commands you need for
ordering the elements you place in your document. You
can, for example, bring an element to the front of a series
or elements or send it to the back. Or, you can group mul-
tiple elements as one, or flip an element along an axis.
The Arrange menu also lets you place guidelines to help
you organize and line up the elements in your document.

A complete description of the commands available in the
Arrange menu follows.

Bring to Front ( =)

The Bring to Front command lets you move a selected
element, or elements, in a layer to the top. 

About elements and layers

The first element you create automatically becomes the
bottom layer in a document. places each addi-
tional element you create above the last element drawn.
The Bring to Front command lets you change this order.

Bringing an element to the front

1. Click on an element you want to bring to the top of a
layer. treats elements as if they lie in a
stack. However, you can change the order of the ele-
ments in a stack

If you cannot click on the element you want to move
because another element covers it, select a nearby
element and press the Tab key. This selects the “next
back” element. Keep pressing Tab until you select the
element you want.

2. Choose the Bring to Front command from the
Arrange menu or click the Bring to Front button on
the Arrangement palette. 
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Send to Back ( -)

The Send to Back command lets you move a selected ele-
ment in a layer to the bottom.

Sending an element to the back

1. Select the element you want to send to the bottom of
a layer. If you haven’t selected an element, the Send
to Back command appears dimmed.

2. Choose the Send to Back command from the Arrange
menu or click the Send to Back button on the
Arrangement palette. 

You can also move groups of elements with the Send to
Back command. When you move groups, the elements in
the group retain the same order relative to each other.

Move Forward ( -=)

The Move Forward command lets you move a selected
element up a layer.

Bringing an element forward

1. Select the element. If if you haven’t selected an ele-
ment, the Move Forward command appears dimmed.

2. Choose Move Forward from the Arrange menu.

You can also move groups of elements with the Send to
Back command. When you move groups, the elements in
the group retain the same order relative to each other.

You can also move groups of elements with the Send to
Back command. When you move groups, the elements in
the group retain the same order relative to each other.

Move Backward ( --)

The Move Backward command lets you move a selected
element down a layer.

Bringing an element backward

1. Select the element. If you haven’t selected an ele-
ment, the Move Backward command appears
dimmed.
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Center Horizontal on Page ( -H)

The Center Horizontal on Pagecommand lets you move
a selected element or group to the horizontal center of the
page that contains the element or group's center point. 

Moving elements to the horizontal center of a page

1. Click the element, or elements, you want to center. If
you don’t have an element selected, the Center
Horizontal on Page command appears dimmed.

2. Choose Center Horizontal on Pagefrom the Arrange
menu. The selected elements move to the horizontal
center of the page

defines the horizontal center of a page as the
point where an invisible vertical line running from the
mid-point at the top of the page to the midpoint of the bot-
tom of the page. The application centers selected elements
so that they intersect this invisible line.

centers elements in the following ways:

• Single elements
If you have selected only one element, 
moves that element to the right or left, depending
on its original location, until the center of the ele-
ment intersects the horizontal center of the page.

• Groups of elements
If you have selected a group of elements,

moves the entire group to the right or
left, depending on the group’s original position,
until the center of the element group intersects
the horizontal center of the page.

The relationship of each element to the group of
elements does not change after your have cen-
tered a group horizontally. If you have a circle at
the top right of your page and a square to the left
of it and 1/2 inch below it, the square still sits to
the left of the circle and 1/2 inch below it after
you have centered the element group.

2. Choose Move Backward from the Arrange menu.

You can also move groups of elements with the Send to
Back command. When you move groups, the elements in
the group retain the same order relative to each other.
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Center Vertical on Page ( -Y)

The Center Vertical on Pagecommand lets you move a
selected element or group to the vertical center of the
page that contains the element or group's center point. 

Moving elements to the vertical center of a page

1. Click the element, or elements, you wish to center. If
you don’t have an element selected, the Center
Vertical on Page command appears dimmed.

2. Choose Center Vertical on Pagefrom the Arrange
menu. The selected elements move to the vertical cen-
ter of the page.

defines the vertical center of a page as the
point where an invisible horizontal line running from the
mid-point at the left of the document to the midpoint of
the right of the document. The application centers
selected elements so that they intersect this invisible line.

centers elements in the following ways:

• Single elements
If you have selected only one element, 
moves that element up or down, depending on its
original location, until the center of the element
intersects the vertical center of the page.

• Groups of elements
If you have selected a group of elements,

moves the entire group up or down,
depending on the group’s original position, until
the center of the element group intersects the ver-
tical center of the page.

The relationship of each element to the group of
elements does not change after your have cen-
tered a group vertically. If you have a circle at the
top right of your page and a square to the left of
it and 1/2 inch below it, the square still sits to the
left of the circle and 1/2 inch below it after you
have centered the element group.

You can center an element in a spread by pressing Shift-
Y . The menu item changes to Center Vertical on Spread.

You can center an element in a spread by pressing Shift-H .
The menu item changes to Center Horizontal on Spread.
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Wrap Text…

The Wrap Text… command lets you change the way text
appears in relation to elements in your document.
Choosing Wrap Text… from the Arrange menu opens the
Wrap Text dialog box.

In the Wrap Text dialog box, you can perform any of the
following:

• Wrap text around nearby elements

• Wrap text within a selected element

• Remove wrapping from a shape

You can apply text wrap settings separately to:

• Combinations of one or more text blocks
and one or more graphics
When you apply text wrap settings to graphics
and text blocks, those elements wrap according to
the settings you’ve made in the Wrap Text dialog
box. This lets you apply different text wrap set-
tings to different groups of elements and text
blocks. 

You can set wrap relationships between text and
one or more elements. If you wish, a text block
can even have multiple relationships. You might
select a text block and a graphic and set wrap
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around, then select the same text block and a dif-
ferent element and set wrap within. That done,
the text wraps around one element, and within
another element. lets you achieve
many unique effects.

You can also wrap text around invisible elements
by setting their fill and line to none and then
using those invisible elements to determine text
wrapping. Try this technique for slanted text
margins or other effects.

To make Wrap Text settings

1. Select the text block(s) and element(s) you want to
apply text wrap settings to.

2. Choose Wrap Text… from the Arrange menu. The
Wrap Text dialog box appears with the following
options:

• No Wrap
The No Wrap radio button lets you keep text
unaffected by any element placed in its text
block. You can also select the No Wrap option
to remove remove an existing wrapping option.

• Around
The Around radio button lets you wrap around
elements placed over the text block.

• Within
The Within radio button lets you place text
inside, and conform to the shape of, graphic
elements.

• Offset text by
The Offset text by text field lets you set the
distance between wrapped text and the borders
of the element the text wraps around or within.

sets the default 1/4 inch, but you
can enter any measurement. For example: 3 pi
for three picas or 2 po for two points or 4 ce for
four centimeters.
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Text wrap occurs whenever a text block or
graphic affected by this setting comes within
the offset distance. Internal wrap occurs when-
ever a text block or element affected by this
setting overlaps by the offset distance.

3. Click the Apply button to view how your text wrap
might affect your document. If the Wrap Text dialog
box rests above some or all the affected elements,
drag it to the side to preview the changes.

4. Click the OK button for the settings to take effect and
to return to the Document Window. To discard your
changes and return to the Document Window, click
the Cancel button. 

Note: In practice, text that’s set to wrap within, or not
wrap at all, may disappear when an element over-
laps it. This element may "hide" your text. When
this happens, click the element that’s obscuring
your text and choose the Send to Back command
from the Arrange menu. Your text will reappear. If
there is more than one element above your text,
you may have to issue this command for each ele-
ment before your text is foremost.

If the element or elements obscuring your text do not
have any color, another way to let your text show through
is by making the element(s) transparent. Do this by
selecting the element(s), clicking the Fill icon, and then
selecting None from the Colors palette.

For more information on the layering of elements, see the
Send to Back and Bring to Front command entries under
the Arrange menu section in this chapter. For details on
assigning colors or other fills to elements, see the section
on the Colors palette in Chapter 2.
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Fit Text Block ( -B)

The Fit Text Block command lets you shrink a selected
text block to the exact size of the text it contains.

To fit a text block

1. Select the text block or blocks you want to fit. If you
have no text blocks selected, the Fit Text Block com-
mand appears dimmed.

2. Choose the Fit Text Block command from the
Arrange menu. The selected text block shrinks so it
hugs the contained text on all sides.

If a text block is smaller than its enclosed text, you need
to resize the block manually. Using the Fit Text Block
command to enlarge text blocks causes text to “rewrap.” 
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Flip Vertical ( -])

The Flip Vertical command lets you turn any element
along its vertical axis. Selected elements flip so each ele-
ment’s bottom side replaces its top side.

Flipping elements vertically

1. Click on the element (or elements) you want to flip.

2. Choose the Flip Vertical command from the Arrange
menu or click the Flip Vertical button on the
Arrangement palette.

Note: When you use the Flip Vertical command on multi-
ple elements, each element flips in its own space.
To flip multiple elements as a group, group the ele-
ments before choosing theFlip Vertical command.

Group ( G)

The Group command lets you take any number of sepa-
rate elements and turn them into a single element as a
group.

Select the elements you wish to group by dragging a
selection rectangle or by pressing the Shif t key while
clicking on each element. You can group text blocks and
graphic elements. If you haven’t selected anything, the
Group command appears dimmed. When you have all

Flip Horizontal ( -[)

The Flip Horizontal command lets you turn any element
along its horizontal axis. Selected elements flip so each
element’s left side replaces its right side.

Flipping elements horizontally

1. Click on the element (or elements) you want to flip.

2. Choose the Flip Horizontal command from the
Arrange menu or click the Flip Horizontal button on
the Arrangement palette.

Note: When you use the Flip Horizontal command on
multiple elements, each element flips in its own
space. If you want to flip multiple elements as a
group, you must group the elements before choos-
ing the Flip Horizontal command.
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your elements selected, click on the Group command in
the Arrange menu. One set of selection handles appears
around the grouped items.

Ungroup ( U)

treats grouped items as a single element.
Anytime you resize, move, flip, or perform some other
action, applies the action to the whole group. 
The Ungroup command lets you break a grouped element
into its component parts. 

To ungroup an item, click on the grouped element. The
Ungroup command appears dimmed if you haven’t selected
anything or if a group cannnot be ungrouped. Choose the
Ungroup command from the Arrange menu. Each compo-
nent’s selection handles replace the group selection handles.

Arrangement

The Arrangement command lets you hide or display the
Arrangement floating palette on the screen. This palette
lets you access many of the commands in the Arrange
menu, like Bring to Front, Send to Back, Flip
Horizontal, Flip Vertical, and others. This command
appears in both the Arrange and View menus.

For more information on the Arrangement palette, see
the Palette section.
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The Guides… command lets you change placed guides
and their relation to nearby elements. 

The options available in the dialog box include:

• Show guides
The Show guides check box lets you view guide
lines. When you have the box deselected, guides
do not appear.

• Snap to guides
The Snap to guides check box lets you place ele-
ments flush against established guide lines or lets
you snap objects to their centers. You can also
click on the Guide Snap Toggle (the small gray
square at the meeting point of the vertical and

Guides…

Element Specs

The Element Specs command lets you hide or display the
Element Specs floating palette on the screen. This palette
lets you control the size and position of an element. This
command appears in both the Arrange and View menus.

For more information on the Element Specs palette, see
the Palette section.
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horizontal rulers). When the box is next to the
dotted lines, the Guide Snap Toggle is on; when
the box is set away from the dotted lines, the
Guide Snap Toggle is off.

• Snap at
The Snap at text field sets the distance an ele-
ment can sit from a guide before snaps
the element to the guide. By default, 
waits until you place an element within 1/4 inch of
a guide before snapping. You can change this
default by entering a new value into the text field. 

In view scales of less than 100 percent, elements
always snap to guides at 1/4 inch, regardless of the
view scale. In view scales of 100 percent or greater,
the application snaps elements to guides at within
1/4 inch of the document scale. The higher the
scale, the more precise the measurement.

You can only access the Snap at field when you
have selected the Snap to guides check box.

• Remove all guides
The Remove all guides button deletes all guides
in the active Document Window’s current spread. 

• Setup guides
The Setup Guides button opens the Setup Guides
dialog box. For more information, see the Setup
Guides… entry below.

When you finish setting the attributes, click the OK but-
ton. To discard your settings, click the Cancel button.
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The Setup Guides… command helps you position ele-
ments in relation to the document and to each other. To
set up guides in your document, choose the Setup
Guides… command from the Arrange menu and the
Setup Guides dialog box appears.

Setting grids

The Grid option lets you establish intersecting vertical and
horizontal guides. To create a system of intersecting
guides, click the Grid radio button. You can now enter
information into the text fields or select one of the options.

Multi-Ad Creator2

In the illustration above, the user has selected the 1/2”
radio button in the Spacing area of the Setup Guides
dialog box. This option places guides at the specified
interval throughout the document.

Setup Guides…
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Three interval measurement radio buttons appear at the
far left of the Grid area: 1 / 4 ”, 1 / 2 ”, and 1”. If you choose
one of these options, the relating value appears in the text
fields. After you click the OK button, places
guides at the selected intervals on both the vertical and
horizontal rulers. 

If you want to create a grid with a different measurement,
enter the desired interval measurements in the Vertical
and Horizontal fields. You do not need to enter the same
value in both fields. 

To place your grid in the document, click the OK button.
To discard you settings and exit the Setup Guides dialog
box, click the Cancel button.

Note: You cannot place guides when you have an active
text block in your document. To place guides, deac-
tivate the text block or select the Arrow tool on the
Tools palette.

Setting custom guides

While the Grid option lets you create basic grids, the
Custom radio button may prove more helpful if you want
to create columns or tables. The custom option lets you
create a specified number of columns and rows at a speci-
fied location in the document. The Custom area contains
many fields for entering table information.

In the above illustration, the Custom area of the Setup Guides dialog
box has been set for two columns and two rows with 1/4 inch spacing
on all sides.
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The Columns field lets you enter the number of vertical
sections you you wish for the page. For example, if you
enter 3 into the Columns field and 1/4 in the From lef t
and From right fields, and 1/8 in the Between columns
field, places guides that divide the page into
three vertical columns, separated by a 1/8 inch area, with
a 1/4 inch border on the right and left sides of the page.
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The Rows field works just like the Columns field, but cre-
ates horizontal sections instead of vertical ones. For
example, if you enter 3 into the Rows field and 0 in all
other fields, places four horizontal guides that
divide the page into three equal areas.

The Spacing area lets you enter information to determine
the distance between individual columns and rows and
from the edges of a page. By default, automat-
ically places 1/4 inch between each column and row.

also puts 1/4 inch between guide lines and the
edges of a page. If you don’t want to use the defaults,
enter your desired values into the text fields.

• Left/right
The Left/right radio button activates the From
lef t and From right text fields. Enter the distance
you want guides to appear from the left and right
edges of a page. This helps you set your desired
left and right margins.
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• Inside/outside
The Inside/outside radio button activates the
From inside and From outside text fields. Enter
the distance you want guides to appear from the
inside and outside edges of facing pages. This
helps you set the desired margins of facing pages.

• Between columns
The Between columns field lets you enter the dis-
tance you want between vertical rows.

• From top/bottom
The From top/bottom field lets you enter the dis-
tance you want between vertical rows and the top
and bottom of a page. 

• Between rows
The Between rows field lets you enter the dis-
tance you want between horizontal rows.

To place your grid on a page, click the OK button. To dis-
card your settings and exit the Setup Guides dialog box,
click the Cancel button.

Note: If you want to ignore any of the fields in the
Spacing area, enter a zero in those fields. If you
leave a field blank, prompts you with
an invalid measurement dialog box. You can, how-
ever, leave either the Columns or Rows fields
blank. If no value appears in either of these fields,

assumes a zero value.
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The Style menu lets you access commands that apply
special characteristics—or styles—to text. You can access
style commands through the Style menu, but the most
frequently used style commands also have keyboard
shortcuts.

Selecting a style

1. Click the Text tool and then click in a text box.

2. Select the section of text you wish to apply a new
style to. If you want a new style for text you wish to
enter, position the insertion point where you want the
text to appear.

3. Choose the desired style from the Style menu.

4. Release the mouse button. Your selected text changes
to reflect the new style. Or the text you type appears
formatted in the selected style.

After you have applied your selected style, select the
styled word and then open the Style menu again. A check-
mark appears beside the style you selected. If you high-
light a range of text with multiple styles, dashes appear
beside every style used within the selected range of text.

To remove an applied style from a range of text, simply
select the command for the applied style a second time, or
choose the Plain Text command.

The Style Menu

Plain Text ( P)

The Plain Text command displays a font as its designer
intended and serves as the default style in all documents.
Choosing the Plain Text command from the Style menu
strips text of all other style attributes. 

The Embolden command makes text appear in boldface
(it makes the weight of selected text greater). You can
specify how great you want to make the weight of bolded
text in the Character dialog box in the Format menu.

Embolden ( B)
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The Outline command makes text appear outlined. You
can apply different colors to the frame and fill of outlined
text. (When you apply the outline style, applies
the main text color to the frame. You need to select a sepa-
rate fill color.) You can specify the weight of an outline in
the Character dialog box in the Format menu.

Outline ( O)

Shadow ( S)

The Shadow command makes text appear shadowed
(duplicate characters appear beneath and slightly offset
from the main text). You can apply a color to the shadow
of shadowed text. You can specify the weight, position,
and slant of a text shadow in the Character dialog box in
the Format menu.

Condense

The Condense command tightens the spaces between
characters, pulling them closer together.

Note: You can use the Tracking… commandin the
Format menu to specify the amount of space you
wish to add or subtract between characters.

Extend

The Extend command increases the spaces between char-
acters, pushing them farther apart.

Note: You can use the Tracking… command in the
Format menu to specify the amount of space you
wish to add or subtract between characters.

Italicize ( I)

The Italicize command makes text appear in italics (it
slants text a certain number of degrees). You can specify
the slant of italicized text in the Character dialog box in
the Format menu.

Underline ( U)

The Underline command makes text appear underlined.
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The Upper Case command converts each letter into its
capital character.

Upper Case

Lower Case

The Lower Case command converts each letter into its
lower case character

Superior ( ;)

The Superior command reduces the specified text to half
its original size and superscripts it to the top half of a line.

Inferior ( ’)

The Inferior command reduces the specified text to half
its original size.

Note: Superior and Inferior cancel each other out.

Superscript

The Superscript command raises the baseline of the cho-
sen text by 15 percent of its point size.

Note: You can use the Offset… commandin the Format
menu to raise or lower text a specified amount
from the baseline.

Subscript

The Subscript command lowers the baseline of the cho-
sen text by 15 percent of its point size.

Note: You can use the Offset… commandin the Format
menu to raise or lower text a specified amount
from the baseline.
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The Size Menu

The Size menu lets you choose a font size for the selected
text. Standard font sizes include 9 pt, 10 pt, 12 pt, 14 pt,
18 pt, 20 pt, 24 pt, 30 pt, 36 pt, 40 pt, 48 pt, 60 pt, 72 pt,
100 pt, and 128 pt.

Selecting a new font size

1. Click on the Text tool on the Tools palette.

2. Click on a text box and select the text whose size you
want to change. If you want to enter new text, posi-
tion the insertion point at the point where you want
the text to appear.

3. Choose the desired size from the Size menu.

4. Release the mouse button. Your selected text changes
to reflect the new size. Any additional text that you
type appears in the newly selected size.
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The Format Menu

The Font Specs command lets you hide or display the
Font Specs floating palette. You can use the Font Specs
palette to select fonts for your document, just like choos-
ing a font from the Font menu. You can also use the
palette to choose a size or a commonly used style.

When you use certain fonts, the Variation and Featur e
pop-up menus become available. The Variation pop-up
menu lets you adjust the appearance of the selected font
while the Featur e menu lets you activate special font
characteristics. The pop-up menus appear dimmed if the
selected font does not contain these options.

This command appears in both the Format and View
menus.

For more information on the Variation and Featur e pop-up
menus, see the entry on the Font Specs palette.

Font Specs

The Format menu contains commands that let you
manipulate the appearance of text and paragraphs. With
the commands in the Format menu, you can justify para-
graphs, place tabs and indents, and adjust the amount of
space between lines.

The Format menu also contains commands that let you
decide how handles sections of text. For exam-
ple, you can use a command from the Format menu to
identify a certain string of text as a specified foreign lan-
guage. You can then use another command from the
Format menu to tell how to hyphenate these
foreign words and phrases.

A complete description of the commands available in the
Format menu follows.
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Alignment

The Alignment submenu lets you set the paragraph align-
ment of text. You can only select the commands in the
Alignment submenu when you have a text block activated. 

Setting text alignment

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the paragraph
whose alignment you wish to change.

3. Click on the Format menu and drag the Arrow
pointer to the Alignment submenu. A new menu
appears next to the arrow in the Alignment selection.

4. Choose the desired alignment command from the
Alignment submenu.

5. Release the mouse button. Your selected text changes
to reflect the new alignment.
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The alignment commands you can choose from include:

• Left ( L)
The Left command lets you align the left edge
of every line. This commands leaves a ragged
right paragraph.

• Right ( R)
The Right command lets you align the right
edge of every line. This leaves a ragged left
paragraph.

• Center ( C)
The Center command aligns all lines so they
appear centered in the text block. This leaves
both the right and left edges of lines ragged.
When you adjust the size of the text block,

adjusts lines so they remain cen-
tered.

• Justify ( J)
The Justify command aligns both the left and
right edges of lines. Justifying adds space
between words to create clean, even left and
right paragraph edges. may even
add some space between letters so the extra
space between words doesn’t appear severe.
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The Language submenu lets you tag a selection of text as
a certain language. When you spell check your document,

spell checks the tagged text with the appropri-
ate language dictionary (automatic hyphenation is also
based on the selected language). 

Setting a language

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the selection of text
whose language you want to specify. If you want to
enter new text, position the insertion point where you
want the text to appear.

3. Choose the Language submenu in the Format menu.
A new menu appears next to the arrow in the
Language selection.

4. Choose the desired language from the Language sub-
menu.

5. Release the mouse button to tag the text as a certain
language. When you check the spelling in your docu-
ment, checks the tagged section of text
against a dictionary of the selected language.

Language



153Reference Manual

Hyphenation ( --)

The Hyphenation command lets you break the text in all
selected paragraphs. You can set the hyphenation rules in
the Hyphenation panel of the Document Settings… dialog
box in the Document menu. To turn off automatic
hyphenation, choose the Hyphenation command again.

Setting hyphens

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the paragraph you
wish to hyphenate. You can hyphenate more than one
paragraph by clicking and dragging or by using the
Select All command in the Edit menu. 

3. Choose the Hyphenation command from the Format
menu. breaks words based on the hyphen-
ation rules established in the Document Settings
dialog box. If you edit text in hyphenated paragraphs,

rehyphenates as necessary.

The languages you can choose from include:

• Danish

• Dutch

• Finnish

• French

• German

• Italian

• Norwegian

• Spanish

• Swedish

• UK English

• US English

By default, uses the language native to your
version of the application. You can change the default lan-
guage for each document in the General panel of the
Document Settings dialog box.
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Discretionary Hyphen ( -)

The Discretionary Hyphen command lets you define the
hyphenation of individual words. The discretionary
hyphen does not appear unless the word with the hyphen
is in a position where it can break. For those words that
cannot yet break, a small insertion mark appears below
the word at the insertion point.

treats discretionary hyphens as invisible char-
acters. To display a discretionary hyphen, select the
Discretionary hyphens check box in the the General panel
of the Preferences dialog box in the Edit menu. 

Discretionary
hyphen

Insert Page Number

The Insert Page Number command lets you number
every page in your document. Simply draw a text block in
the section of the page where you would like the page
number to appear. Choose Insert Page Number from the
Format menu to place the appropriate page number in
the text block.

To automatically number every page in a document, you
must first assign a master spread. With your assigned
master spread displayed, create a text block in the sec-
tion of the page where you want page numbers to appear
in the main document. Choose Insert Page Number com-
mand from the Format menu to place a special page
character into the text block. 

When you return to the main document, a text block with
the appropriate page number appears in the same place
on every page. If you create and assign facing master
spreads, you can even place page numbers in opposing
corners of a two-page spread.

“Smart Quotes”

The “Smart Quotes” command lets automati-
cally place beginning (“ ) and end ( ”) quote characters in
their proper place in a text string. The application
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Character… ( -A)

The Character… command opens a dialog box that lets
you set a variety of attributes for selected text. You can
even change the appearance of text styles like italics and
boldface.

Reformatting characters

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the text you wish to
reformat.

3. Choose the Character… command in the Format
menu. The Character Attributes dialog box opens.

4. Enter the format settings that you wish to apply.

5. Click the Apply button to view the selected text with
your changes. If you like, make further modifications
to the format.

chooses which quote to use based on the preceding quote
character.

A checkmark appears next to the command name in the
Format menu when you activate the “Smart Quotes”
command. You can turn smart quotes on or off at any
point in the document. Smart quotes remain on until you
turn them off. If you like, you can select individual quotes
and make them smart quotes, or vice versa.
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6. Click the OK button to change the text. Click the
Cancel button to discard your changes.

The character attributes you can set include:

• Type style
The Type style pop-up menu lets you apply an
existing style to the selected text. 

• Language
The Language pop-up menu lets you tag the
selected text as a specific language. When you
spell check a document, checks the
spelling of the selected text against a dictionary
of the specified language.

• Font
The Font pop-up menu lets you change the font of
the selected text. All of your system’s active fonts
appear in the pop-up. The pop-up menu next to
the Font pop-up menu lets you select pre-set vari-
ations—called instances—for some fonts.

• Variation
Some fonts let you adjust attributes. You can do
this by clicking on the scroll bar to the right of
the Variation pop-up or by selecting a pre-set com-
bination—an instance—from the pop-up to the
right of the Font pop-up menu. 

For more information on font variations, see the
Font Specs command entry.

• Feature
Some fonts have a variety of typographic features
that you can use in your documents. Some com-
mon features include: character alternates, frac-
tions, number case, letter case, ornaments, and
ligatures.

You can find the Variation pop-up menu in the Font Specs
area of the Character Attributes dialog box.
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Select the desired feature from the Featur e pop-
up. Now select, or deselect, a feature option from
the pop-up menu to the right of the Featur e pop-
up. For example, the Letter Case setting for the
Skia font lets you choose from Upper & Lower
Case or All Caps options.

For more information on font features, see the
Font Specs command entry.

• Size
The Size text field lets you enter the font size of
the selected text. You can enter any desired font
size from 2 to 1,000 points. You can even enter
fractional sizes like 10.5 pt.

If a font size appears outlined, a bitmap font for
that specified size exists in your System folder.
This helps display the font smoothly on screen.

• Leading
The Leading text field lets you set the amount of
space occupied by a line. When you enter a new
value, the leading of every line containing part of
the selected text changes. 

By default, sets leading at 120 percent
of the current point size. You can change the
default leading value in the Text Defaults panel of
the Document Settings dialog box in the
Document menu.

For more information, see the Size/Leading…
command entry in the Format menu section.

You can find the Featur e pop-up menu in the Font Specs
area of the Character Attributes dialog box.



158 Multi-Ad Creator2

• Style
The Style pop-up menu lets you apply any stan-
dard text style to the selected text. Notice that
when you select a text style other than Plain Tex t ,

selects the relating check box in the
Effects area. The style check boxes let you control
the appearance of the text styles.

• Tracking
The Tracking field lets you set the amount of space
between letters. The values in this field refer to
thousandths of an em (the width of a capital M in
the current font and size). You can enter both posi-
tive and negative values in the Tracking field to
increase or decrease the space between characters.

• Horiz. Scale
The Horiz. Scale field lets you set character width.
The default value of 100 percent represents the
intended scale of the font. A larger percentage
expands selected text while a lesser percentage
compresses selected text. Changing the horizontal
scale doesn’t change the character ’s height.

• Vert. Offset
The Vert. Offset field lets you move the selected
text above or below the standard baseline. A posi-
tive percentage superscripts the text while a neg-
ative percentage subscripts the text.

• "Smart Quotes"
The "Smart Quotes" check box lets 
automatically convert your quote marks into open
or closed quote marks. 

• Allow Hanging Characters
The Allow Hanging Characters check box lets

place some punctuation marks outside
the borders of a text block. Not all fonts support
this feature.

• Bold Effect
Selecting the Bold check box lets you apply a
boldface text style to the selected characters.
Notice that the Style pop-up menu changes to
Bold when you select the Bold check box. 
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The Bold check box also lets you specify the thick-
ness of bold characters. Enter a percentage into
the Boldness text field to increase the current
font’s plain text thickness. By default, 
increases the thickness of plain text fonts by 5
percent when bold.

• Italic Effect
Selecting the Italic check box lets you apply an
italic text style to the selected characters. Notice
that the Style pop-up menu changes to Italic
when you select the Italic check box.

The Italic check box also lets you specify the slant
of italicized characters. Enter a degree value into
the Slant text field to adjust the lean of the
selected text. Entering a positive degree value
slants the selected text to the right…

Reference Manual

In the illustration above, the user has selected the Bold check
box in the Character Attributes dialog box and has
increased the font thickness by five percent.

In the illustration above, the user has selected the
Italic check box  in  the  Character  Attributes
dialog box and has angled the text by 14 degrees.
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while a negative value slants the selected text to
the left…

Enter any value from -60 degrees to 60 degrees.

• Outline Effect
Selecting the Outline check box lets you apply an
outline text style to the selected characters.
Notice that the Style pop-up menu changes to
Outline when you select the Outline check box.

• Shadow Effect
Selecting the Shadow check box lets you apply a
shadow text style to the selected characters.
Notice that the Style pop-up menu changes to
Shadow when you select the Shadow check box.
The shadow effect appears at its best when used
with the outline effect.

The Shadow check box also lets you specify a
number of shadow attributes. Each shadow
attribute is similar to the corresponding attribute
in the Bold and Italic check boxes.

The Boldness text field lets you specify what per-
centage of the plain text thickness you want the
shadow. By default, sets the shadow
boldness to zero percent.

In the illustration above, the user has selected the
Italic check box  in  the  Character  Attributes
dialog box and has angled the text by negative 14
degrees.

In the illustration above, the user has selected the Shadow
check box in the Character Attributesdialog box and
has increased font thickness by ten percent.
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The Slant field lets you set a lean and a direction
for the shadow. By default, sets the
slant to zero degrees.

The Offset Horiz and Offset Ver t fields let you
move the shadow’s position left or right, or above
or below the baseline of the main text. By default,

sets both the horizontal and vertical
offset to seven percent.

The Scale Horiz and Scale Ver t fields let you set
the size of the shadowed characters. Increasing
the percentage makes the shadowed text larger
than the main text, while decreasing the percent-

In the illustration above, the user has selected the
Shadow check box in the Character Attributes
dialog box and has angled the text by 25 percent.

In the illustration above, the user has selected the
Shadow check box in the Character Attributes dia-
log box and has offset the shadow from the main text by
seven percent along the horizontal and vertical axes.



162 Multi-Ad Creator2

age makes the shadowed text smaller than the
main text. By default, sets both the
horizontal and vertical scale to 100 percent.

• Text Color
The Tex t pop-up in the Colors area lets you set
the print color you wish for the selected text. The
text field to the right of the pop-up menu lets you
enter the percentage of the color you wish to use.
When you have the outline and/or shadow text
styles selected, the Text pop-up controls the color
of the selected character ’s outline.

• Fill Color
The Fill pop-up in the Colors area lets you set the
color of the inside text area. The text field to the
right of the pop-up menu lets you enter the per-
centage of the color you want to use. You can only
access the Fill pop-up if you have selected the out-
line and/or the shadow text styles.

• Shadow Color
The Shadow pop-up menu lets you set the print
color you wish for the shadow of the selected text.
The text field to the right of the pop-up menu lets
you enter the percentage of the color you wish to
use. You can only access the Shadow pop-up menu
if you have selected the shadow text style.
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Paragraph… ( -F)

The Paragraph… command lets you apply existing para-
graph styles or set paragraph attributes for a selected
paragraph only. To create and save paragraph styles,
refer to the Make ¶ Style …command below.

Reformatting characters

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the paragraph you
wish to reformat.

Note: considers any section of text that
ends in a return character a paragraph.
However, also considers the last
section of text in a block a paragraph even if it
doesn’t end in a return character.

3. Choose the Paragraph… command in the Format
menu. The Paragraph dialog box opens.

4. Enter the format settings that you wish to apply to
the selected text.

5. Click the Apply button to view the selected text with
your changes. If you like, make further modifications
to the format.
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6. Click the OK button to make the changes to the text.
Click the Cancel button to discard your changes.

The paragraph attributes you can set include:

• Paragraph Style
The Paragraph style pop-up menu lets you apply
an existing paragraph style to the selected para-
graph.

• Alignment
The Alignment pop-up menu lets you apply any of
the alignment commands—Lef t , Right , Center , or
Justif y—to the selected paragraph.

• Space Before ¶
The Before ¶ field in the Space area lets you
adjust the amount of space added before the
selected paragraph. Enter a point value into the
text field, and adds that number of
points to the normal line spacing before the first
line of each selected paragraph.

• Space After ¶
The Af ter ¶ field in the Space area lets you adjust
the amount of space added after the selected
paragraph. Enter a point value into the text field
and adds that number of points to the
normal line spacing after a return character.

• Left Indent
The Lef t field in the Indents area lets you set the
amount of space between the left edge of a text
block and the first letter of each selected line.

• Right Indent
The Right field in the Indents area lets you set
the amount of space between the right edge of a
text block and the last letter of each selected line.

• First Indent
The First field in the Indents area lets you set the
amount of space between the left edge of a text
block and the first letter of the first line of the
selected paragraph.

Adding Space Before/After
Paragraphs

Deciding when to add para-
graph space can prove con-
fusing, especially if you don’t
often work on large docu-
ments. Use the following sug-
gestions to help you decide
when to add space and
where:

• Add space before
most paragraphs.

• Add space both before
and after paragraphs.

• Add space after para-
graphs in headers.

• Add spaces after the
closing in letters.

• Add space both before
and after graphics and
tables.
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• Hyphenate
Selecting the Hyphenat e check box lets you apply
hyphenation rules to the selected paragraph. If
you do not select the Hyphenat e box, 
word wraps the selected text instead of breaking
words. You can set the hyphenation rules in the
Hyphenation panel of the Document Settings dia-
log box in the Document menu. 

• Quad Leader
The Quad Leader field lets you attach a leader to
all quad characters in the selected paragraph. You
can create quad characters by pressing the Shif t
key and the Tab key. moves all text fol-
lowing a Shift-Tab (a quad character) flush right. 

Enter a character you wish to use as a quad
leader into the text field. uses this
character to fill the space between a quad charac-
ter and the flush right text.

Note: You can use any character you want as a
quad leader. Some suggested characters
include a period or a hyphen. An under-
score character creates a solid line between
the quad character and the flush right text.

Copy Fit… ( - -=)

The Copy Fit… command lets you resize or scale text to
fit a given text block or linked text blocks.

To Copy Fit text

1. Draw a text block the size of the area you want the
text to fill.

2. Type or place text into the block.

3. Choose the Actual Size command from the View
menu for a better view of the changes to your text.

4. Click on the text block with the Text tool. The Copy
Fit… command appears dimmed if you have selected
a text block with any other tool.



166 Multi-Ad Creator2

Selecting “Scale and rewrap” Options

The “Scale and rewrap” feature has three options:

• Adjust Textblock Scale
The Adjust Textblock Scale radio button lets you
increase or decrease the scale of text inside a
block. It also rewraps the text to fit into the
active block or blocks. The text scales up or down
to fit snugly within the block both vertically and
horizontally.

• Adjust Size
The Adjust Size radio button lets you increase or
decrease the point size of text inside a block. It
also rewraps the text to fit into the active block or
blocks. Some horizontal or vertical space may
remain with this option.

5. Choose the Copy Fit… command from the Format
menu. The Copy Fit dialog box opens.

The dialog box offers two main sets of features—
“Scale and rewrap” and “Scale without rewrapping.” 

6. Click the OK button to return to the Document
Window after you make your selections. Click the
Cancel button to discard your changes and return to
the Document Window.
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• Adjust Leading
The Adjust Leading radio button lets you increase
or decrease the space between lines to fit the text
into the active block or blocks. This doesn’t
change the actual size of the characters, it only
adjusts the space between lines of characters.

With this form of copyfitting, may have to make
several attempts to copy fit the text accurately. Although
this takes some time, it even works with text wrapped
around other elements or contained in more than one block.

can scale the text either up to 500 percent or
down to 20 percent of its original size. In reality, both of
these limits are rather extreme. If you have so much text
and so little space allotted that it has to scale it down to
20 percent of its original size to fit, you probably have too
much text in too little space. If you need to scale it up to
more than 500 percent, you may have too little text in too
much space. On the other hand, you might want the text
quite large. If this is the case, use the Size menu to make
the text the approximate size you want and then use the
Copy Fit… command.

To see what percentage your text has been scaled to when
the Copy Fit… command has finished, double-click the
text block with the Arrow pointer and note the amounts in
the Horizontal and Vertical scaling fields in the Tex t panel
of the Element Info dialog box in the Elements menu.

If you have chosen an option in the Scale and rewrap area,
it may be necessary for to make several passes
in order to copy fit the text. As it does, a dialog box informs
you of the percentage of scaling being applied with each
pass. Cancel the process at any time by pressing Cmd-. .

If you do not like the results, you can undo the changes
by pressing Cmd-Z or choosing Undo from the Edit menu.

Note: Since copy fit operations can result in some very
unusual type sizes, copyfitted text may not look
good on the screen. However, adjustments made by
your PostScript output device will improve the
look of printed versions.

Also, copy fit operations may seem slow in one
instance and fast in the next. This is because

uses successive approximation to
achieve its copyfitting results—and some copyfit-
ting sessions require more attempts than others.
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Selecting “Scale without rewrapping” Options

Typically, you only use the “Scale without rewrapping”
options on headlines. For this reason, these options
appear dimmed if there is more than one text block
selected, the text runs beyond the border of the block, or
the block is not a rectangular shape. The “Scale without
rewrapping” feature has two options:

• Proportional
The Proportional radio button lets you resize the
text inside a block proportionally—only changing
the point size—to fit the surrounding text block.
Some horizontal or vertical space may remain
with this option.

• Scale to Fit
The Scale to Fit radio button lets you resize the
text inside a block non-proportionally. This option
changes both the point size and the horizontal
scaling, so it fits the surrounding text block both
vertically and horizontally. In extreme cases, this
makes the text look either stretched or squashed.
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The Size/Leading… command lets you adjust both the
font size and the leading in a document. You can adjust or
set the font size and leading in several other menus and
dialog boxes, but the Size and Leading dialog box offers
one of the easiest ways to set size and leading attributes.

When you select the Size/Leading… command from the
Format menu, the Size and Leading dialog box opens.
The document’s default font size, or the font size of the
selected text, appears in the Size text field. By default,

sets the values in the Leading text fields to
120 percent and zero points.

To change the font size, enter a new point value into the
Size field. If you haven’t selected any text, you can apply
the new font size to the document. If you have selected
text, you can apply new value to the selected text. You
can also increase the point size by selecting the Size field
and clicking on the Arrow up or Arrow down buttons in
the dialog box. The arrow buttons increase or decrease
font size a point for each click.

To change the leading, enter the space you would like
between lines as a percentage of the selected font size.
You can increase the leading by typing in a new percent-
age or by adding point sizes to the leading percentage.
You can also adjust the leading by selecting either the
percentage of point fields and then clicking on the Arrow
up or Arrow down buttons in the dialog box. The arrow
buttons increase or decrease the percentage field by five
percent and the points field by one point for each click.

To see how your settings affect text, click the Apply but-
ton. To use your new settings, click the OK button. If you
wish to discard your settings, click the Cancel button.

Size/Leading… ( \)
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The Tracking… command lets you adjust the spacing
between selected text. Although you can adjust or set
tracking in several other menus and dialog boxes, the
Tracking dialog box offers one of the easiest ways to set
character spacing.

Setting tracking

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the text whose
tracking you wish to change, or position the I-beam
where you want new text to appear.

3. Choose the Tracking… command in the Format
menu. The Tracking dialog box appears.

4. Enter a value in the Tracking text field. You can also
click on the Arrow right or Arrow left buttons. The
arrow buttons increase or decrease tracking by the
amount set in the Tex t panel of the Preferences dialog
box in the Edit menu. By default, changes
tracking by units of 50.

Tracking values are measured in thousandths of an
em. An em equals the width of a capital "M" in the
current font and size. An em usually equals the point
size.

5. Click the Apply button to view the selected text with
your changes.

6. Click the OK button to apply the changes and return
to the Document Window. Click the Cancel button to
discard the changes.

Note: Tracking is the opposite of kerning, a feature sup-
ported in some word processing applications.
Whereas tracking adjusts the spacing behind a char-
acter, kerning adjusts the spacing before a character.

Tracking… ( K)
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The Horiz. Scale command lets you adjust the width of
selected text. Although you can adjust or set the horizon-
tal scale in several other menus and dialog boxes, the
Horizontal Scale dialog box offers one of the easiest ways
to set character width.

Setting the horizontal scale

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the text whose
tracking you wish to change, or position the I-beam
where you want new text to appear.

3. Choose the Horiz. Scale… command in the Format
menu. The Horizontal Scale dialog box appears.

4. Enter a percentage in the Scale text field. You can also
click on the Arrow right or Arrow left buttons. The
arrow buttons increase or decrease the scale by the
amount set in the Tex t panel of the Preferences dialog
box in the Edit menu. By default, changes
the scale by units of 20.

By default, sets the horizontal scale to 100
percent. You can compress the scale to 20 percent or
expand the scale to 400 percent.

5. Click the Apply button to view the selected text with
your changes. If you adjust the scale with the arrow
buttons, updates the text with each click.

6. Click the OK button to change the text. Click the
Cancel button to discard your changes.

Horiz. Scale… ( H)
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The Offset command lets you adjust the position of the
selected text in relation to the center of a line, also called
the baseline. Although you can adjust or set the vertical
offset in several other menus and dialog boxes, the
Vertical Offset dialog box offers one of the easiest ways
to set superscript or subscript text.

Setting the vertical offset

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the text whose offset
you wish to change or position the I-beam where you
want new text to appear.

3. Choose the Offset… command in the Format menu.
The Vertical Offset dialog box appears.

4. Enter a percentage in the Offset text field. You can also
click on the Arrow up or Arrow down buttons. The
arrow buttons increase or decrease the scale by the
amount set in the Tex t panel of the Preferences dialog
box in the Edit menu. By default, changes
the offset by units of five.

5. Click the Apply button to view the selected text with
your changes. If you adjust the scale with the arrow
buttons, updates the text with each click.

6. Click the OK button to change the text. Click the
Cancel button to discard your changes.

Offset… ( Y)
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The Make Type Style… command lets you create your
own format styles to apply to text. Choosing the Make
Type Style… command in the Format menu opens the
Edit Type Style dialog box. The Edit Type Style dialog
box contains all the choices available in the Character
Attributes dialog box. Just a few differences distinguish
the two dialog boxes.

Creating Type Styles

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the text you wish to
use as your type style.

3. Choose the Make Type Style… command in the
Format menu. The Edit Type Style dialog box
appears. Notice that the style attributes reflect those
of the selected text.

4. Make the desired format adjustments. For a detailed
description of the Font Specs, Effects, Size, Leading,
Color and other options, see the Characters… com-
mand entry above. 

5. Enter a name for the type style in the Style name text
field.

Make Type Style…
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6. Click the OK button to make the changes to the text.
Click the Cancel button to discard your changes.

The Edit Type Style dialog box has several unique fea-
tures. These features include:

• Style name
The Style name field lets you enter a name to
identify the type style you have created.
Initially, the field appears with Untitled Type
Style highlighted. Just start typing to replace this
caption with a more descriptive name.

• Based on
The Based on pop-up menu lets you select an
existing file as the basis for the style you wish to
create. If you edit the base style, modi-
fies those same attributes in the new style, unless
you have already changed those attributes in the
newer style.

• Key Equivalent
The Key Equivalent text field lets you create a key-
board shortcut that automatically applies the
specified style to text. The specified key shortcut
appears next to the style's name on the Style's
palette. Do not use a keyboard shortcut used by
another style or by .

To change the settings of an existing type style, choose
the Text Styles… command in the Document menu. See
the Text Styles… command entry in the Document
menu section for more information.

Make ¶ Style…

The Make ¶ Style… command lets you create your own
paragraph styles to apply to text. Choosing the Make ¶
Style command in the Format menu opens the Edit
Paragraph Style dialog box. The Edit Paragraph Style
dialog box contains all the choices available in the
Paragraph… dialog box. Just a few differences distin-
guish the two dialog boxes.
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Creating Paragraph Styles

1. Click on the Text tool on the Tools palette.

2. Click on a text box and highlight the paragraph you
wish to use as your paragraph style.

Note: considers any section of text
that ends in a return character a para-
graph. However, also considers
the last section of text in a block a para-
graph if it doesn’t end in a return character.

3. Choose the Make ¶ Style… command in the Format
menu. The Edit Paragraph Style dialog box appears.
Notice that the style attributes reflect those of the
selected paragraph.

4. Adjust any of the format settings you want. For a
detailed description of the Alignment , Space , Indents ,
Hyphenat e, or Quad Leader options, see the
Paragraphs… command listing above. 

5. Enter a name for the paragraph style in the Style
name text field.

6. Click the OK button to make the changes to the text.
Click the Cancel button to discard your changes.
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The Edit ¶ Style dialog box has several options and
unique features. These features include:

• Style name
The Style name field lets you enter a name to
identify the new paragraph style. Initially, the
field appears with Untitled ¶ Style highlighted.
Just start typing to replace this caption with a
more descriptive name.

• Based on
The Based on pop-up menu lets you select an
existing file as the basis for the new style. If you
edit the base style, modifies those
same attributes in the new style, unless you have
already changed those attributes in the newer
style.

• Type style
The Type style pop-up menu lets you apply the
attributes of a selected type style at the same
time you apply a paragraph style. When you link
a paragraph and type style in this way, the
selected text appears with both the paragraph
and type formatting rules. Selecting None does
not apply a pre-existing type style.

• Next ¶ style
The Next ¶ style pop-up menu lets you set the
format of the paragraph following the selected
paragraph. By default, the Same as this option
appears in the pop-up menu, but you can desig-
nate any paragraph style you have created as the
next paragraph style.

• Key Equivalent
The Key Equivalent text field lets you create a key-
board shortcut that automatically applies the
specified style to text. The specified key shortcut
appears next to the style's name on the Style's
palette. Do not use a keyboard shortcut used by
another style or by .

To change the settings of an existing paragraph style, see
the Text Styles… command entry in the Document
menu section for more information.
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The Make Style Model… command lets you combine
type styles and paragraph styles. In this way, you can
create style models for special formats.

When you select the Make Style Model… command from
the Format menu, the Edit Style Model dialog box opens.
Notice that the dialog box breaks a style model into its
component paragraph and type styles.

Creating a New Style Model

When you open the Edit Style Model dialog box, an
unnamed style model appears for you to edit. 
sets the paragraph and type style formats to the docu-
ment defaults. If you want to create a new style model
model, you need to:

1. Draw a text block.

2. Choose the Make Style Model… command from the
Format menu. The Edit Style Model dialog box
opens. 

3. Enter a name for the new style model into the Style
Model name field.

4. Click the OK button to add the new style model to the
Styles palette. Click the Cancel button to discard the
new model.

Make Style Model…
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Modifying Style Models

Because so many different formatting needs exist,
offers many different ways to modify a style

model. Not only can you edit style models for individual
paragraphs, you can also specify the format of sequences
of paragraphs and text.

Editing paragraph and type styles

You may wish to make changes to a new style model or
modify an existing one. lets you do just this.
You can make changes to existing paragraph and type
styles from the Edit Style Model dialog box.

1. Click on a text block with the Text tool.

2. Choose the Make Style Model… command from the
Format menu. The Edit Style Model dialog box
opens.

3. Click on the paragraph or type style you wish to edit.

4. Click the Edit button. This opens either the Edit
Paragraph or Edit Character Model dialog boxes,
depending on the type of style you selected.

Note: You can also open the Edit Paragraph and
Edit Character Model dialog boxes by
double-clicking on the name of the appro-
priate style in the Edit Style Model scroll
list.

5. Modify the style according to your wishes. Notice that
you can select existing styles from the Type style or
Paragraph style pop-up menus, depending on the dia-
log box you have open.

6. Click the OK button to apply the style changes and
return to the Edit Style Model dialog box.

7. Click the OK button in the Edit Style Model dialog
box to return to the Document Window. Click the
Cancel button if you wish to discard the changes.
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Adding paragraph formats

When you create a style model for a particular para-
graph, you may already know how you want to format
succeeding paragraphs. Instead of applying a series of
style models for these paragraphs, lets you
specify how you want succeeding paragraphs formatted.

1. Click in a text block with the Text tool.

2. Choose Make Style Model from the Format menu.
The Edit Style Model dialog box opens. 

3. Click on the Paragraph 1 entry.

4. Click the New button. A new entry labeled Paragraph
2 appears.

5. Click on the paragraph or type style listing for the
Paragraph 2 entry.

6. Click the Edit button.

7. Modify the style according to your wishes.

8. Click the OK button to apply the changes and return
to the Edit Style Model dialog box. Click the Cancel
button if you wish to discard your changes.

9. Click the OK button in the Edit Style Model dialog
box to return to the Document Window. Click the
Cancel button if you wish to discard your changes.

Adding type styles

In some sections of text, you may wish to apply the same
paragraph style but change type styles. You can accom-
plish this by adding type styles to your style model.

1. Click on a text block with the Text tool.

2. Choose Make Style Model… from the Format menu.
The Edit Style Model dialog box opens.

3. Click on a type style entry in the scroll list of the dia-
log box.
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4. Click the New button. A new type style entry
appears. A Change af ter “?” message appears before
the type style name. 

Notice that a pop-up and text field appear at the bot-
tom of the dialog box after you add a type style.
These menus let you determine when to change type
styles.

5. Select
an option from the Change pop-up menu. Your options
include:

6. Select an option from the pop-up menu to the right of
the Change pop-up. Your options include:

7. Click the OK button to apply your changes and return
to the Document Window. Click the Cancel button to
discard your changes.

To change the settings of an existing style model, choose
the Text Styles… command in the Document menu. See
the Text Styles… command entry in the Document
menu section for more information.
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The Apply Tags command lets you apply styles to a stan-
dard text file. does this by looking for tags—or
labels—which tell the application what style it needs to
apply to the specified text. Enter these tags into the text
before importing the file into .

When finds a tag in a text file, the application
deletes the tag and then styles the text accordingly. You
can apply styles from tags when importing or breaking
text (or word processing) files.

The form of tags

looks for tag delimiter characters to recognize
tags. 

uses the « (Option-\ ) and » (Option-Shift-\ )
characters as default tag delimiters. If you choose your
own delimiters, avoid frequently used characters. Also
avoid characters you’ve already used as delimiters in
style models. If you wish, you can use the same character
as both the start and end delimiter.

A tag can identify a type style, paragraph style, or a style
model by name or by position in the style sheet. There is
also a None tag to turn off styling.

Making a tag

Here’s how to make a tag. Start with a tag start delimiter
(«). Follow that with: 

• T for a type style, or

• P for a paragraph style, or 

• M for a style model. 

Apply Tags

You can find the characters used for tag
delimiters in the Te x t panel of the
Preferences dialog box. 
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Next, type:

• a colon (:) and the style name, or

• a number sign (#) and the number of the style

Finally, type the tag end delimiter (»). 

The None tag is constructed by the word “None” between
tag start and end delimiters.

Here are some examples:

«M:Disk Listing» Use the style model named “Disk
Listing.”

«P#5» Use the fifth paragraph style. (This
will be the sixth item on the 
paragraph style palette, because the
None item at the top of the list 
doesn’t represent a style.)

«None» Don’t use any style or style model.

How Creator2 uses tags

When you apply styles using tags, scans the
text from top to bottom. When it finds a tag, the applica-
tion deletes the tag. Then it applies the specified type
style, paragraph style, or style model until the applica-
tion finds another tag to turn off the style or the end of
the text file is reached. 

Note that type styles and paragraph styles can coexist. A
type style tag doesn’t turn off a paragraph style tag. 

However, a paragraph style tag will turn off a previous
type style if the paragraph style tag includes an associ-
ated type style.

Style models affect both type and paragraph formatting,
so:

• A style model tag turns off type and paragraph
tags. 
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• A type or a paragraph tag turns off a style model
tag. 

• “None” tags turn off all three kinds of styles.

The scope of a tag

When you select a range of text and apply a paragraph
style or a style model, extends the selection to
the beginning of the first paragraph containing the selec-
tion and the end of the last paragraph containing the
selection. This is because paragraph formatting affects
entire paragraphs, and both paragraph styles and style
models affect paragraph formatting.

The same is true of paragraph and model tags. To avoid
confusion, we recommend placing paragraph and model
tags at the beginning of the first paragraph they will
affect. Even if a paragraph or model tag is in the middle
of a paragraph, it is applied at the beginning of the para-
graph and continues through to the end of a paragraph in
which another tag turns it off.

An example of tags

Here’s a sample of text containing tags (the tags are bold-
faced for visibility):

«M:Disk Listing»5.25” Precision Disks
35¢ each
SS/DD in bo xes of 10
3.5” Sony Disks
55¢ each
DS/DD in quantities of 25
«M:Tabbed List»Premium Diskettes
3.5” double-sided double-density in lots of 25. 
Lifetime warranty 59¢ each
Printer Ribbon
Imagewriter, Imagewriter II $2.49
Disk Case
Protects up to 20 3.5” disks $4.95
«P:Newspaper»«T:Tight Times»Our store has all the «T:T T
Bold»best«T:Tight Times» supplies for your computer
needs, at all the «T:TT Bold»best«T:Tight Times» prices!
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In this example, 

• Disk Listing is a three-paragraph style model
which is applied to the first six lines. 

• Tabbed List is a two-line model containing a tab
with a tab leader for the prices. It is applied to
the next seven lines. 

The last paragraph begins with the paragraph style
Newspaper and alternates between the type styles Tight
Times and TT Bold .

Here’s what it looks like when tags are applied:

5.25” Precision Disks 
35  

¢  
  each  

SS/DD in boxes of 10 

3.5” Sony Disks 
55  

¢  
  each  

DS/DD in quantities of 25  

Premium Diskettes  
3.5” double-sided double-density
in lots of 25. Lifetime warranty ....... 59¢   each 

Printer Ribbon  
Imagewriter, Imagewriter II ............... $2.49  

Disk Case  
Protects up to 20 3.5” disks ................. $4.95  

Our store has all the  best  supplies for your
computer needs, at all the  best  prices! 
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To apply tags to a range of text, the Styles palette must
be visible.

1. Click the Style Model button on the Styles Palette.

2. Select the text containing the tags.

3. Choose the Apply Tags command from the Format
menu.

If you didn’t select whole paragraphs, extends
the selection. The tags are then deleted and the styles
applied. 

Note: Invalid tags—those with names that can’t be
found or numbers that are out of range—will not
be deleted and no styles will be applied.

Applying tags while placing a text file

1. Choose Import Text… from the File menu.

2. In the Import Text dialog box, check the Use Style
check box and choose Use Tags (the default) in the
pop-up menu.

3. Choose a text or word processing file containing tags
and click the Place button. applies tags to
the entire file when it is placed.

Applying tags while breaking text

1. Choose Import Text… from the File menu. 

2. Select a text file containing tags to be imported.

3. Click the Break button.

4. In the Break Text dialog box, make sure you select
the Use Style Model check box and choose Use Tags
from the pop-up menu. 

5. Specify the appropriate break settings and click the
Place button. 
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Tags are applied to the separate text blocks as if they
were still a single piece of text. Block 2 may not con-
tain any tags, but it is still styled with tags that were
in effect at the end of the first block.

Applying tags while Importing Text from the Files
palette

1. In the Files palette, click on the file containing tags
to be placed.

2. Choose the Apply Tags command from the Format
menu.

3. Drag a rectangle to contain the text. 

Note: The same technique works for applying any style
model to text placed from the Files palette. 

To break text from the Files palette, double-click the file
name in the Files palette. This brings up the Break Text
dialog box, and you can select tags or a model as
described above. For more information on using the Files
and Styles palettes, refer to Chapter 2 of this Reference
Manual.

An easy way to insert tags into your text

If you are editing your text in and you wish to
insert a tag for an existing type style, paragraph style, or
style model into your text, set the insertion point where
you wish the tag to go, press the Option key, and click on
the name of the desired style or model in the Styles
palette.
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The Document Menu

The Document Settings… command lets you decide
what kinds of document information you want 
to present. You can also tell how to deal with
certain types of text information. 

When you select Document Settings…, the Document
Settings dialog box appears. Several panels appear in
the scroll list on the left side of the dialog box. You can
control document attributes by setting vari-
ous options available on each panel.

Document Settings…

The General document settings panel lets you set docu-
ment specific interface attributes. 

Setting Document Attributes in the General Panel

The Document menu contains commands that let you set
document-specific attributes or let you make changes
across a document. With the commands in the Document
menu you can create type styles, add or delete pages, or
replace font styles throughout an entire document. A full
description of the commands in the Document menu fol-
lows.
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Setting the Pasteboard Area size

lets you set the pasteboard size (the area sur-
rounding a spread) in each document. Simply enter a
measurement into the width and height fields, and

adjusts the available pasteboard accordingly.

Setting the Invisibles attributes

does not always display certain formatting
information. By clicking in the appropriate check box,

displays special characters to represent this
hidden formatting information. The type of invisible
information that can display includes:

• Spaces
The Spaces check box lets you view the number of
spaces between words and characters. Spaces
appear as small gray dots. also sup-
ports Em, En, and Thin Spaces. An Em space
appears as a dot with an M over it. An En space
appears as a dot with an N over it. A Thin space
appears as a dot with a T over it.

An Em space (Shift-Ctrl-Space ) equals the width
of the selected point size. An En Space (Shift-
Space ) equals 1/2 the width of the selected point
size. A Thin space (Ctrl-Space ) equals 1/4 the
width of the selected point size.

• Returns and Newlines
The Returns and Newlines check box lets you see
where each line ends and where each new line
begins. Return characters appear as paragraph
symbols (¶) while newline characters appear as ↵.

• Tabs and Quads
The Tabs and Quads check box lets you view all tab
and quad marking. Tabs appear as right arrows (➞)
while quads appear as double-headed arrows ( ).

• Discretionary Hyphens
The Discretionary Hyphens check box lets you
view all the discretionary hyphens you have
placed in words. Discretionary hyphens appear as
gray carrots (^) beneath words.

For more information on discretionary hyphens,
see the entry for the Discretionary Hyphen com-
mand in the Format menu section.
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The Document Info panel options include:

• Status
The Status pop-up menu lets you record the
importance or the state of completion of a docu-
ment. Here are the status labels available.

• Author
The Author text field lets you record the name of
the person who originally created the open docu-
ment.

Setting Attributes in the Document Info Panel

The Document Info panel lets you record important infor-
mation about the current document.

• Invisible Shapes
The Invisible Shapes check box lets you view
graphics with a fill and frame color of None .
Invisible shapes appear as a transparent light
blue or gray color.
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Note: If you have entered a name into the User
Name field of the General panel of the
Preferences dialog boxin the Edit menu,
this name automatically appears in the
Author field when you create a new docu-
ment.

• Description
The Description text field lets you describe the
document. You can provide a synopsis of the docu-
ment, a description of the intended audience, or
whatever information you feel is important.

You can also enter document strings into the
Description field. These strings replace commonly
used phrases. Simply type a description string
into the appropriate spot in the Description field.
The actual phrase the string characters represent
appears on printouts.

The document strings available include:

@c or @C — company name (from 
registration)

@e or @E — extended date string (e.g., 
Monday, November 11, 
1997)

@d or @D — short date string (e.g., 
11/11/97)

@n or @N — user name from 
registration

@p or @P — PostScript printer name 
selected in the Chooser

@t or @T — time string as defined by 
the Control Panel

@v or @V — version of 

• Keywords
The Keywords text field lets you identify

documents with certain words. When
you catalog your files with Multi-Ad Search, the
application includes these keywords in the catalog
of files. 
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The Text Defaults panel lets you set text attributes for
the current document. You can set the standard font, font
size, paragraph style, and other attributes for the active
document only. If you open a new document, its text
appears in the style entered in the Tex t panel of the
Preferences dialog box.

To specify a keyword, type a word into the text
field at the upper right of the Keywords area and
then click the Add button. Your word appears in
the scroll list to the left.

To remove a keyword, click on a word in the scroll
list and then click the Delete button. 
removes the word from the list.

To replace a keyword with a new word, click on a
keyword in the scroll list. Enter a new word into
the text field in the upper right and click the
Replace button. Notice that the new word appears
in the scroll list in place of the old keyword.

Setting Attributes in the Text Defaults Panel
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The Type Defaults area allows you to set the default text
attributes for your document. The attributes include:

• Type style
The Type style pop-up menu lets you apply a  type
style that you previously created and saved.

• Font
The Font pop-up lets you choose a default font.

• Size
The Size field lets you select a default point size.

• Leading
The Leading field lets you enter a percentage of the
existing point size, plus a certain number of points
to determine the space between lines of text.

• Language
The Language pop-up menu lets you identify text
as belonging to a certain language. When you
check spelling, checks the specified text
against a dictionary of the appropriate language.

• "Smart Quotes"
The "Smart Quotes" check box lets 
automatically convert your quote marks into open
or closed quote marks. 

• Allow Hanging Characters
The Allow Hanging Characters check box lets

place some punctuation marks outside
the borders of a text block. Not all fonts support
this feature.

If you have created a paragraph style, the Text Defaults
panel lets you use that style as a default. Just choose
your style from the Paragraph style pop-up menu. You
can further modify the default paragraph by selecting an
alignment from the Alignment pop-up menu or setting a
tab stop by entering a value into the Align t o field. You
can also turn on hyphenation.
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The Hyphenation panel lets you set a wide range of
hyphenation rules in your document. 

The hyphenation attributes you can set include:

• Minimum breakable word
In the Minimum breakable wor d field, enter the
smallest number of characters you want a word to
have before hyphenates it. 

• Minimum letters before break
In the Minimum letters before break field, enter
the smallest number of characters you want
before each hyphen. 

• Minimum letters after break
In the Minimum letters af ter break field, enter the
smallest number of characters you want after each
hyphen.

• Consecutive hyphens allowed
In the Consecutive hyphens allowed field, enter the
number of consecutive lines that you want
hyphens to appear in. If the field reads unlimited ,
hyphens can appear in every line on a page.

• Break capitalized words
Click the Break capitalized words check box to let
hyphenation rules apply to capitalized words. By
default, does not hyphenate capital-
ized words.

Setting Attributes in the Hyphenation Panel
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Entering Exceptions to hyphenation rules

The Exceptions area, at the bottom of the Hyphenation
panel, lets you enter specific hyphenation rules. You can
define how you want certain words hyphenated, even if
they break the minimum letter rules you previously
entered. Or you can exempt certain words from hyphen-
ation altogether.

The Word field in the Exceptions area lets you apply spe-
cial hyphenation rules to a specified word. Click the
Break button and displays your word with its
natural hyphenation breaks. Add hyphens where you
wish to break the word, and remove the hyphens you
don’t want. Click the Add button to enter the word, and
its new hyphenation breaks, to the scrolling list.

If you wish to exempt a word from the hyphenation rules
entirely, enter it into the Word field in the Exceptions
area. Click the Add button to enter the unhyphenated
word into the scrolling list. 

To change the hyphenation rules for any word in the
scrolling list, click on a word to place it in the Word field.
Change the word to reflect your new hyphenation
requirements. Click the Replace button to enter the new
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Setting Attributes in the Print Defaults Panel

The Print Defaults panel lets you specify the document’s
border, in order to create bleeds and other effects. You
can even change the position of a document on a page by
clicking and dragging the sample document to a new sec-
tion of the view area. The panel also lets you decide if you
want various marks and printer information to appear on
the page. 

• Bleed items at edge
Click on the Bleed items at edge check box to print
parts of items that overlap the document border. If
you have this item deselected, only
prints those parts of elements that are in the docu-
ment area. Parts of elements that are not in the
document area appear dimmed.

• A single page
The A single page radio button lets you print each
document page on a separate sheet of paper. Any
part of an element that runs over the margins of
a document does not appear on the printout.

• A whole spread
The A whole spread radio button lets you print an
entire spread on a single sheet of paper.

• Ornaments
Click the Ornaments check box to view the place-
ment of all ornaments (registration marks, crop
marks, color bars, etc.) in the Document Window.
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• Paper outlines
Selecting the Paper outlines check box displays
the printable area and paper size outlines. 

Deselecting the check box hides these outlines.

The Print Defaults panel also lets you place page orna-
ments in a document. Normally this information doesn’t
appear, but you may find it helpful when printing separa-
tions. The ornament options include:

• Registration marks
Click in the Registration marks check box when
you print color separations. This option places
Registration Marks on a page to aid in lining up
the color separations for perfect realignment. 

also prints GATF (Graphic Arts
Technical Foundation) control targets on certain
corners. These 1/2 inch pinwheels help measure
image resolution during plate production and
plate degradation, dot doubling, grain, and slur-
ring during printing.

Paper size
outline

Paper's printable
area outline

Document page size/
Document Area
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• Crop marks
Click in the Crop marks check box when you print
a document on a sheet of paper that is larger
than the document. The crop marks let the
printer know that the paper needs trimming.

You may also need to select the Crop marks check
box when tiling a page or spread.

• Color bars
Click in the Color bars check box to place four rec-
tangles at the bottom of each color separation
plate. Each rectangle represents one of the four
separation components: black, cyan, magenta,
and yellow—in that order. On the black separa-
tion, the first rectangle is colored black while the
other rectangles are white. On the cyan separa-
tion, the second rectangle is colored black while
the other rectangles are white, and so on.

The color bars help identify each color separation.
also prints color and gray ramps on the

left and right sides for calibration purposes.

• Document description
Click in the Document description check box to
print any notes entered into the Document Info
panel of the Document Settings dialog box. These
notes appear at the top of the printout.

• Plate information
Click in the Plate information check box to print
the document name and the plate name.

The Page Manager… command lets you control your doc-
ument’s page size and number. If you like, you can even
include pages of differing sizes in your document.

When the Page Manager dialog box first opens, the
pages of your document appear in the scroll list to the left
of the dialog box. You can move a page by clicking on it
and then dragging to the desired location. Selected pages

Page Manager…
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appear shaded. The page currently displayed in the
Document Window appears with a bold border in the
Page Manager dialog box.

Changing page sizes

When you click on a page in the scroll list, notice that the
pages dimensions appear the Width and Height text fields
of the Page Size area of the dialog box. You can change
the values in these fields to vary the size of individual
pages. To change the size of a page, click the number of
the page you want to change, then click the Choose Page
Size… button and select a page size from the Choose a
Size dialog box. You can also enter the desired height and
width into the text fields. To apply the dimension
changes, click the Set button.

For more information on the Choose a Size dialog box
and how to make your own document sizes, see the
New… command entry in the File menu section.

Selecting a master spread

Occasionally, you may have several pages that you wish
to appear different than the rest of the document. If you
have prepared several different master spread formats in
the Master Spreads dialog box, you can apply those for-
mats to different pages. 

Click on the desired page to select a new master spread
and then choose the name of the desired master spread
from the Master Page pop-up menu. When you return to
the Document Window, the elements from the selected
master spread appear on the appropriate page.
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Inserting Pages

The Insert Pages… button of the Page Manager dialog
box lets you add a specified number of pages at a specific
spot in your document. You can do this through the
Insert Pages dialog box.

The options in the Insert Pages dialog box include:

• Insert _ pages
The Insert _ pages text field lets you add a
desired number of pages. Simply enter the num-
ber of the pages you wish to add in the text field.
By default, always assumes you want
to add one page.

• At the beginning
The At the beginning radio button adds the num-
ber of pages entered into the Insert _ pages text
field to the beginning of the document.

• At the end
The At the end radio button adds the number of
pages entered into the Insert _ pages text field to
the end of the document.

• After page
The Af ter page radio button adds the number of
pages entered into the Insert _ pages text field
after the page entered in the Af ter page text field.

• Choose Page Size…
The Choose Page Size… button lets you add a
page with different dimensions than the rest of
the document. Clicking the Choose Page Size…
button opens the Choose a Size dialog box.
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Deleting Pages

To delete a page from a document, first select the page
icon in the Page Manager scroll list for the page you
wish to delete. Notice that the page icon you clicked on
becomes highlighted. To select a range of pages, click on
the first page you want deleted and then Shif t -click on
the last page you want to delete. Notice that all the pages
between the two selected pages become highlighted.
Command -click to select only those pages you wish to click
on. 

When you have selected all the desired pages and clicked
the Delete button, a warning dialog box appears.

Should you delete an odd number of pages, a second dia-
log box appears.

For more information on the Choose a Size dia-
log box and how to make your own document
sizes, see the New… command entry in the File
menu section.

• Master Page
The Master Page pop-up menu lets you assign a
master spread to the pages you wish to add to the
document.

To insert pages and return to the Page Manager, click
the Insert button. To discard your settings and return to
the Page Manager, click the Cancel button.
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Creating a Master Spread

The Master Spreads… command lets you place elements
on numerous pages throughout a document. These ele-
ments can include page numbers, header and footer infor-
mation, text, and graphics. 

In the Master Spreads dialog box, you can create a differ-
ent style master spread for both side pages. If you wish to
include a few scattered pages with yet another format in a
document, you can create special master spread styles.

The Master Spreads dialog box displays the names of
your master spread styles in the scroll list on the left side
of the dialog box. Selecting one of the master spread
names lets you copy, rename, modify, or delete it. You can
create a new master spread style, too.

Master Spreads…

You can format a master spread just like a regular docu-
ment page. You can format graphics, text, and para-
graphs. To create a master spread:

1. Choose the Master Spreads… command from the Edit
menu. The Master Spreads for document namedia-
log box appears.
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Modifying a Master Spread

2. Click the New… button. A dialog box appears.

3. Enter a name for the new master spread in the text
field and click the OK button to return to the Master
Spreads dialog box. Notice that the name of the mas-
ter spread now appears in the scroll list. Click the
Cancel button if you wish to discard the new master
spread.

4. Click the Done button to return to the Document
Window.

lets you modify any master spread. Once you
finish with your modifications, automatically
applies them to all pages assigned to the modified master
spread. If you like, you can create duplicates of a master
spread or delete those you don’t need.

Editing a master spread

At some point during your work, you may decide to
change the design of a master spread. gives
you the option of modifying master spreads in the Master
Spreads for document name dialog box.

1. Choose the Master Spreads… command from the
Edit menu. The Master Spreads for document
name dialog box appears.

2. Choose the master spread you wish to edit. 

3. Click the Edit… button. returns you to the
Document Window. However, notice that the
Document Area now contains your master spread. 

4. Change the attributes to reflect your wishes.

5. Click on the pop-up page menu to the left of the bot-
tom scroll bar. Choose the desired page.

Copying a master spread

You may decide that you wish to copy a master spread
already listed in the scroll list. lets you make
copies of master spreads.
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1. Choose the Master Spreads… command from the Edit
menu. The Master Spreads for document namedia-
log box opens.

3. Choose the master spread style that you wish to copy.

4. Click the Duplicate button. This creates a copy of the
selected text style. Notice that numbers
each copy. If you have no further modifications, click
the Done button to return to the Document Window.

5. Click on the duplicate master spread.

6. Click the Edit… button to place the master spread in
the Document Window.

7. Change the attributes to reflect your wishes.

8. Click on the pop-up page menu to the left of the bot-
tom scroll bar. Choose the desired page.

Deleting a master spread

You may decide you don’t need certain master spreads in
the Master Spreads for document namedialog box.
Choose the Master Spreads… command from the Edit
menu to open the Master Spreads for document name
dialog box. Click on the master spread you wish to
remove from the dialog box, and then click the Delete
button. The master spread disappears from the dialog
box’s scroll list. When finished deleting master spreads,
click the Done button to return to the Document Window.

The Colors… command lets you choose, manipulate, and
create colors in your document. You can also import colors
from other documents or create an independent color file
for use in other documents.

Choosing Colors… command from the Document menu
opens the Colors from document name dialog box. You
can also open the Colors from document namedialog
box by double-clicking on one of the buttons on the Colors
palette. A scroll list of the colors currently available in
the document appears on the left side of the dialog box. 

Colors…
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You can select a color from the list and then modify it by
clicking on one of the buttons at the right of the dialog
box. The button options include: Import…, Export…,
New…, Edit…, Duplicate, Delete, and Done. Double-
clicking on a color opens the Edit "color name" dialog
box for that color.

Importing and Exporting Colors

When you start a new document, you might wish to use a
colors list from another document you have worked on.

lets you save color lists as stand-alone files.
This lets you use the same color list in several documents,
or even give a color list to another user.

Exporting a color file

Use the following procedure to make a copy of the current
color list for use in other documents. You may wish to
export a color list if you expect to use a certain set of col-
ors frequently.

1. Choose the Colors… command from the Document
menu. The Colors from document name dialog box
appears.
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2. Click the Export… button. A directory dialog box
appears.

3. Type a name for the color file into the Save Document
As field.

4. Select the location where you want to save the color
file.

5. Click the Save button.

6. Click the Done button to return to the Document
Window.

Importing a color file

Use the following procedure to place a color list from one
document into another. When importing a new color list,
the application does not import colors that have the same
name and attributes as colors that already appear in the
current document’s color list. 

1. Choose the Colors… command from the Document
menu. The Colors from document name dialog box
appears.

2. Click the Import… button. A directory dialog box
appears.

3. Locate the color list you want to import into your doc-
ument. 

4. Double-click on the color list name, or click on the
color list name. Then click the Import button.

reads the color file and adds colors from
the file to the document’s color list.

5. Click the Done button to return to the Document
Window.
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Modifying Colors

lets you create or edit colors. The Edit “New
Color” dialog box provides seven different panels that let
you create colors or pick colors from an existing list. Each
panel supports a different method for creating color (for
example, mixing light or mixing inks) or a different set of
pre-mixed colors (for example, Focoltone or PANTONE).

Picking new colors

You pick a new color to add to the document’s color list
from the Edit “New Color” dialog box. Whether you cre-
ate a color by mixing RGB or CMYK, or by selecting a
spot color, depends on the panel you select from the scroll
list on the left side of the dialog box. Each panel lets you
pick a color from a different color system. The color sys-
tems supported by include:

• CMYK
The CMYK color system reproduces a color based
on its percentage of cyan, magenta, yellow, and
black components.
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• Grayscale
The Grayscale color system only allows percent-
ages of grays.

• RGB
The RGB color system reproduces a color based on
its percentage of red, green, and blue components. 
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• PANTONE
The PANTONE color system provides ready-made
color samples for use in your documents. You must
have the PANTONE Responder extension, the
PANTONE Profile control panel, and the PAN-
TONE CMM extension installed to use PANTONE
colors.

• Focoltone/ID
The Focoltone/ID color system provides ready-
made color samples for use in your documents.
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• Focoltone/Swatch
The Focoltone/Swatch color system provides ready-
made color samples for use in your documents.

• NAA-COLOR ™

The NAA-COLOR™ color system provides ready-
made color samples for use in your documents.
The Newspaper Association of America has speci-
fied these colors for use as process and spot col-
ors. Spot colors contain an SP before the color
name (except for NAA SP-GREEN A0A0, which
you can also use as a process color). 
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When you select an RGB or CMYK panel, you create a
color by clicking and dragging on the slide bars or by
entering percentages into the fields. As you increase or
decrease the percentages in the fields, modi-
fies the appearance of the color in the sample window. If
you create your own color, you must enter a color name
into the Color Name field before returning to the Colors
dialog box.

Selecting the Automatically rename check box tells
to ignore any color name with the same val-

ues. If you select the Automatically rename check box,
modify an existing color, and then choose another color
panel, the values of the modified color are translated into
the appropriate values for the new color model. Using
this method, you can design a color using the RGB panel
and then select the CMYK panel to see its cyan, magenta,
yellow, and black values.

When you select a PANTONE, Focoltone or NAA-
COLOR™ panel, you can click on a color from the scroll
list to select it. You can also select a color by typing its
name or number into the Color Names field. If you don’t
know a color ’s name or number, click on a color in the
scroll list and automatically places the color ’s
name or number in the Color Name field.

After you find and name a color, click in the Process or
Spot options. Selecting the Process option prints the
color on four process color plates: a cyan plate, a magenta
plate, a yellow plate, and a black plate. Each plate has
varying percentages of ink. Combining the plates repro-
duces the desired color. You may wish to select the
Process option if you have four or more colors to repro-
duce on a page.

Selecting the Spot option matches the on-screen color
with a specific color ink. Spot colors let you print just one
plate to reproduce a color instead of four process color
plates. Most of the Focoltone and NAA-COLOR™ colors
are spot colors. Each of the colors in those color systems
closely matches a pre-existing color ink. If you print a
spot color plate using NAA SP-RED, the printer knows to
use a specific color ink that closely matches the on-screen
color. You may wish to select the Spot option if you only
have a few colors to reproduce.

Note: You should only select the Spot option when you
have spot colors available. Using a spot color that
you don’t have access to may cause printing diffi-
culties, such as the spot color areas not printing.
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When you finish selecting a new color’s attributes, click
the OK button to return to the Colors dialog box. Notice
that the new color ’s name appears in the scroll list. If you
have no further changes, click the Done button to return
to the Document Window.

Editing a color

At some point during your work, you may decide that a
particular color just isn’t quite right. You may wish to use
a different shade or maybe a spot color instead of a
process color. gives you the option of modify-
ing the colors in your color list.

1. Choose the Colors… command from the Document
menu. The Colors from document name dialog box
appears.

2. Click on the color you wish to change.

3. Click the Edit… button. The Edit colors dialog box
appears. Notice that whatever color system panel you
select, automatically sets the panels
attributes to reflect those of the color you wish to
edit.

4. Change the color settings to reflect your wishes.

5. Click the OK button to apply your changes. Click the
Cancel button if you wish to discard your changes.

6. Click the Done button in the Colors dialog box to
return to the Document Window.

Duplicating a color

You may decide that you wish to copy a color already
listed in the color list. For example, you may wish to have
a certain red available as both a process and spot color.

lets you make copies of colors.

1. Choose the Colors… command from the Document
menu. The Colors from document name dialog box
appears.

2. Click on the color that you wish to copy.
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3. Click the Duplicate button. This creates a copy of the
selected color. Notice that numbers each
copy. If you have no further modifications, go to Step 8.

4. Click on the duplicate color.

5. Click the Edit… button. The Edit colors dialog box
appears.

6. Change the color settings to reflect your wishes.

7. Click the OK button to apply your changes. Click the
Cancel button if you wish to discard your changes.

8. Click the Done button in the Colors from document
name dialog box to return to the Document Window.

Deleting a color

You may decide you don’t need or want certain colors on
the colors list. Choose the Colors… command from the
Document menu to open the Colors from document
name dialog box. Click on a color you wish to remove
from the colors list and then click the Delete button. The
color disappears from the colors list. When finished delet-
ing colors, click the Done button to return to the
Document Window.
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Many applications let you create style sheets to manipulate
text, but also lets you create style sheets for
graphics. You may find element styles particularly helpful
when creating elements with a special set of features.
Styles save time by applying graphic attributes for you.

For example, you wish to create some boxes with a frame of
a certain size and a fill of a certain shade. Instead of set-
ting the same attributes on each box, you create an ele-
ment style to apply the desired attributes to all the boxes
you draw. You can even apply your style to other shapes.

Exporting an Element Style

Use the following procedure to make an element style file
for use in other documents.

1. Choose the Element Styles… command from the
Document menu. The Element Styles from docu-
ment name dialog box appears.

2. Click the Export… button. A directory dialog box
appears.

3. Type a name for the graphic style into the Save
Document As field.

Element Styles…
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4. Select the location where you wish to save the
graphic style.

5. Click the Save button.

6. Click the Done button to return to the Document
Window.

Importing an Element Style

Use the following procedure to place an element style
from one document into another.

1. Choose the Element Styles… command from the
Document menu. The Element Styles from docu-
ment name dialog box appears.

2. Click the Import… button. A directory dialog box
appears.

3. Locate the element style you wish to import into your
document. 

4. Double-click on the element style name, or click on
the element style name and then click the Open but-
ton. imports the element style into the
document.

5. Click the Done button to return to the Document
Window.

Modifying an Element Style

lets you modify almost all the features of an
element style. You can change the frame type, frame
weight, fill color, and more. If you like, you can create
duplicates of existing styles or delete those you don’t need.

Creating an element style

If you wish to apply a set of features to a series of graphic
elements, you might consider creating an element style to
apply those features for you. If you modify an element
style, automatically applies your changes to
every element that you applied that style to.

1. Choose the Element Styles… command from the
Document menu. The Element Style from document
name dialog box appears.
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2. Click the New… button. The Edit Element Style dia-
log box appears.

3. Set the attribute features in the Frame area by click-
ing on the appropriate check box.

• Ink
The Ink check box lets you determine the color,
shade, and texture of a graphics border.

• Type
The Type check box lets you determine the
style of the border.

• Weight
The Weight check box lets you determine the
point size of the border.

• Trapping
The Trapping pop-up menu lets you set print-
ing attributes for the graphic. For a description
of the available options, see the Trapping com-
mand in the Elements menu.

Note: If you do not select a check box for a particular
attribute, the element retains the attribute that
existed before you applied the element style. For
example, if you apply a style to a rectangle with a
red frame, but do not have the Ink check box in the
Frame area selected, the rectangle retains the red
frame. The other attributes of the applied style
also appear on the rectangle.



216 Multi-Ad Creator2

4. Set the attribute features in the Fill area.

• Ink
The Ink check box lets you determine the color,
shade, texture, and gradient of the fill.

• Trapping
The Trapping pop-up menu lets you set print-
ing attributes for the graphic. For a description
of the available options, see the Trapping com-
mand in the Elements menu.

Note: If you do not select a check box for a particular
attribute, the element retains the attribute that
existed before you applied the element style. For
example, if you apply a style to an oval with a
green fill, but do not have the Ink check box in the
Fill area selected, the oval retains the green fill.
The other attributes of the applied style also
appear on the oval.

5. Set the attribute features in the Shadow area.

• Ink
The Ink check box lets you determine the color,
shade, and gradient of the shadow.

• Offset
The Offset check box lets you determine the
horizontal and vertical distance of the shadow
from its graphic.

• Outset
The Outset text field lets you adjust the size of
the shadow.

• Trapping
The Trapping pop-up menu lets you set print-
ing attributes for the graphic. For a description
of the available options, see the Trapping com-
mand in the Elements menu.

Note: If you do not select a check box for a particular
attribute, the element retains the attribute that
existed before you applied the element style. For
example, if you apply a style to a rectangle with a
blue shadow, but do not have the Ink check box in
the Shadow area selected, the rectangle retains the
blue shadow. The other attributes of the applied
style also appear on the rectangle.
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6. Enter a name for the element style into the Style
Name field.

7. Click the OK button to create an element style and
return to the Element Styles from document name
dialog box. Notice the name of your element style
appears in the scroll list on the left side of the dialog
box. 

Click the Cancel button to discard your settings and
return to the Element Styles from document name
dialog box.

8. Click the Done button to return to the Document
Window.

Editing an Element Style

At some point during your work, you may decide to
change some of the attributes of an element style.

gives you the option of modifying element
styles in the Edit Element Styles dialog box.

1. Choose the Element Styles… command from the
Document menu. The Element Styles from docu-
ment name dialog box appears.

2. Click on the element style you wish to change.

3. Click the Edit… button. The Edit Element Style dialog
box appears. Notice that all the style attributes reflect
those of your selected element style.

4. Change the attributes to reflect your wishes.

5. Click the OK button to apply your changes. Click the
Cancel button if you wish to discard your changes.

6. Click the Done button in the Element Styles dialog
box to return to the Document Window.

Duplicating an element style

You may wish to copy an element style already listed in
the color list. lets you make copies of element
styles.
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1. Choose the Element Styles… command from the
Document menu. The Element Styles from docu-
ment name dialog box appears.

2. Click on the element style that you want to copy.

3. Click the Duplicate button. This creates a copy of the
selected element style. Notice that num-
bers each copy. If you have no further modifications,
go to Step 8.

4. Click on the duplicate element style.

5. Click the Edit… button. The Edit Element Styles dia-
log box appears.

6. Change the graphic attributes to reflect your wishes.

7. Click the OK button to apply your changes. Click the
Cancel button if you want to discard your changes.

8. Click the Done button in the Element Styles from
document name dialog box to return to the
Document Window.

Deleting an Element Style

You may decide you don’t need certain element styles on
the Styles palette. Choose the Element Styles… command
from the Element menu to open the Element Styles from
document name dialog box. Click on an element style you
want to remove from the Styles palette and then click the
Delete button. The element style disappears from the
Styles palette. Elements using the deleted style retain the
style’s attributes. When finished deleting element styles,
click the Done button to return to the Document Window.

Text Styles…

Many applications let you create text styles. 
offers three different style types for formatting text: type
styles, paragraph styles, and style models. Text styles
prove helpful when you want to apply a consistent look to
a document. Simply format a particular section of text
and then create a style based on that section. Whenever
you want to use this style again, select some text and
apply the style. 
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When you choose the Text Styles… command from the
Document menu, the Text Styles from document name
dialog box appears. 

The three buttons in the upper left corner of the dialog
box let you choose a style type to create: type styles, para-
graph styles, or style models. The style names you create
appear in the scroll list. You must select a style button to
see the relevant styles appear in the scroll list.

saves your styles in the active document so
they are always available. However, you can save styles
in an independent file for use in other documents.

Importing a text style

lets you use styles from other files in your cur-
rent document. If you want to use a style you created in
another document, the Import… button lets
you use that file.

Exporting a text style

When you create a style that you want to use in another
document, you can save, or export, the style as an inde-
pendent file. 
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lets you modify almost all the features of a
text style. Through the Text Styles from document
name dialog box, you can edit styles from all three text
style formats. Change font, font size, paragraph indenta-
tions, or other attributes. If you like, you can create dupli-
cates of existing styles or delete those you don’t need.

Creating a text style

A text style lets you format the appearance of characters,
words, and lines in a document. When you create a text
style, you have all the options available in the Character
dialog box (font, font size, style, leading, etc.), plus addi-
tional ones that let you name and save your custom style.

1. Choose the Text Styles… command from the
Document menu. The Text Styles from document
name dialog box appears.

2. Click on the button of the desired text style. 

3. Click the New… button. The dialog box for the
selected text style appears.

4. Enter the style’s formatting rules. For information on
entering style formatting information, see the
Character… command entry in the Format menu
section.

5. Enter a name in the Style name field.

6. Click the OK button to return to the Text Styles from
document name dialog box. Notice that the name of
the style appears in the scroll list when you select the
appropriate style button. Click the Cancel button to
discard your settings and return to the Text Styles
from document name dialog box.

Modifying a Text Style

The Type Styles
icon

The Paragraph
Styles icon

The Style Models
icon

The Element
Styles icon
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7. Click the Done button to return to the Document
Window.

Editing a text style

At some point during your work, you may decide to change
a text style’s attributes. gives you the option of
modifying text styles in the Text Styles dialog box.

1. Choose the Text Styles… command from the
Document menu. The Text Styles from document
name dialog box appears.

2. Click on the appropriate text style button. 

3. Click on the desired text style.

4. Click the Edit… button. The Edit dialog box for the
appropriate text style appears. 

5. Change the attributes to reflect your wishes.

6. Click the OK button to apply your changes. Click the
Cancel button if you want to discard your changes.

7. Click the Done button in the Text Styles from docu-
ment name dialog box to return to the Document
Window.

Copying a text style

You may decide that you want to copy a text style already
listed in the scroll list. lets you make copies of
text styles.

1. Choose the Text Styles… command from the
Document menu. The Text Styles dialog box appears.

2. Click on the button of the desired text style. 

3. Click on the text style that you want to copy.

4. Click the Duplicate button. This creates a copy of the
selected text style. Notice that numbers
each copy. If you have no further modifications, go to
Step 8.
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5. Click on the duplicate text style.

6. Click the Edit… button. The Edit dialog box for the
appropriate text style appears.

7. Change the attributes to reflect your wishes.

8. Click the OK button to apply your changes. Click the
Cancel button if you want to discard your changes.

9. Click the Done button in the Text Styles from docu-
ment name dialog box to return to the Document
Window.

Deleting a text style

You may decide you don’t need certain text styles on the
Styles palette. Choose the Text Styles… command from
the Document menu to open the Text Styles from docu-
ment name dialog box. Click on the text style button for
the text style you want to remove. Click on a text style
you want to remove from the Styles palette and then click
the Delete button. The text style disappears from the
Styles palette. When finished deleting text styles, click
the Done button to return to the Document Window.
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The Check Spelling… command lets you correct any
spelling errors you may have in your document. To select
the command, first select a text block with the Text tool.
When you choose the Check Spelling… command from
the Document menu, proofreads the contents
of an entire document, regardless of whether text blocks
are connected or not. 

To further increase the usefulness of the Check
Spelling… command, you can tell to check
spelling, punctuation, and other spelling rules. For more
information of spelling rules, see the Spelling Rules…
command below.

Using the Spell Checker

1. Select a text block with the Text tool.

2. Choose the Check Spelling… command from the
Document menu. now proofreads your
document. One of two dialog boxes may appear. If
your document contains no errors, this dialog box
appears…

Check Spelling…
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If the application finds a spelling mistake, the Check
Spelling dialog box opens…

Notice that the misspelled word appears in the
Suspect Wor d field. A list of possible spelling alterna-
tives appears in the Suggestions scroll list.

3. Click on the correct word in the Suggestions scroll
list. This places the correct spelling in the
Replacement text field. You can also type the correct
spelling into the field.

4. Click the Replace button to correct the word in the
document. You can also double-click on the correct
word in the Suggestions scroll list to place the correct
word in the document.

Click the Add button if the spelling of the word is cor-
rect. This happens when a word does not appear in
one of ’s dictionaries. The Add button
places the word in your own user dictionary for future
use. For more information about user dictionaries, see
the User Dictionary… command entry below.

Click the Skip button if you want to keep your
spelling of the suspect word. If you have spelled the
suspect word the same way throughout your docu-
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The Check Selection command lets you check the
spelling of a highlighted selection.

Using the Check Selection command

1. Highlight the word or section of text you want to spell
check.

ment, you can click the Skip All button and
ignores all succeeding words with that

spelling.

Click the Done button to end spell checking and
return to the Document Window. Otherwise,

continues to check spelling until it reaches
the last word of the document. When it reaches the
end of the document, a Finished checking document
name dialog box appears.

5. Click the OK button in the Finished checking docu-
ment name dialog box to return to the Document
Window.

If your document contains overflowed text (text that
flows beyond the boundaries of the last linked text block),
then this dialog box appears…

continues to check the spelling of the over-
flowed text, even though you cannot view it.

Check Selection
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2. Choose the Check Selection… command from the
Document menu. now proofreads the
selected part of the document. One of two dialog
boxes may appear. If your document contains no
errors, this dialog box appears…

If your selection contains a spelling mistake, the
Check Spelling dialog box opens…

Notice that the misspelled word appears after the
Suspect Wor d field. A list of possible spelling alterna-
tives appears in the Suggestions scroll list.

3. Click on the correct word in the Suggestions scroll
list. This places the correct spelling in the
Replacement text field. You can also type the correct
spelling into the field.
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The Spelling Rules… command lets you tell the applica-
tion what things to look for during a spell check. You can
choose what spelling rules you wish to apply by clicking
the appropriate check box in the Spelling Rules dialog box. 

4. Click the Replace button to correct the word in the
document. You can also double-click on the correct
word in the Suggestions scroll list to place the correct
word in the document.

Click the Add button if the spelling of the word is cor-
rect. This happens when a word does not appear in
one of ’s dictionaries. The Add button
places the word in your own user dictionary for future
use. For more information on user dictionaries, see
the User Dictionary… command entry below.

Click the Skip button to keep your spelling of the sus-
pect word. If you have spelled the suspect word the
same way throughout your selection, click on the Skip
All button and ignores all succeeding
words with that spelling.

Click the Done button to end spell checking and
return to the Document Window. Otherwise, the
application continues to check spelling until it
reaches the last word of the selection. When it
reaches the end of the selection, a Finished checking
document name dialog box appears.

5. Click the OK button in the Finished checking selec-
tion dialog box to return to the Document Window.

Spelling Rules…
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The spelling rules include:

• Spelling
Selecting the Spelling check box lets you proof
your document for spelling errors. Should the
application question a correctly spelled word, you
can add the word to a user dictionary by clicking
the Add button in the Check Spelling dialog box.

• Capitalization
Selecting the Capitalization check box lets you
check for common capitalization errors. The appli-
cation notifies you of sentences that begin with a
lower case letter and the uncapitalized names of
days, months, holidays, and proper nouns. The
application also notifies you of mixed case words,
like wEnt or thE . However, the application ignores
capitalized words in the middle of sentences. This
lets you use titles, proper names, and other capi-
talized words in the middle of sentences without
receiving a warning message.

You can specify changes to the capitalization rules
in a user dictionary. For more information on user
dictionaries, see the User Dictionary… command
entry below.

• Punctuation
Selecting the Punctuation check box lets the appli-
cation notify you of text containing doubled punc-
tuation, like two periods at the end of a sentence.
You can specify changes to the punctuation rules
in a user dictionary. For more information, see
the User Dictionary… command entry below.

• Compound words
Selecting the Compound words check box lets the
application notify you when you have incorrectly
used a hyphen.

• Double words
Selecting the Double words check box lets the
application notify you of occurrences of two iden-
tical words. Some exceptions exist. For example:

We had had the same question earlier in the week.
We thought that that question had been answered.
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The User Dictionaries… command lets you add, edit, or
remove words from your own dictionary. When you select
the User Dictionaries… command from the Document
menu, the User Dictionary dialog box opens. 

• Article usage
Selecting the Article usage check box lets the
application notify you of incorrectly used indefi-
nite articles (a and an).

• Format errors
Selecting the Format errors check box lets the
application notify you of certain formatting errors.
For example, it tells you to change U.S.A . to USA .

bases its spelling rules on The Chicago
Manual of Style, 13th Edition.

User Dictionaries…
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Any words you have added to a user dictionary using the
Add button in the Check Spelling dialog box appear in
the scroll list on the left side of the User Dictionary dia-
log box. Selecting a word from the scroll list places that
word in the Word text field. Other User Dictionary dialog
box options include:

• Language
The Language pop-up menu lets you select the
language dictionary in which you want to add
words You can select from English, French,
German, and many other languages. If you select
the Universal dictionary, adds all new
words you enter to all existing dictionaries.

• Word
The Word text field contains any word selected in
the scroll list. You can also enter new words into
this field.

• Add
The Add button lets you place new words into a
user dictionary. Simply type the word you want to
enter into the Word text field and then click the
Add button. The word you entered appears in the
scroll list.

• Replace
The Replace button lets you edit a word already
in a user dictionary. Find the word you want to
change in the scroll list and click on it. Notice
that word appears in the Word text field. Type
your changes in the Word text field and click on
the Replace button. Your changes appear in place
of the original word in the scroll list.

• Delete
The Delete button lets you remove a word from a
user dictionary. Simply click on the word you
want to remove and then click the Delete button.
The highlighted word no longer appears in the
scroll list. To delete a word that exists in all the
dictionaries available, choose the Universal option
from the Language pop-up menu, select the word,
and then click the Delete button

• Universal
The Universal button works like the Universal
option in the Language pop-up. It lets you add a
word to all existing dictionaries. To add a new
word to all dictionaries, simply type the word into
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the Word text field and click the Universal but-
ton. To add a word that already exists in one dic-
tionary to the remaining dictionaries, select the
word from the scroll list and then click the
Universal button.

• Cancel
Click the Cancel button when you want to discard
your changes and return to the Document
Window.

• Done
Click the Done button to save your changes and
return to the Document Window.

The Replace Fonts… command lets you view and change
the fonts you use in a document. When the Replace Font
dialog box opens, all the fonts you use in the active docu-
ment appear in the dialog box’s scroll list. 

Select a font in the scroll list. Notice its name appears in
the Change t o pop-up menu. When you choose another
font from the pop-up menu, changes every
instance of the font selected in the scroll list to the font
you have chosen from the pop-up menu. A notation to this
effect appears in the Replace Font dialog box.

To add a style to a selected font, choose the desired style
from the Add to style pop-up menu. You can choose from
Nothing , Bold , Italic , Underline , Outline , Shadow ,
Condense , and Ex tend options.

Replace Fonts…



232 Multi-Ad Creator2

The File Utilities… command lets you locate the original,
missing files of graphic images in documents. 
needs to know the location of some graphic file types in
order to print the relating images. However, the applica-
tion cannot print an image when the file has been moved
from its original location. 

The File Utilities dialog box lists all the files for which
needs the original files in the dialog’s scroll

list and identifies those images with missing files. Each
file listing includes a full pathname to the location of the
original graphic file. The volume name and filename
always appear. If cannot find an original file,
a «missing» notation appears next to the filename.

File Utilities…

Using the Find It Dialog Box

To make finding files as easy as possible, pro-
vides a directory dialog box with a search function. Even
if you cannot find the missing file, you can use the dialog
box to replace the missing file with another file of the
same type.

Click the OK button to apply your changes and return to
the Document Window. Click the Cancel button if you
want to discard your changes and return to the
Document Window.

Note: Font changes do not occur until you click the OK
button. Click the Cancel button to discard
unwanted changes.
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Locating an original file

1. Choose the File Utilities… command from the
Document menu. The File Utilities dialog box opens.

2. Select the name of the file you wish to locate from the
scroll list. 

3. Click the Find button. The Find dialog box opens.

4. Click the Find It button if you want to
find the file for you. If you already know where to
find the missing file, use the directory dialog to go to
its new location and click the Here button. This
resets the file’s path in the application to the new
location.

Once has the new pathname for the file, it
returns you to the File Utilities dialog box. 

5. Click the OK button to apply your changes and return
to the Document Window. Click the Cancel button to
discard your changes and return to the Document
Window.

Replacing graphics from the Find It dialog box

1. Select the Let me pick a different file check box at the
bottom of the Find It dialog box. Any potential
replacements in the active directory appear in the
Find It dialog box’s scroll list. You can use the direc-
tory dialog to navigate to other directories if neces-
sary.

2. Select the file that you wish to use in place of the
missing file. 

3. Click the Use button. resets the filename
and the pathname to that of the new file and returns
you to the File Utilities dialog box.

4. Click the Done button to apply your changes and
return to the Document Window. Click the Cancel
button to discard your changes and return to the
Document Window.
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The Replace button allows you to replace missing art
with another graphic file. 

1. Choose the File Utilities… command from the Edit
menu. The File Utilities dialog box opens.

2. Select a missing file from the scroll list.

3. Click the Replace button. A standard Macintosh
directory dialog box appears.

4. Locate and select the file you want to use in place of
the missing file. To see a preview of the selected file,
select the Show preview check box.

5. Click the Replace button. resets the file
name and the pathname to that of the new file and
returns you to the File Utilities dialog box.

6. Click the Done button to apply your changes and
return to the Document Window. Click the Cancel
button to discard your changes and return to the
Document Window.

Other Features of the File Utilities Dialog Box

To make copies of original files and place them in another
location, use the Copy button. This gathers all the origi-
nal files linked to a document and lets you put them in
one location. This feature lets you copy all necessary files
to a floppy disk or other medium to be taken to your
printer or service bureau.

Note: You don’t need to re-reference the location of the
graphic files after you have copied them to a new
location. Instead, place the copies of the graphic
files in the same location as the document file.
When you open the document, locates
the graphic images in the same folder, even though
the image pathnames point to another location.

Replacing Art Using the Replace Button
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Select the original files that you want to copy—you can
use Shift-click or Command-click to select more than one
at a time, or press Command-A to select all files—and
then click the Copy button. Specify a location for the files
in the resulting dialog box. Select the Change file refer -
ences when copying option to re-reference, or change, the
pathname of the original file to reflect its new location.

Click the Done button to apply the file changes and
return to the Document Window. Click the Cancel button
to discard you changes and return to the Document
Window.
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The View Menu

New Window ( -N)

The New Window command lets you display a document
in multiple windows. When you modify the elements in
one window, automatically displays the same
modifications in the other windows.

Note: Changes to text to not appear in other open win-
dows until after you deselect the Text tool. This
helps speed ’s operations.

The View menu contains commands that you use to pre-
view a document at different sizes. The View menu can
even display your document as a color plate. For example,
if you want to see the portion of your document that has
cyan ink, can display your document to show
this attribute.

The View menu also contains commands you need to dis-
play the floating palettes. You can decide what palettes
appear on-screen at any one time. Finally, if more than
one document is open at a time, you can jump to a
desired document from the View menu.

A complete description of the commands available in the
View menu follows.

In the illustration to the
right, the window
named Untitled 1:2
displays the same ele-
ments as the window
named Untitled 1:1.
You can jump to
another page in
Untitled 1:2 a n d
leave the elements
centered in Untitled
1:1.
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You can use the New Window command to view one sec-
tion of a document while you modify another. You can
also drag elements between windows. For example, you
may want to move a graph from page one to page three.
Choose New Window from the View menu to open a new
window. In the new window, use the scroll bars to go to
page three, or select the Page 2, 3 option from the Page
pop-up menu at the bottom of the Document Window.
This takes you to the spread containing page three. Now,
move your pointer back to the first window and drag the
graph to its insertion point on page three.

Remember, the New Window command provides multiple
views of the same document. Changes made in one win-
dow affect all the other open windows. You can open as
many windows as you computer’s memory allows.

Note: Do not increase the amount of memory allocated
to unless you receive a dialog box that
expressly tells you to do so.

Actual Size ( T)

The Actual Size command lets you display the document
at its true size, the same size at which it prints. If the
document’s actual size is larger than your Document
Window, only a section of the document appears. You can
view the rest of the document using the scroll bars or by
holding Control to display the Hand tool. By clicking and
dragging the Hand tool, you can move the page around
on the screen.

Actual Size - 100 percent
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Fit in Window ( F)

The Fit in Window command lets you display an entire
document page in the Document Window, regardless of its
actual size. If you have a multiple page document open,
the Fit in Window command displays the entire spread.
If you jump to another spread, the new spread also
appears in the Fit in Window view mode. To change view
modes, select another view command.

Enlarge ( E)

The Enlarge command lets you increase the display to
the next larger view scale interval. The view scale inter-
vals include: 25 percent , 50 percent , 75 percent , 100
percent , 150 percent , 200 percent , 300 percent , 400 per -
cent , and 800 percent . For example, if you set your view
scale to 88.7 percent and then select the Enlarge com-
mand, the view scale resets to 100 percent. You can’t
enlarge a document past 800 percent of its actual size.

When you choose the Enlarge command, the elements in
the Document Window enlarge accordingly. However,
your view remains centered on the point where you
clicked.

In the illustration to the
right, the user has
reduced a document
spread to fit inside a
w i n d o w. The current
view scale is set at 68
percent, the largest
value at which you can
see the entire spread.
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The Reduce command lets you reduce the display to the
next smaller view scale interval. The view scale intervals
include: 25 percent , 50 percent , 75 percent , 100 percent ,
150 percent , 200 percent , 300 percent , 400 percent , and
800percent . For example, if you set your view scale to
88.7 percent and then select the Reduce command, the
view scale becomes 75 percent. You cannot reduce the
view scale below 25 percent.

Reduce ( R)

Separation

The Separation submenu contains settings that let you
display documents as color plates. For example, if you
want to see how the cyan plate of your document
appears, choose the Cyan command. redis-
plays your document to show only those graphic areas
that contain the color cyan. Since the separation settings
are based on previews, separations for some graphic
types may look different when printed from a PostScript
printer.
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The Composite setting displays the entire color range of
a document on screen. In other words, the Composite
setting lets you display a representation of the document.

uses this as the standard setting. 

Composite

Cyan

The Cyan setting displays only those sections of a docu-
ment that contain cyan. The Cyan command lets you dis-
play a representation of the cyan plate of a document. 

Magenta

The Magenta setting displays only those sections of a
document that contain magenta. The Magenta command
lets you display a representation of the magenta plate of
a document. 

Yellow

The Yellow setting displays only those areas of a docu-
ment that contain yellow. The Yellow command lets you
display a representation of the yellow plate of a docu-
ment. 

Black

The Black setting displays only those areas of a document
that contain black. The Black command lets you display a
representation of the black plate of a document. 

Spot Colors

reserves a place on the Separation submenu
for spot colors. Any spot color that you have placed on the
Colors palette also appears in the Separation submenu.
When you choose a spot color name from the submenu,

redisplays your document to show you only
those areas that contain the selected spot color.
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Rulers ( -R)

The Rulers command lets you display or hide ’s
horizontal and vertical rulers. If the rulers do not appear
in a document, choosing the Rulers command in the View
menu places a check mark next to the Rulers command
in the View menu and displays the rulers. If the rulers
already appear, choosing the Rulers command removes
the check mark and hides the rulers. 

To size and place an element

Display the rulers when you wish to size and place ele-
ments in your Document Window. The rulers’ selected
units of measurement can help you place elements in pre-
cise positions. 

1. Choose the Rulers command from the View menu.
This displays the horizontal and vertical rulers in
your document. When you move the arrow pointer
into the document area, lines appear on the rulers.
These lines track the position of the pointer.

2. Click on an element tool and place your pointer so the
dotted lines on both horizontal and vertical rulers are
even with a line (or tick) marking the beginning of
any measurement. 

3. Drag the element tool toward the bottom right corner
of the document. When the dotted lines on both
rulers are even with the line (or tick) marking the
end of your measurement, release the mouse button
to create an element of the appropriate dimensions.

Rulers
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Placing guides using the rulers

To place a guide, click anywhere on the horizontal or ver-
tical ruler. A diamond—called a guide handle—appears
where you clicked. The guide handle marks the location
of a guide line that can position elements in relation to
each other and the document. See the Setup Guides…
and Guides… commands in the Arrange menu section for
details on creating and positioning guides.

To move a guide line, click on its guide handle and drag it
to a new position on the ruler.

You can remove a guide by dragging it off the ruler. When
you release the mouse button, the guide disappears.

Using the Guide Snap Toggle

The button in the upper left corner of the Document
Window is called the Guide Snap Toggle. It’s the button
with the pair of intersecting dotted lines and a small gray
square.

Clicking the Guide Snap Toggle turns the toggle either on
or off. When this gray square rests next to the intersec-
tion of dotted lines, all elements near guides “snap to” the
guides. 

The Guide Snap Toggle also lets you align elements along
their center axes. You can set how close you place an ele-
ment to a guide before it “snaps” in the Guides dialog
box. Using the snap to guides function helps you position
elements precisely. See the Setup Guides… and Guides…
commands under the Arrange menu section for more
information about creating and positioning guides.

Setting a zero point

1. Click on Guide Snap Toggle in the upper left corner of
the Document Window. The button contains two
intersecting dotted lines. 

Snap Guide
Toggle on

Snap Guide
Toggle off
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2. Drag diagonally down and to the right. You’ll notice
vertical and horizontal lines that move with you.

3. Position the horizontal and vertical lines at the
desired zero point location. 

4. Release the mouse button. The ruler changes so the
zero point of the selected measurement system corre-
sponds to the specified location.

Using this technique, you can reset your zero point to cor-
respond with any other point in the Document Window: a
column of text in the Document Area, an element in the
center of your document, and so on. You can return the
zero point to the default setting (where zero on both
rulers corresponds to the upper left corner of the
Document Area rectangle) by pressing the Command key
and clicking the Guide Snap Toggle.

Zero point
lines

Click and
drag on the
Guide Snap
Toggle

Guides

The Guides command lets you view all the guides placed
in a document. A checkmark appears next to the Guides
command listing in the View menu when you have the
command activated. Deactivating the Guides command
hides all the guide lines placed in a document.

Arrange Palettes

The Arrange Palettes command lets you return all the
visible palettes in a document to their default positions
around the Document Window. The Arrange Palettes
command repositions both visible and hidden palettes,
but it does not make hidden palettes visible.
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The Tools command lets you hide or display the Tools
palette. The Tools palette contains the most important
tools you need to create and modify elements.

Choosing the Tools command from the View menu places
a check mark next to the Tools entry and displays the
palette. If you want to remove the palette from the
Document Window, choose Tools again and the check
mark disappears along with the Tools palette. For more
information, see the Tools palette entry.

Tools

Colors

The Colors command lets you hide or display the Colors
palette. The Colors palette lets you set frame, fill, and
shadow colors for elements. You can also set outline, fill,
and shadow colors for text. The icons on the Colors
palette change to reflect what type of object (elements or
text) you have selected.
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The Files command lets you hide or display the Files
palette. The Files palette gives you easy access to fre-
quently used graphic and text files. You can add files to
your document simply by clicking on the name of the file
on the Files palette and dragging it into the document.

Choosing the Files command from the View menu places
a checkmark next to the Files entry and displays the
palette. If you wish to remove the palette from the
Document Window, choose Files again and the check
mark disappears along with the Files palette.

For more information, see the Files palette entry.

Files

Choosing the Colors command from the View menu
places a check mark next to the Colors entry and dis-
plays the palette. If you wish to remove the palette from
the Document Window, choose Colors again and the
check mark disappears along with the Colors palette. For
more information, see the Colors palette entry.
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Styles

The Styles command lets you hide or display the Styles
palette. The Styles palette gives you easy access to any
type styles, paragraph styles, element styles, or style
models you have created. You can apply any of these
styles from the Styles palette.

Choosing the Styles command from the View menu
places a check mark next to the Styles entry and displays
the palette. If you wish to remove the palette from the
Document Window, choose Styles again and the check
mark disappears along with the Styles palette.

For more information, see the Styles palette entry.
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The Element Specs command lets you hide or display the
Element Specs floating palette on the screen. This palette
lets you control the size and position of an element. This
command appears in both the Arrange and View menus.

For more information on the Element Specs palette, see
the Palette section.

Font Specs

The Font Specs command lets you hide or display the
Font Specs floating palette. You can use the Font Specs
palette to select fonts for your document, just like choos-
ing a font from the Font menu. You can also use the
palette to choose a size or a commonly used style.

When you use a GX font, the Variation and Featur e pop-
up menus become available. The Variation pop-up menu
lets you adjust the appearance of the selected font while
the Featur e menu lets you activate special font character-
istics. The pop-up menus appear dimmed if the selected
font does not contain these options.

This command appears in both the Format and View
menus.

For more information on the Variation and Featur e pop-
up menus, see the entry on the Font Specs palette.

Element Specs
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The Arrangement command lets you hide or display the
Arrangement floating palette on the screen. This palette
lets you access many of the commands in the Arrange
menu, like Bring to Front, Send to Back, Flip
Horizontal, Flip Vertical, and others. This command
appears in both the Arrange and View menus.

For more information on the Arrangement palette, see
the Palette section.

Arrangement

Trapping

The Trapping command lets you hide or display the
Trapping palette. This palette lets you set trapping
attributes for a selected element. 

With the Trapping palette you can set trapping attributes
for an element’s frame, fill, and/or shadow. Selecting the
Overprint Black check box tells to always print
black ink over another color for that element only.

For more information on trapping and the Trapping
palette, see the Trapping command entry in the Elements
menu section.
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If you have more than one document open at a time,
lists the names of these documents at the bot-

tom of the View menu. You can choose the name of a doc-
ument and places that Document Window
before you. In this way, you can bring hidden windows to
the front.

In this example, selecting Untitled 1 activates the back-
ground document and places it in the foreground.

Document Name

Document
names



250 Multi-Ad Creator2

CHAPTER 2: MULTI-AD CREATOR2 PALETTES
This chapter discusses the Tools palette, Colors palette,
Styles palette, Files palette, Arrangement palette, Font
Specs palette, and the Element Specs palette. It also pro-
vides in-depth information about the tools and options
available in each palette.

About palettes

When you open for the first time, a group of
palettes automatically appears arrayed around the
Document Window. These palettes include: the Colors
palette, Tools palette, Arrangement palette, Styles
palette, Files palette, Element Specs palette, and the
Font Specs palette.

You can close, or hide, a palette by clicking on its close
box or by deselecting its command in one of the menus.
You can open a palette by selecting its command from one
of the menus. You can find the commands to display the
palettes in the View menu.

You can move each palette anywhere on the screen by
clicking and dragging on its title bar. If you want, you can
reshape the Colors, Styles, and Files palettes by clicking
and dragging their Resize buttons. The Resize button
appears as a small box imposed over a larger box. You
can find the Resize box in the lower right corner of the
appropriate palette.

can even remember where you last placed
each palette so when you open a new document, the
palettes appear in their last position. also
remembers what palettes you have open and what
palettes you have hidden.
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The Tools Palette
The Tools palette contains the tools you need to create
and modify elements. For even more control over ele-
ments, double-click on an element to open the dialog box
for the Element Info… command. Each dialog box is
named after the selected element shape and lets you
modify the format settings for the selected element.

The Arrow Tool
The Arrow tool lets you manipulate the size and position
of elements in the Document Window. To use the Arrow
tool, click on the Arrow button on the Tools palette. You
can use the Arrow tool to:

• Select elements
Select elements in the Document Window by
clicking on the element. To select more than one
element, hold down the Shif t key as you click on
each one. You can also select elements by drag-
ging a selection rectangle around them. As you
drag, all elements that overlap that rectangle
become selected. When an element is selected, it
is surrounded by selection handles.

If you wish to select an element hidden behind
other elements, press the Tab key. This progres-
sively selects each element in a document.

Selection
handles
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• Resizing elements
Resize elements by moving the Arrow pointer
over any of the black selection handles. When
positioned over a selection handle, the pointer
changes to pinching fingers. 

To resize an element horizontally, grab a handle
on the right or left side of the element and drag
horizontally. To resize an element vertically, grab
a handle at the top or bottom of the element and
drag vertically. To resize an element both verti-
cally and horizontally, grab a corner handle and
drag diagonally. To resize an element proportion-
ately, press the Shif t key while resizing from a
corner handle. 

If you want the text in a text block to stretch
when you resize the block, hold the Command key
(and the Shif t key, if you wish to constrain pro-
portionally) while dragging.

To resize more than one element at a time, select
the elements by holding down the Shif t key and
clicking each with the Arrow tool, or by dragging
a selection rectangle. Choose the Group command
from the Arrange menu to group the items
together. Now click on the grouped element and
resize it as you normally would.

• Deleting elements
Delete elements or text blocks in the Document
Window by selecting the elements with the Arrow
tool and pressing the Delet e key. To restore
deleted elements, choose Undo from the Edit
menu (or press Cmd-Z ) immediately after the dele-
tion.

• Moving elements
Move elements or text blocks anywhere in the
Document Window by moving the Arrow pointer
onto the element and clicking and dragging. To
restrict the drag to either the horizontal or verti-
cal dimension, hold down the Shif t key after
starting the drag. 

Do not drag an element by its selection handles. If
you do this, the element resizes. If you acciden-
tally resize an element you wished only to move,
or vice versa, choose Undo from the Edit menu (or
press Cmd-Z) to restore the element to its previous
condition.
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The Text Tool

The Text tool lets you create and edit text blocks in the
Document Window.

Click the Text tool on the Tools palette, and the pointer
appears as an A with a crosshair (+A). When you move
the pointer over an existing text block, it changes into an
I-beam. The crosshair indicates that you can create text
blocks, while the I-beam indicates that you can enter or
edit text in existing blocks.

Create text blocks in the Document Window by dragging
the Text tool diagonally in any direction. When you
release the mouse button, a box appears with a tab
(called a widget) below the bottom right corner. Pressing
the Option key with the Text tool selected lets you draw a
new text block on top of an existing one. A blinking text
insertion point appears at the upper left corner of the box
as soon as you finish creating the text block. 

When you begin typing, the text appears at the blinking
insertion point. You can copy text from other text blocks,
or other documents, and paste it into the new text block.
You can also import text. For more information, see the
Import… command entry under the File menu.

If you create a text block large enough to display all of its
contained text, an exclamation mark (!) appears in the
box’s widget. If you have more text than a text block allows
for, the widget contains an ellipsis (…). To display addi-
tional text, you can either resize the text block with the
Arrow tool or flow the extra text into another text block.

Note: Press Enter to change the Text tool to the Arrow
tool so you can resize or move a text block. To
resize it, move the pointer to an edge or a corner of

Insertion
point

Widget
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the block until it changes to the pinching-fingers
resizing pointer. Then click and drag to resize the
block. 

To restore the Text tool, press Enter .

To flow text from one block to another, click on the ellip-
sis widget (…). When you click this widget, the pointer
becomes an A with a crosshair followed by an ellipsis
(+A...). This indicates that the pointer can create a block
for the extra text to flow into. 

Click and drag the pointer to create the new text block.
The excess text flows into the block when you release the
mouse button. If you still have more text than you can
display in the new block, an ellipsis (…) appears in the
box’s widget. If so, repeat these steps to flow the text into
additional blocks.

When you flow text from its original block to a second
block, the widget notation on the original block changes
from an ellipsis (…) to a 1. The widget of each block dis-
plays a number representing the text block sequence.

Text flows from block 1, to block 2, to block 3, and so on.
When you have displayed all the text, the widget on the
last block displays an exclamation mark (!).

!

2

1
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If you delete a text block from a series of blocks, the text
from the deleted block reflows through the remaining
blocks. When you delete a block, the widgets renumber or
display the appropriate symbol. Likewise, if you delete
text from any text block in a series, the remaining text
reflows through all the blocks.

If a single batch of text flows through a series of blocks,
you can still select it as if it were all in one block.
However, you must make selections sequentially. You can-
not select text in block 1 and block 3 of a series without
selecting everything in block 2 as well.

Note: Whenever you make a text block active for editing
(by selecting the Text tool and clicking in the
block), you make all linked blocks active because
they all contain different parts of the same text.
You can only make one linked set of text blocks
active for editing at a time.

Editing text in a block

1. Select the Text tool on the Tools palette and move the
pointer into the block. The pointer becomes an I-
beam. 

2. Click in the text block to make it active for editing. 

If the text overlaps other elements, it is shown in
front and appears opaque so you can edit the text
more easily. Clicking in a text block activates other
linked blocks linked, too. 

3. Click where you want to start typing or drag the
pointer over text you want to replace. 

4. Start typing.

!
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Up to now, you have only dealt with square text blocks.
However, lets you make text blocks out of any
shape. You can make ovals, starbursts, even freehand
drawings into text blocks, or in this case, text shapes.

Drawing a text shape

1. Click on a drawing tool on the Tools palette.

2. Click and drag in the Document Window to draw an
element. If you have selected the Oval tool, this cre-
ates an oval.

3. Click the Text tool on the Tools palette.

Multi-Ad Creator2

Text typed directly into a new text block assumes the
attributes (font, size, alignment, etc.) chosen in the Tex t
panel of the Preferences dialog box. You can modify
those attributes in a number of ways. For more informa-
tion, see the Text, Font, Size, and Style listings in
Chapter 1.

Creating Text Blocks of Different Shapes
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4. Press the Command key while clicking on the shape
you have drawn. Notice that your pointer changes
into a small arrow followed by an A.

After you Command-click on the element, it becomes a
text shape. You can identify a text shape by the wid-
get that appears when you click on the shape with
the Text tool.

5. Type or import the desired text into the text shape.

Reference Manual
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Linking text shapes

also lets you create sequences of text shapes.
The text flows from one shape into another. To do this,
click on the widget of a text shape and then Command -
click on the element you want to flow the text into.

For example, if you wanted to flow text from an oval into
a starburst:

1. Click the Oval tool on the Tools palette and draw an
oval element in the Document Window.

2. Click the Text tool on the Tools palette.

3. Command -click on the oval with the Text tool. Notice
that the oval gains an insertion point and a widget.

4. Import or type the text you want to appear in the
oval.
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5. Click the Starburst tool on the Tools palette and draw
a starburst element in the Document Window.

6. Click the Text tool on the Tools palette.

7. Click on the widget of the oval text shape with the
pointer.

8. Command -click on the starburst element.
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The overflowed text from the oval text shape flows
into the starburst.

Resizing text shapes

Like any other element, you can proportionally resize a
text shape by pressing Command while dragging on a cor-
ner handle with the Arrow tool selected. However,

also lets you proportionally resize the text
inside an element. With the Arrow tool selected, press
Command-Shif t while clicking on a corner handle of a text
shape. Notice that the text inside the element scales itself
at the same proportion as the element.
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The Containment tool lets you place one element inside
another. The container acts like a picture frame for the
element it holds. Any part of the contained element that
overflows the container ’s bounds cannot be seen. In this
respect, containing an element is similar to cropping,
except you can place any element—not just graphics—
inside a container. ’s automask function, for
example, simply places a graphic inside a container.

Using the Containment tool

1. Click on the Containment tool on the Tools palette.
The pointer turns into an outlined arrow when moved
into the Document Window.

2. Click and drag on an element. Move the selected ele-
ment onto another element (the container). Notice that
the container’s border becomes framed when you posi-
tion the selected element over the stationary one.

3. Release the mouse button to place the element you
wish to frame inside the container. places
the selected element inside the frame of the station-
ary element.

The Containment Tool
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Containing elements inside other contained elements

lets you place containers inside other ele-
ments through the Open Element command.

1. Draw the outermost container in the Document
Window.

2. Draw another element. 

3. Click on the Containment tool and place the second
element inside the container. Make sure the con-
tained element remains selected.

4. Select the Open Element command from the
Elements menu. This opens a window that allows you
to manipulate the contained element.

5. Draw a new graphic in the Open Element window.

6. Click on the Containment tool and drag the new ele-
ment into the contained item. This creates three lay-
ers of contained elements.

7. Repeat Steps 4 through 6 to place elements inside the
new contained level.

8. Click on the Open Element close box to return to the
Document Window.

Opening containers

To remove an element from a container, simply click on
the Containment tool on the Tools palette. Click on the
contained item and drag it out of the container. Notice
that the frame of the container becomes highlighted when
you have properly selected the contained element.

To remove an element contained more than one level
deep, progressively drag each contained element out of its
container. You can also choose Open Element for each
container, then cut and paste the desired contained item
into the main Document Window.



263Reference Manual

lets you modify elements as you place them in
containers. To open the Containment Tool Prefs dialog
box, double-click the Containment tool on the Tools palette.

The dialog provides four different options to choose from.
The Containment tool preference options include:

• No Scaling
The No Scaling radio button lets you place an ele-
ment in a container at the element’s current size.

uses the No Scaling radio button as its
default setting. 

If you have selected another containment option
but wish to use No Scaling , press the N key while
dragging the selected element into a container.

• Scale to Fit
The Scale to Fit radio button lets you center and
resize an element so it fits snugly in its container.

Setting Containment Tool Preferences
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If you have selected another containment option
but wish to use Scale to Fit , press the S key while
dragging the selected element into a container.

Note: If you place text, or a graphic containing
text, inside a container with the Scale t o
Fit preference selected, the text also
rescales. This may cause the text to appear
distorted.

• Fit Within Container
The Fit Within Container radio button lets you
center and scale a selected element proportionally
so that it fits within its container.

If you have selected another option but wish to
use Fit Within Container , press the W key while
dragging the selected element into a container.

• Fill Container
The Fill Container radio button lets you center and
scale an element proportionally so that it fills its
container.

If you have selected another containment option
but wish to use Fill Container , press the C key
while dragging the selected element into a con-
tainer.
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The Cropping Tool

The Cropping tool lets you crop graphic images. Cropping
lets you pare the edges of a graphic, like taking scissors
and cutting off one or more sides of an image. Cropping
doesn’t alter or resize the graphic in any way; it only
alters your view of the graphic. The remaining image
doesn’t get any smaller in scale, but it fits in a smaller
area. For example, you might crop out extra white space
at the top of a graphic or crop unwanted text from the
bottom of a picture.

Using the Cropping tool

1. Click on the Cropping tool on the Tools palette.

2. Click on the graphic you want to crop.

3. Move the Cropping tool over one of the image’s han-
dles. When you position the center of the Cropping
tool directly over a handle, it clamps down. When it
clamps, drag to crop the graphic.

3. Release the mouse button and move the pointer over
the graphic. The pointer turns into a four-way arrow.

4. Click and drag on the graphic with the four-way
arrow. This allows you to reposition the graphic
inside the cropped area.

The Reshape tool lets you modify the appearance of many
elements. Clicking on an element with the

Reshape pointer allows you to modify the element’s
shape. You can reshape rectangles, starbursts, freehand
drawings, and paths. You cannot reshape other element
types.

Using the Reshape tool

1. Click on the Reshape tool on the Tools palette. The
pointer turns into a crosshair when you move it into
the Document Window.

2. Click on the element you wish to reshape. Either a
dialog box or control points appear. If you have an ele-
ment selected before clicking on the Reshape tool, the
control points or dialog box for that element appear.

The Reshape Tool
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The Reshape Tool Dialog Boxes

Rectangle and starburst elements have their own dialog
boxes that you can open with the Reshape tool. These
dialog boxes let you modify the appearance or shape of
the elements they relate to.

Reshaping rectangles

Clicking on a rectangle with the Reshape tool opens a
dialog box and places new handles at the rectangle’s cor-
ners. 

When you click on a corner handle and drag inward, the
rectangle’s corners become rounded. You can adjust the
size of the corners by positioning the corner selection
handles. Initially, adjusts all the corner selec-
tion handles in tandem. 

If you wish to adjust the size of a single corner, click the
Link button in the Rectangle dialog box. When you click
the Link button, it changes to an Unlink button. This sig-
nifies that you can adjust the size of the selected corner
without affecting the other rectangle corners.

3. Make any modifications you want. auto-
matically applies your modifications to the selected
element.

To cancel a reshaping action, choose Undo from the
Edit menu or press Cmd-Z immediately following the
operation.

Linked
corners

Unlinked
corner
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Change the corner type by selecting a new option from
the Type pop-up menu. This method only changes one rec-
tangle corner at a time. To change the shapes of all the
corners of a rectangle, press the Option key while select-
ing a new corner shape from the Type pop-up menu.

Reshaping starbursts

When you click on a starburst with the Reshape tool, sev-
eral new handles appear on the starburst and the
Starburst dialog box opens, just as if you selected a rec-
tangle. However, you can reshape a starburst in more
ways than you can reshape a rectangle.

Like the rectangle’s selection handles, a starburst’s selec-
tion handles let you modify the element in unique ways.
Starburst shapes are contained within two rectangles.
The outer rectangle sets the edge of the starburst’s peaks,
and the inner rectangle sets the edge of the starburst’s
valleys.

Unlocked
corner

Corner
types

Locked
corner
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You can adjust the corner roundness of the inner and outer
rectangles by clicking and dragging on the two arrow selec-
tion handles that appear inside the starburst. The larger
arrow controls the roundness for the outer rectangle…

And the smaller rectangle controls the roundness for the
inner rectangle.

Handle
for inner
rectangle

Handle
for outer
rectangle
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You can also adjust the size of the inner rectangle. Click
and drag on one of the diamond selection handles on the
sides of the inner rectangle. To increase the length of the
inner rectangle, click on the left or right diamond selec-
tion handles. To increase the height of the inner rectan-
gle, click on the top or bottom diamond selection handles.
If you press the Shif t key while dragging a handle, you
can resize the inner circle proportionally.

You can even reposition the inner rectangle within the
frame of the outer rectangle. Move your pointer so that it
rests in the inner rectangle. However, don’t position the
pointer near a selection handle. The pointer turns into an
arrow-capped crosshair. Click and drag on the rectangle
to reposition it within the outer rectangle.

The Starburst dialog box lets you modify starbursts in
even more ways. The dialog box’s options include:

Diamond
selection
handle
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• Round Valleys
The Round Valleys check box smoothes the valleys
of a starburst so they appear rounded.

• Round Peaks
The Round Peaks check box smoothes the peaks of
a starburst so they appear rounded.
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• Randomization
The Randomization field and slide bar lets you
vary the peak and valley lengths within the
bounds of the inner and outer circles. You can
enter any percentage from 0 to 100. Zero repre-
sents no randomization and 100 represents
absolute randomization.

• Alternation
The Alternation field and slide bar lets you change
the length of every other flare on the starburst.
You can enter any percentage from 0 to 100. Zero
represents no alternation and 100 represents
absolute alternation.

• Points
The Points field lets you determine how many
flares you want a starburst to have.

• Center
The Center button centers the inner circle or a
starburst within its outer circle.
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• Random
The Random button creates different, random star-
burst designs based on your settings. You must
enter a value greater than zero in the
Randomization field to activate the Random button.

You can create many complex shapes using the Reshape
tool in conjunction with freehand drawings or path ele-
ments. When you select a path element with the Reshape
tool, reshape handles appear on the element. Two different
types of reshape handles, called control points, exist. An
unsmoothing control point indicates a straight line while a
smoothing control point indicates a curved line.

Note: Unsmoothed handles appear as diamonds and
smoothed handles appear as circles.

You can select a control point by clicking on it with the
Closed Hand pointer (an Open Hand pointer becomes a
Closed Hand pointer when positioned over a control
point). You can also drag a selection rectangle around a
control point (or a group of control points) to select it. A
selected control point becomes highlighted. Move a con-
trol point by clicking on it with the Closed Hand pointer
and then dragging it to another position.

Reshaping Path Elements

Unsmoothing
control points

Smoothing
control points
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Adding points to a line

Move the Open Hand pointer over a line. Press the
Command key while clicking to add a new unsmoothed
control point. If you press the Option key and the
Command key while clicking on a line, you create a
smoothed segment.

Toggling between smoothed and unsmoothed
points

Press the Option key and click on a handle to change it to
its opposite point type.

Closing a path element

Drag the end point over the element’s starting point.

Opening line segments

To open a closed path element, position the Open Hand
pointer over the line segment you wish to remove and
click the Option key.

Note: Each path element can have only one open segment.

Deleting points

Select a handle and then press the Delet e key.

Path Editing in Reshape
Mode:

• Click on a handle, then
drag the handle to
reshape.

• C m d - c l i c k on a line
segment to create a
new handle, drag to
reshape.

• Shift-Cmd-click on a
line segment to create
an opposite handle.

• Option-click a handle
to toggle between
smoothing and un-
smoothing.

• Delete-click a handle
to remove the handle.

End point
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The Rotate tool lets you rotate elements in any direction. 

Using the Rotate tool

1. Click on the Rotate tool on the Tools palette. The
pointer turns into a curved arrow when you move it
into the Document Window.

2. Click on the element you wish to rotate, if not already
selected.

3. Grab part of the element or one of its selection han-
dles, and drag in the direction you want the element
to rotate. Elements rotate around their centers.

To cancel a rotation, choose Undo from the Edit menu
or press Cmd-Z following the operation.

You can rotate any element in the Document Window,
including text blocks. However, you can only rotate one
element at a time with the Rotate tool. If you need to
rotate two or more elements at the same time, you must
first group them and then rotate them.

When you use the Rotate tool to rotate elements drawn in
or masked graphics, you see the actual outline

of the element being rotated. When rotating unmasked,
placed graphics, you see an outline defined by the ele-
ment’s selection handles being rotated. 

The Rotate Tool
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Pressing the Shif t key while rotating constrains the rota-
tion to 15 degree increments.

Setting the center of rotation

also lets you establish an element’s point of
rotation. In this way, you can rotate elements around
their corners, or any other point.

1. Click on an element with the Rotate tool.

2. Command -click at the point you wish to rotate the ele-
ment around. places a target at the
selected point.

3. Click on the target and drag away. Notice the selected
element rotates around the target.

Target
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The Skew Tool

The Skew tool lets you skew any element without chang-
ing the length of an element’s sides. 

Using the Skew tool

1. Click on the Skew tool on the Tools palette. The
pointer turns into a crosshair when you move it into
the Document Window.

2. Click on the element you wish to skew.

3. Click on a selection handle and drag in the direction
you want the element to skew.

To cancel a skew, choose Undo from the Edit menu or
press Cmd-Z immediately following the operation.

You can skew any element in the Document Window,
including text blocks. However, you can only skew one
element at a time with the Skew tool. If you wish to skew
two or more elements at the same time, you need to
group them and then skew them.

Pressing the Shif t key while skewing constrains the skew
to 45 degree increments.
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Using the Flip tool

1. Click on the Flip tool on the Tools palette. The pointer
turns into a crosshair when you move it into the
Document Window.

2. Click on the element you wish to flip. 

3. Drag on any part of the element or on one of its selec-
tion handles. Dragging in any direction automatically
flips the element. The element flips around a point
halfway between the initial click and the pointer’s
current position. 

To cancel a flip, choose Undo from the Edit menu or
press Cmd-Z immediately following the operation.

You can flip any element in the Document Window,
including text blocks. However, you can only flip one ele-
ment at a time with the Flip tool. If you need to flip two
or more elements at the same time, you must first group
them and then flip them.

When you use the Flip tool to flip elements drawn in
or masked graphics, you see the actual outline

The Flip Tool

The Flip tool lets you reposition and rotate a selected ele-
ment. The Flip tool does notflip an element at its point of
origin. Instead, you must move the element to a new loca-
tion in order to flip it.



278 Multi-Ad Creator2

of the element being flipped. When flipping unmasked,
placed graphics, you see an outline defined by the ele-
ment’s selection handles being flipped. 

The Line tool lets you create lines of any angle.

Using the Line tool

1. Click the Line tool on the Tools palette. The pointer
turns into a crosshair when you move it into the
Document Window.

2. Click and drag the pointer across the screen, at any
angle, to draw a line. To constrain lines to increments
of 45 degree angles, press the Shif t key while drag-
ging the Line pointer.

If you have your rulers displayed (chosen in the View
menu), you can use them to size the line. For details,
see the discussion on Rulers, under the View menu in
Chapter 1.

3. Release the mouse button to create the new line.
selects the new line. You can then reposi-

tion the element, resize, and so on.

The Line Tool

The Border Tool

The Border tool lets you place custom borders for art and
text in the Document Window.

Using the Border tool

1. Click on the Border tool on the Tools palette. The
pointer turns into a crosshair when moved into the
Document Window.

2. Click and drag to draw the border. If you have your
rulers displayed (chosen in the View menu), you can
use them to size the elements. For details, see the
discussion on Rulers, under the View menu in
Chapter 1.

To create a square border, hold down the Shif t key
while dragging.
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The Rectangle tool lets you create custom squares and
rectangles.

Using the Rectangle tool

1. Click the Rectangle tool on the Tools palette. The
pointer turns into a crosshair when moved into the
Document Window.

2. Drag the pointer across the screen to draw the
desired square or rectangle. If you have your rulers
displayed (chosen in the View menu), you can use
them to size the elements. For more information, see
the Rulers command entry under the View menu.

Press the Shif t key while clicking and dragging to
constrain the rectangle to a square or rounded
square.

3. Release the mouse button to create the new rectan-
gle. selects the new element. You can then
reposition the element, resize, and so on.

Note: You can use the Reshape tool to vary the appear-
ance of a rectangle element’s corners.

The Rectangle Tool

The Oval tool lets you create custom circles and ovals.

Using the Oval tool

1. Click the Oval tool on the Tools palette. The pointer
turns into a crosshair when moved into the Document
Window.

2. Click and drag the pointer across the screen to draw
the desired circle or oval. If you have your rulers dis-
played (chosen in the View menu), you can use them
to size the elements. 

Press the Shif t key while clicking and dragging to
create circles.

The Oval Tool

3. Double-click on the Border tool to open the Border
directory dialog box. Locate the Border folder and
select the desired border file.
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The Starburst tool lets you create custom starbursts.

Using the Starburst tool

1. Click on the Starburst tool on the Tools palette. The
pointer turns into a crosshair when you move it into
the Document Window.

2. Click and drag to draw the starburst. If you have
your rulers displayed (chosen in the View menu), you
can use them to size the shape. For details, see the
discussion on Rulers, under the View menu in
Chapter 1.

Press the Shif t key while dragging to create propor-
tional elements.

3. Release the mouse button to create a new starburst.
selects the new shape. You can then repo-

sition the shape, resize it, and so on.

Note: You can use the Reshape tool to vary the appear-
ance of a starburst element’s size and flares.

The Starburst Tool

The Freehand Drawing tool lets you make freeform lines
and shapes. You can draw open or closed shapes.

Using the Freehand Drawing tool

1. Click on the Freehand Drawing tool on the Tools
palette. The pointer turns into a pencil when you
move it into the Document Window.

2. Click and drag to draw freeform shapes. 

The Freehand Drawing Tool

3. Release the mouse button to create the new oval.
selects the new element. You can then

reposition the element, resize it, and so on.
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The Path Tool

The Path tool combines the Line tool with the flexibility
of the Freehand drawing tool. The Path tool lets you cre-
ate path elements with both straight and curved lines.

Using the Path tool

1. Click the Path tool on the Tools palette. The pointer
turns into a pen when you move it into the Document
Window.

2. Create a line. You can draw straight lines by clicking
at the line’s start point and then clicking at the line’s
end point. 

3. Release the mouse button to create the freeform
shapes. selects and automatically
smoothes the line you drew. You can then reposition
the element, resize, and so on.
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To draw curved lines, click at a start point. Click and
drag at the point where you want the line to curve.
You can release the mouse once the line begins to
curve. Finally, click at the point where you want the
line to end.

If you have your rulers displayed (chosen in the View
menu), you can use them to size your lines. For more
information, see the Rulers command entry under the
View menu.

3. Click the pointer on the original starting point to cre-
ate a polygon.

To cancel a path element, choose Undo from the Edit
menu or press Cmd-Z immediately following the oper-
ation.
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The Colors Palette
The Colors palette contains three icons for assigning col-
ors to elements. These icons let you set colors to an ele-
ment’s frame, fill, and shadow. A text field and a pop-up
menu appear next to the three icons. You can select a per-
centage from the pop-up menu to set a color’s shade, or
you can enter a percentage into the text field.

In most cases, the icons on the Colors palette contain rec-
tangles illustrating the icons' functions. However, if you
click on a text block with the Text tool or select a range of
text, then the icons change into letters. These letters also
illustrate the icons' functions

The colors listed in the Colors palette may vary from one
document to another. You can add and remove colors on
the palette through the Colors from document name
dialog box. You can open the Colors from document
name dialog box either by choosing the Colors… com-
mand from the Document menu or by double-clicking on
one of the buttons on the Colors palette. For more infor-
mation on adding or removing colors from the Colors
palette, see the entry from the Colors… command in the
Document menu.

Changing pre-assigned colors on elements

Besides assigning new colors to elements, you can use the
Color palette to change colors already assigned to ele-
ments. 

1. Click on an element. 

2. Select a feature icon (the Frame , Fill , or Shadow icon)
from the Colors palette. Whatever button you select,
the current assigned color appears highlighted on the
palette. 

3. Choose a new color and, if necessary, a new shade
percentage. automatically applies your
selected changes to the element
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Rearranging colors

Although the first four colors on the palette (None , Black ,
Whit e, and Registration ) always remain the same, you
can rearrange the rest of the color listings. Simply click
and drag on the color that you want to move. Notice that
the color listing becomes a highlighted line as you drag it.

Position the highlighted line between the color entries
where you want the color to appear. When you release
the mouse button, the name of the color you selected
appears in place of the highlighted line.

The Frame Icon

Selecting the Frame icon in the Colors palette lets you
outline selected elements in the Document Window with
a selected color.

Assigning a Frame

1. Click on the element(s) you wish to frame.

2. Click the Frame icon on the Colors palette.

3. Click on the color you wish to frame the element with
from the scrolling list in the Colors palette. The out-
line of selected elements becomes the chosen color.

Selected
color

Highlighted
line



285Reference Manual

Selecting the Fill icon in the Colors palette lets you fill
selected elements in the Document Window with assigned
colors.

Assigning a Fill

1. Click on the element(s) you wish to fill.

2. Click the Fill icon in the Colors palette.

3. Click on the color you wish to fill in the element from
the scrolling list in the Colors palette. The selected
element’s interior fills with the chosen color.

The Fill Icon

The Shadow Icon

Selecting the Shadow icon in the Colors palette lets you
fill the shadows of selected elements in the Document
Window with assigned colors.

Assigning a Shadow

1. Click on the element(s) you wish to Shadow.

2. Click the Shadow icon in the Colors palette.

3. Click on the color you want to fill in the shadow of the
element from the scrolling list in the Colors palette.
The selected element’s shadow fills with the chosen
color.

Note: If you click on the Frame icon while you have text
selected, the text appears filled with the selected
color, unless you have selected outline or shadow
text. When you apply a frame color to outline or
shadow text, that color only appears on the outline
of the selected characters. You need to select a fill
color for the interior of outline and shadow text.
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The Files Palette
The Files palette places frequently used text or graphic
files on a list for easy reference and quick use. The
palette speeds the creations of documents containing
many graphic elements and/or text files.

The Place Graphic and Import Text dialog boxes contain
two methods for placing files. Either placeg the file imme-
diately (with the Place button) or defer placement of the
file by adding it to the Files palette (with the Add files to
palette and Add all icons).

The Shade Field
The Shade field lets you adjust the shade of any color on
an element. 

Assigning a Shade

1. Click on the element with the color you wish to
adjust.

2. Click the Frame, Fill, or Shadow icon. The color you
have assigned for the chosen feature appears high-
lighted.

3. Click on the pop-up menu to the far right of the but-
tons and select a percentage. You can also enter a
percentage into the text field to the immediate right
of the Shadow icon. By default, all colors first appear
at 100 percent. Choose a lesser percentage to shade
the color. The lower the percentage, the lighter the
color.

To return to 100 percent, or to choose another shade,
choose a value from the pop-up menu or enter a new value
into the text field.
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The Place icon closes the dialog box and returns you to
the Document Window. The Add files to palette and Add
all icons do notclose the dialog box. You can keep adding
files to the palette list until you click on the Done button.

When you return to the Document Window, notice that
symbols appear to the left of the filenames on the Files
palette. The symbols include: ps for EPS (Encapsulated
PostScript) files, a collection of element shapes for PICT
files, and a graphic symbol for MacPaint, TIFF, RIFF,
GIF, and JPEG files.

The top of the Files palette contains three icon buttons.
Clicking the Open icon opens either the Place Graphic or
Import Text dialog boxes. To add a graphic image to the
Files palette, click the Arrow tool on the Tools palette and
then click the Open icon on the Files palette. To add a
text file to the Files palette, click the Text tool and then
click the Open icon. 

To help you identify which dialog box opens when you
click the Open icon, the icon’s image changes. The Open
icon contains a representation of a graphic file if you
have the Arrow tool selected. It contains a representation
of a text file if you have the Text tool selected.

Open graphic
file icon

Open text file
icon
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The Delete icon removes selected items from the Files
palette. 

To remove all the files on the Files palette, press the
Shif t key and click on the palette. To delete multiple—but
nonconsecutive files—on the palette, press the Command
key while clicking on the names of the files you wish to
delete. 

The Place icon creates a crosshair that lets you draw a
rectangle in which to place a selected file. The Place
icon’s appearance may change, depending on what kind of
file you have selected. If you have a graphic file selected,
a representation of a graphic file appears on the Place
icon. If you have a text file selected, a representation of a
text file appears on the Place icon.

Placing from the Files palette

You can place text or graphic files from the Files palette
in one of two ways:

Double-click on a filename to automatically place it in
the document

Or

Click on a filename and drag a rectangle for the file’s
contents to appear in (press the Shif t key to keep the
graphic’s contents proportional). 

Adding files from the desktop

lets you drag files directly from the Finder to
the palette. To do this, first select the Keep Files palett e
visible while in background check box in the General panel
of the Preferences dialog box in the Edit menu. Unless
you select this check box, the Files palette always disap-
pears when you go to the Macintosh desktop.

Delete
icon 

Place graphic
file icon

Place text
file icon
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The Styles Palette
The Styles palette contains four icons for displaying lists
of previously saved type styles, paragraph styles, style
models, and element styles. You can assign these styles to
selected text or elements. Each style in each list also
shows its keyboard equivalent, if it has one.

Assigning a type style, paragraph style, or style
model

1. Select the text or element you want styled.

2. Click the Type Style, Paragraph Style, or Style
Model icon at the top of the Styles palette.

3. Click on a style name from the list that appears in
the Styles palette. The selected text reformats to
reflect your choice.

Removing style attributes from selected text

1. Select the text or element you want to modify.

2. Click a style icon (type style or paragraph style) that
relates to the style attributes you wish to remove.

3. Select None from the scrolling list. 
removes that style from the selected text or element.

Type Styles icon

Selecting the Type Styles icon in the Styles palette lets
you assign a previously saved style of character formats
to the selected text.

Assigning type styles

1. Select the characters you wish to format.

To format all the text in a block, press Cmd-A to select
everything.

The Files palette becomes highlighted when you drag a
file from the desktop onto the palette. When you release
the mouse button, places the name of the
selected file on the palette. You can now place the file in
your document in any of the ways mentioned above.
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To format a portion of the text, select that portion.

To apply a type style to text that hasn’t yet been
typed, click an insertion point where you wish to
begin typing.

2. Click the Type Style icon in the Styles palette to dis-
play the list of saved type styles in the scrolling list.

3. Click on the type style you want. Selected characters
or new characters typed from the location of the text
insertion pointer format accordingly.

Paragraph Styles Icon

Selecting the Paragraph Styles icon in the Styles palette
lets you assign a previously created style of paragraph
formats to the selected paragraphs. 

Assigning a paragraph style

1. Select the paragraphs you wish to format.

To format just one paragraph in a block, click the text
insertion pointer anywhere in that paragraph. 

To format all the paragraphs in a block, press Cmd-A .

To format selected paragraphs, select at least one
character in each paragraph in a continuous selection
operation.

To apply a paragraph style to text that hasn’t yet
been typed, click the text insertion pointer where you
wish to begin typing.

2. Click the Paragraph Style icon in the Styles palette
to display the list of saved paragraph styles in the
scrolling list.

3. Click on the paragraph style you want. Selected para-
graphs or new paragraphs typed from the location of
the text insertion pointer formats accordingly. If the
paragraph style you select has a type style associated
with it, character settings as well as paragraph
attributes change.
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Selecting the Style Models icon in the Styles palette lets
you assign a previously saved style model to the selected
text.

Assigning style models

1. Select the text you wish to restyle. The text has to
conform to certain specifications. For a detailed dis-
cussion of these specifications, see Make Style
Models under the Edit menu in Chapter 1.

2. Click the Style Model icon in the Styles palette to
display the list of saved style models in the scrolling
list.

3. Click on the style model you want and the selected
text formats accordingly.

Style Models Icon

Element Styles Icon

Selecting the Element Styles icon in the Styles palette
lets you assign a previously saved element style to the
selected text.

Assigning element style

1. Select the element you wish to restyle.

2. Click the Element Style icon in the Styles palette to
display the list of saved element styles in the
scrolling list.

3. Click on the element style you want and the selected
element formats accordingly.
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The Arrangement palette provides quick access to certain
commands in Arrange menu. The commands include:

Manipulating an element with the Arrangement

palette

1. Click on the elements that you wish to reposition.

2. Choose the Alignment command from the Arrange
menu to display the Arrangement palette.

3. Click the appropriate button to reposition the ele-
ments. 

Note: While you can flip and change the front-to-back
ordering of one element at a time, you must have
two or more elements selected before you click on
the other buttons. If you do not have enough ele-
ments selected, the buttons appear dimmed.

The Arrangement Palette

Align
left

Align
center
(vertical)

Align
right

Justify 
horizontal
spacing

Flip
horizontal

Bring to
front

Send to 
back

Align 
top

Align center
(horizontal)

Align
bottom

Justify
vertical
spacing

Flip 
vertical
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Font Specs Palette

The Font Specs command lets you open the Font Specs
floating palette. You can use the Font Specs palette to
select fonts for your document, just like choosing a font
from the Font menu. You can also use the palette to
choose a size or a commonly used style.

While you can use some of the options on the Font Specs
palette with all fonts, some options only appear active
when you select a special type of font. The options you
can always select include:

• Font pop-up menu
The Font pop-up menu lets you select and apply a
font to text. Every font available in the Font
menu also appears in the Font pop-up menu on
the Font Specs palette.

• Size pop-up menu
The Size pop-up menu lets you select and apply a
point size to text. Every point size available in
the Size menu also appears in the Size pop-up
menu on the Font Specs palette. You can also
enter any desired size into the Size text field.

• Style buttons
The style buttons let you you select and apply the
most commonly used styles to text. Simply click
on a button to apply the represented style.
Buttons exist for the embolden, italic, underline,
outline and shadow styles. To turn a style off,
click on that style’s button a second time.

You must select a GX font from the Font menu, or from
the Font pop-up menu on the Font Specs palette, in order
to activate the Variation and Featur e pop-up menus. The
Variation pop-up menu lets you adjust the appearance of

Font pop-up
menu

Size text field and
pop-up menu Style buttons

Variation
pop-up
menu

Variation
slide bar

Instances
pop-up
menu

Feature pop-up
menu

Settings pop-up
menu
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the selected font. Different GX fonts let you adjust differ-
ent aspects of a font’s appearance. In most cases, Width
and Weight options appear in the Variation pop-up menu.
To adjust a feature of a font, choose the desired feature
from the pop-up menu and then click and drag on the
slide bar.

Some GX fonts come with preset styles. To select a preset
style, choose an option from the Instances pop-up menu.
Common styles include light, regular, and bold.

The Featur e menu lets you activate special font charac-
teristics. Each GX font has its own set of features that
you can activate. Some common features include:

The Settings pop-up menu, next to the Features pop-up
menu, offers additional options that relate to the option
chosen in the Features pop-up menu. For example, if you
choose Ligatures option from the Features pop-up menu,
you can choose from Common Ligatures , Rare Ligatures ,
and Dipthong options in the Settings pop-up menu.
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The Element Specs palette lets you manipulate the posi-
tion, size, and orientation of an element. 

The Element Specs palette contains ten options: 

• Top
The Top field represents the top measurement of
the selected element. The value you enter into the
field reflects the element’s position on the vertical
ruler.

• Bottom
The Bottom field represents the bottom measure-
ment of the selected element. The value you enter
into the field reflects the element’s position on the
vertical ruler.

• Left
The Lef t field represents the left measurement of
the selected element. The value you enter into the
field reflects the element’s position on the hori-
zontal ruler.

• Right
The Right field represents the right measurement
of the selected element. The value you enter into
the field reflects the element’s position on the hor-
izontal ruler.

• Height
The Height field represents the vertical size of the
selected element. 

• Width
The Width field represents horizontal size of the
selected element.

• Rot
The Rot field represents the number of degrees
the selected element is rotated.

The Element Specs Palette
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• Skew
The Skew field represents the number of degrees
the selected element is skewed.

• Preserve width and height
The Preserve width and height lets you move the
selected element to a measurement that you enter
into the Top, Bottom , Lef t , or Right fields. The
dimensions of the element remain the same.

If you deselect the   and then enter a new mea-
surement into the Top , Bottom , Lef t , or Right text
fields, the selected element resizes. The relating
side of the element moves to the new measure-
ment. However, the other sides of the element
remain in their original positions.

• Type
The Type notation indicates the type of element
you have selected.

Whenever you click on an element, the element’s position
on the page, dimensions, and orientation values appear
in the fields. When you resize, move, or reorientate an
element, the values in the Element Specs palette auto-
matically change to reflect the new settings.

Manipulating an element with the Element Specs
palette

1. Click on an element that you wish to modify.

2. Choose the Element Specs command from the
Arrange menu to display the palette.

3. Click in one of the fields on the palette.

4. Enter a new value into the field and press the Return
key or the Enter key to apply the changes. 

Note: Press the Tab key to jump to the next field. As you
do so, applies the changes from the
previous field.
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APPENDIX A: THE PAGE BORDER AND FILL
lets you apply borders and fill colors to indi-

vidual pages. You can open the Page Border and Fill dia-
log box by double-clicking on a page. A menu command
for the Page Border and Fill dialog box does not exist.

The Page Border and Fill dialog box works much like
that of the Element Info… command in the Elements
menu. However, in the Page Border and Filldialog box,
the option you choose in the Border Type pop-up menu
determines what panels appear in the dialog box’s scroll
list. From this pop-up menu, you can select the type of
border you wish to place around the page. 

• Use Master Spread
The Use Master Spread option applies a style
that exists on a master page. It also lets you use
the elements on a master spread as the design for
the selected page. Note that selects
this option by default. Choosing another option
for the selected page keeps the master spread ele-
ments in place on other pages.

• Rectangle
The Rectangle option creates a rectangle around
the selected page. When you select the Rectangle
option from the pop-up menu, the Fill , the Frame,
and Corners panels appear in the scroll list. You
can set the attributes of the rectangle with these
panels.
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• Custom Border
The Custom Border option applies a border style
to the selected page. When you select the Custom
Border option from the pop-up menu, the
Fill/Frame and Border panels appear in the scroll
list. You can set the border’s attributes with these
panels.

• None
The None option lets you remove a page border
and/or fill from a page entirely.

• Border inset
The Border inset text field lets you set how far in
from the edge of a page you wish a border or rec-
tangle to appear.

• Bleed outset
The Bleed outset text field lets you determine
how far you want the page fill color to extend out-
side the page boundary.



299Reference Manual

APPENDIX B: CREATOR2 FILE FORMATS
This section contains information about file formats
accepted by for placement in document files. 

The two major categories of file formats that 
accepts are text and graphics. There are several accept-
able file types in each category.

On the following pages, the name of each file format cate-
gory appears in bold on a line by itself. Below the cate-
gory name, each acceptable file format in the category is
listed in bold on a line by itself.

Also called “ASCII Text,” or “Text-Only file,” this is the
most elemental text format. It contains no formatting—
no bold, no italic, no anything—only the characters that
comprise the text, along with tabs, return characters and
line feed characters.

ASCII text—the lowest common text denominator—can
be created by almost any word processor. All Macintosh
word processors—and most word processors for other
computers—can “save as ASCII text.” Once saved, the
ASCII text can easily be moved between computers, just
as any file would be transferred.

Because text can be quickly styled in , you may
find ASCII the most convenient text format. By inserting
characters such as /, {, or other “separator” characters
into the text, you can take advantage of ’s
Break Tex t option to break your text into separate blocks. 

Text Formats

Text

lets you import a number of different word
processing files. supports all of the file formats
listed below. To import even more documents, 
supports the MacLink Plus file translation system.
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MacWrite files are supported through the MacLink Plus
translators.

MacWrite

Microsoft Word

can place Microsoft Word through the

MacLink Plus translators.
can place WriteNow files through the

WriteNow

RTF

MacLink Plus translators.
RTF stands for “Rich Text Format.” The RTF file format
was created by Microsoft Corporation. (Microsoft also
calls RTF “Interchange Format.”) Microsoft developed
this format to allow word processing files to retain for-
matting information across different computer platforms
(between PC and Macintosh).
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has a built-in interpreter for reading RTF
files.
Bitmaps produced by MacPaint (and similar programs)
are collections of black and white pixels. MacPaint does
not support gray shades or colors, just black and white
dots at a resolution of 72 dots per inch with a maximum
document size of 8 inches by 10 inches.

MacPaint’s lowest common denominator format is some-
times thought too basic for desktop publishing. MacPaint
format, however, is offered by many inexpensive, easy-to-
use applications and scanners. 

There’s a way to make MacPaint images have an effective
resolution of 300 dpi. Here’s how: Expand your MacPaint

Graphics Formats

MacPaint

TIFF

images 4.2 times as large as needed, then—once placed in
—reduce the image to 24 percent. At 24 per-

cent, you’ll have an effective resolution of 300 dpi.
TIFF—for Tagged Image File Format—is another stan-
dard graphic format. Originally devised by Aldus
Corporation, TIFF files are now standard fare on
Macintosh, IBM, and other computers. 

TIFF was created because a standard was needed for rep-
resenting grayscale images. TIFF format is often saved
by high-end scanners and high-resolution paint and
image editing programs.

TIFF is a bitmap format that allows black and white,
grayscale, or color images at nearly any resolution, and a
variety of color models.

TIFF files can also be compressed or uncompressed.
Compression is a good idea, because photographic-quality

lets you import a number of different graphic
files into your documents. To give you the widest range of
import options, supports most of the major
graphic file formats.
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images can be quite large (1 megabyte or more in some
cases).

supports both Macintosh/Motorola and
IBM/Intel byte-ordering for all of its TIFF file format
variations:

1 bit per pixel (B & W) 

• Uncompressed

• Compressed with CCITT, LZW, LZW with
Horizontal Differencing Predictor, or PackBits

4 bits per pixel (16 grays) 

• Uncompressed

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

8 bits per pixel (256 grays) 

• Uncompressed

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

4 bits per pixel (16 palette colors) 

• Uncompressed

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

8 bits per pixel (256 palette colors) 

• Uncompressed 

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

16 bits per pixel (32 levels each of Red, Green, and Blue) 

• Uncompressed 

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

24 bits per pixel (256 levels each of Red, Green, and Blue)
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• Uncompressed 

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

24 bits per pixel CIE L*a*b

• Uncompressed 

• Compressed with LZW, LZW with Horizontal
Differencing Predictor, or PackBits

32 bits per pixel (256 levels each of Cyan, Magenta,
Yellow, and Black)

• Uncompressed 

• Compressed with LZW or LZW with Horizontal
Differencing Predictor

also accepts TIFFs with alpha channels.
However, the application ignores the alpha channels.
RIFF (Raster Image File Format) is a grayscale image for-
mat, and it supports 256 shades of gray. RIFF is the native
format of ImageStudio, an image retouching application. 

RIFF

Note: only supports grayscale RIFF files. You
cannot load color RIFF files into your documents.

JPEG (Joint Photographic Experts Group) is a highly com-
pressed bitmap file format that reduces the amount of
data needed to describe a full-color bitmap. JPEG com-

JPEG

GIF
pression can reduce 24-bit images to 1/20 of their original
file size. accepts Grayscale, RGB, and CMYK
files.
GIF (Graphics Interchange Format) is the copyright prop-
erty of CompuServe Incorporated. It was created by
CompuServe to help minimize file transfer times when
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PICT

transmitting bitmap images to and from the on-line ser-
vice. GIF images are limited to 256 colors, so TIFF is a
preferred format for color photographs.
PICT is Apple’s standard graphics format. Some PICT
files require QuickTime.

PICT files contain QuickDraw graphics and text-drawing
commands. Generally speaking, PICT graphics can be
scaled to any size without producing the jagged-looking
results common in stretched bitmaps. 

However, a PICT file can also contain bitmaps. In fact,
some painting programs, such as Studio/1, Studio/8, and
various scanners, only produce PICTs containing bitmaps

EPS
(which can be black and white, grayscale, or color at any
resolution). These PICT files are just as susceptible to
“jaggies” as MacPaint files.
EPS (Encapsulated PostScript file) is also an element-ori-
ented format. EPS files contain PostScript commands. 

EPS files may also contain low-resolution bitmaps in
PICT format for screen display in applications which
don’t support PostScript on-screen (and very few do—
Adobe Illustrator is the notable exception). 
supports EPS files with PICT or TIFF previews.

does not support plain PostScript files without
a preview.

EPS files usually contain high-quality, device-indepen-
dent images that can be scaled. 

Note: Several scanners can optionally save files in EPS
format, but it’s usually a poor choice for saving
scanned images. An EPS file of a scanned image
is typically at least twice as large as an equivalent
PICT or uncompressed TIFF file. We recommend
scanned images be saved in TIFFformat.
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APPENDIX C: FONT INFORMATION

Much like graphic or text formats, different types of fonts
exist, too. Each type of font has different built-in capabili-
ties. In order to give you the greatest latitude possible,

supports many different kinds of fonts. 

Bitmap Fonts

Bitmap fonts represent the original type of font format.
Bitmap fonts recreated the look of a typeface by arrang-
ing screen pixels or printer dots. Since each bitmap font
reproduced a typeface at a specified size, bitmap fonts of
the same typeface were typically placed together in a
suitcase file. This provided the user with access to more
than one point size for a particular font.

Bitmap fonts could be scaled to reproduce point sizes for
which the bitmap file was unavailable. However, the
appearance of these scaled fonts was unreliable.

Even when using sizes for which bitmap files were avail-
able, the fonts appeared jagged when printed. For this
reason, bitmap fonts are seldom used.

Type 1 Fonts

Developed by Adobe, Type 1 fonts differ from bitmap
fonts in that they send an outline of the typeface to the
printer instead of pixels. This provides a smoother, more
rounded looking font on printouts.

Actually, a Type 1 font makes use of two different types of
files. A suitcase of bitmap files (of different styles and
sizes) is used to simulate the typeface on-screen, while
outline files are used to reproduce the font on PostScript
laser printers. 

Many different types of fonts and font utilities exist.
supports as many different font types and

utilities as possible. In some cases, certain font utilities
are recommended, or even required, for use with the
application.

However, not all fonts or font utilities work correctly in
all programs. Certain font or font utility features can cre-
ate problems when used in . A list of typical
font types and utilities follows.

Font Types
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Type 3 Fonts

Also developed by Adobe, Type 3 fonts encapsulate
PostScript graphics into characters of a font. After releas-
ing the Type 3 font format, Adobe provided documenta-
tion for how to make Type 1 fonts. Since then, Type 3
fonts have fallen into disuse.

Multiple Master Fonts

Another font developed by Adobe, Multiple Master fonts
let users adjust a font’s weight and width. A Multiple
Master font contains four files that provide an outline of
the font at different weights and widths. The font uses
these files to interpolate the user’s desired effect.

The most common Multiple Master fonts are Adobe Sans
and Adobe Serif. These fonts accompany Adobe Acrobat
and other programs. Adobe programs use these fonts to
emulate and replace missing fonts.

Most applications do not support Multiple Master fonts.
However, fully supports them, and users can
take full advantage of their scalable features.

TrueType Fonts
Developed by Apple Computer, TrueType provides
another kind of outline font. Whereas Type 1 fonts
require different files for display and print fonts,
TrueType fonts contain information for both in one file. 

Unlike Type 1 printer files, you can place TrueType files
in a suitcase file for easier management. Sometimes
bitmap fonts reside in the same suitcase as TrueType
fonts. These bitmap fonts help display fonts at small
point sizes.

For identification purposes, the bitmap files use the font’s
actual name. The outline files use a truncated name,
where the first five letters identify the font name, and
the next three letters identify the font style. For example,
if you used a bold Palatino font in a document, the
bitmap filename would be Palatino Bold but the outline
filename would be PalatBol.

ATM (Adobe Type Manager) allows outline fonts to be
used on screen displays and QuickDraw printers. This
allows smooth font displays at any size.
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TrueType GX Fonts

Similar to regular TrueType fonts, TrueType GX fonts
contain additional features for use with Apple’s GX
Graphics extension. These additional features—called
variations, instances, and features—only work with
applications that support GX.

Variations let the user adjust the appearance of the font.
Usually this means users can adjust the font’s weight and
width (like Multiple Master fonts). However, users can
also adjust other appearance features, too. 

Note: In , Multiple Master fonts behave like
TrueType GX fonts.

TrueType GX fonts may have preset Variation settings,
called Instances. Typically, Instances set the width and
weight to give a font a certain look, like heavy, light, com-
pressed, etc.

Features include a large number of options that give the
user control over the appearance and behavior of the font.
Features let users access variant characters, activate
pairwise kerning (combining certain sets of characters
into one character), or set other typography features.

GXified TrueType Fonts

GXified fonts result when a program called the GXifier
expands the feature set of regular TrueType fonts.
GXified fonts do not have Variations or Instances, but
they do contain Features. For example, GXified TrueType
fonts allow pairwise kerning.

GX Enabled Type 1 Fonts

To use Type 1 fonts with applications that use the GX
Graphics extension, you must convert them into another
format. You can do this with an application called Type 1
Enabler. In addition to enabling Type 1 fonts, you must
have a GX aware version of ATM to use them correctly.

Running the Type 1 Enabler does not add additional fea-
tures to Type 1 fonts, as running the GXifier does to
TrueType fonts.
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Font Utilities
A wide variety of font utilities exist. All of these utilities
perform useful functions. Some conflict with .
Others are required in order to get the best performance
from your fonts.  A list of common font utilities and their
relationship with follows.

Adobe Type Manager (ATM)

ATM scales Type 1 fonts so they display and print cor-
rectly. requires ATM 4.0.2 or better. Although
older versions of ATM supported QuickDraw GX, they do
not run correctly with the GX Graphics extension cur-
rently supported by Apple.

Font Manager Extensions (Suitcase, MasterJuggler, Font Reserve, etc.)
These font utilities appear grouped together, because
they all offer the same feature: installing and unin-
stalling fonts without moving them in and out of the
Fonts folder. ATM Deluxe also provides this capability.

These utilities are conditionally compatible with
. While you can use these programs to install

fonts while running the application, does not
recognize the newly installed fonts until after you have
quit and restarted the program. Uninstalling a font that
the application uses may crash the program.

Font Menu Extensions

These utilities provide WYSIWYG and/or hierarchical
features to the Font menu. In most cases, the WYSIWYG
capability of these utilities conflict with the 
Font menu.

In addition, the Font menu already has hier-
archical features. Difficulties may result if a Font menu
extension attempts to modify the application’s hierarchi-
cal menus with its own.
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Type 1 Enabler

The Type 1 Enabler application converts Adobe Type 1
font files into a format usable by . You cannot
use Type 1 fonts with any GX application unless you first
run the Type 1 Enabler.

When you launch the Type 1 Enabler, it scans the Fonts
folder within your System folder and notifies you of any
Type 1 font that needs converting. The application then
converts all specified fonts into a format usable by
QuickDraw GX applications. The Type 1 Enabler places
the original versions of converted fonts in a folder titled
•Archived Type 1 Fonts• in the System folder.

The Type 1 Enabler makes a new outline file, based on
the printer font, for display purposes. It then places the
outline file in the font suitcase with the bitmap files of
the appropriate font. Once in the suitcase, the outline file
appears identical to a TrueType font.

can use unenabled Type 1 fonts. However, it
cannot display the fonts correctly, even if you have ATM
installed. Since does use the outline font when
printing to a PostScript printer, you should enable all
your Type 1 fonts.

GXifier

Running the GXifier adds additional tables to regular
TrueType fonts. These tables take available characters
that usually require an Option key combination to access
and makes them easier to access. In some cases, GXified
fonts replace combinations of characters with a single
character. For example, the characters a and e, when
placed next to one another, become æ.

You can use GXified fonts in non-GX applications.
However, non-GX applications cannot make use of the
added features of these fonts.
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APPENDIX D: OPENING CIF FILES
Although you can open CIF (Creator Interchange Format)
files in , you need to know that some files may
appear different in . Several reasons for this
exist. Changes may occur because handles
some information differently than Creator, or because

does not support some features that existed in
Creator (or vice versa). 

Despite the differences that exist between Multi-Ad
applications, opens CIF files and emulates
their original state as closely as possible. In most cases,
you can’t even tell that changes have occurred. However,
should you need to modify a CIF file, familiarize yourself
with how handles CIF files.

Q. How does open Creator FXs?

A. turns FX effects into external EPS files
and places them in a designated folder.

Q. How does handle borders from Creator?

A. replaces borders from Creator with its
equivalents. If no corresponding file

exists, converts Creator borders into its
native format and places them in the Borders File
folder in the Creator2 Add-Ons folder.

Q. What does do to EPS graphics enclosed in
CIF files?

A. Like Creator FX effects, takes enclosed
EPS graphics, turns them into external EPS files,
and places in a designated folder.

Q. Why don’t CIF files with dashed lines display cor-
rectly in ’s Frame Type dialog box? No
checkmark appears beside the appropriate line entry.

A. Multi-Ad Creator makes a different dash for each
type and line weight, so CIF files can contain an infi-
nite number of dashes. You can also script a dash to
anything, so an equivalent dash type might not
appear in ’s Frame Type dialog box.
Dashes only appear checked if the dash in the CIF
file directly matches an option in the dialog box.



311Reference Manual

Q. Why does the baseline of the first line in a text block
change after you open a CIF file in ?

A. uses the leading of a text block’s first line
to establish its baseline. This differs from Creator,
since that application always used the automatic
leading percentage to establish the baseline of the
first line in a text block. If the Creator document used
an auto lead percentage other than 120 percent, a dif-
ference may still appear after you open the CIF file in

. You cannot make the baseline values
exactly the same because has no global
automatic leading feature.

Q. Why doesn’t the Element Info dialog box
display the shadow colors of CIF files?

A. After opening a CIF file in , you can select
the element and the shadow separately. Creator actu-
ally treats shadows as separate elements. By default,
the application groups a shadow with the element it
shadows, but you can ungroup these elements later.

Q. Why do the italic, bold, upper case, and lower case
styles in a converted CIF appear without a check
mark in ’s Style menu?

A. If a CIF file contains fonts with applied styles,
replaces the fonts with their prestyled

equivalent, if available. For example, if a CIF file con-
tains a Palatino font with bold and italic styles
applied, replaces the font with a Palatino
Bd It font. As for upper case and lower case styles,
Creator does not recognize these styles. It just
changes the character codes used to their upper case
or lower case equivalents. 

Q. Why can’t I automatically see the invisible features of
an imported CIF file?

A. CIF files don’t contain show invisible preferences.

Q. Can I open all 40 of the spot plates that Creator sup-
ports?

A. supports 32 spot plates. If a CIF file con-
tains more than 32 spot plates, only recog-
nizes the first 32. 
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In addition to the issues mentioned above, CIF files con-
tain additional information that ignores.

cannot use this information, because it is
obsolete or because handles the information so
differently that it can’t be converted. This information
includes:

• Print colors as grays  

• Customer adjust in separations options dialog box

• PPD information 

• Spot functions  

• Black generation and undercolor removal  

• Text tagging  

• Layouts  

• Draw as rough  

• Bleed edges 
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APPENDIX E: USING MULTI-AD SEARCH
Multi-Ad Search, a program that references and catalogs
graphic files, simplifies the process of cataloging and find-
ing graphics. Each record in a Search catalog contains a
reference to a graphic’s filename, format, and location. You
can transfer this reference into in order to
place graphics in your documents.

Sending references

1. Start .

3. Choose the Search icon from the Application menu in
the upper right corner of the screen.

4. Select the references you wish to send.

5. Choose the Send References command from Search’s
File menu. A dialog box appears.

6. Select as the program to receive the refer-
ences.
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7. Click the OK button. This places the file onto the
Files palette.

You can place a file by dragging the file’s record from
Multi-Ad Search and dropping it into a 
Document Window. To make the process as easy as possi-
ble, supports many of the same file types as
Search. If you drag a file or reference into and
the Document Window does not highlight, then

cannot import that file type.

Placing an item using the drag-and-drop method

1. Open the document in which you want to
place the graphic.

2. Open the Search catalog containing the record of the
file you want to place in the document.

3. Select the record of the graphic file from the Search
catalog.

4. Drag the selected file into the Document Window. A
gray or colored outline frames the Document Window
to signify that can import the file. 

Note: You must have the original file on your
hard drive or on another volume connected
to your computer. If you do not have the
original file available, you cannot drag a
record from Search into .

5. Release the mouse button and the application centers
the file at that location.

Using Drag-And-Drop with Search
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To use the Copy Reference command and the Send
Reference command most effectively, try to run

and Search at the same time. If you wish to
use the Send Reference command or the drag-and-drop
feature, you haveto run and Search at the
same time. 

If your computer does not have enough memory to run
both and Search, you can still use the Copy
Reference command.

Note: Do not increase the amount of memory allocated
to unless you receive a dialog box that
expressly tells you to do so.

Copying references with only one program running

at a time

1. Highlight the graphic file references in Search.

2. Choose Copy from the Edit menu. This places a copy
of the references in the Clipboard.

3. Quit Search.

4. Open the document in which you want to place the
files.

5. Choose Place Graphic… from the File menu. The
Place Graphic directory dialog box appears.

6. Click the Add Search items to Filesbutton and the
filenames appear on the Files palette.

Tip: Do not cut or copy any item between quitting
Search and adding the file references to the

Files palette. Copying or cutting
another item replaces the file references in the
Clipboard with the new item.
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APPENDIX F: BORDER SAMPLES
This appendix contains samples of all the borders
included with . Each border appears listed by
name under the border file that contains it. Border files
appear in alphabetical order.

• Abstract

• Auto/Machines

• Celebration

• Children

• Corner Designs

• Coupon Borders (Fancy)

• Coupon Borders (Rounded)

• Coupon Borders (Square)

• Financial

• Flowers

• Food

• Holidays

• Home

• Line Variations

• Miscellaneous

• Nature/Animals

• Sale

• School

• Simple Patterns

• Sports/Recreation

• Tools/Industry

• Western
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Abstract

Abstract TrianglesAbstract Lines

Art Deco Braid 1

Corner Holders

CharcoalBraid 2

Clip Bar
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Geometric

Groove

Interrupting Lines

Horizontal Stripes

Crosshatch

Giraffe

Hollow Rectangles

Max Headroom
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Sawtooth

Mexican Pattern

Open Pattern Ovals and Circles

Reverse Links

Nested Squares

Shadow Squares Side Graphic
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Stacked Squares Stripes w/ Barbell

Tone Edged

Triangle

Tone Pattern w/ Black

Triangles

Vertical Stripes Waves
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Waves 2 Waves and Sound

Zig Zag 1 Zig Zag 2

Zipper Pattern

ZipperZig Zag and Spots
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Auto/Machines

Chain

Anchors Car Cartoon

Cars

Keys 1 Keys 2

Front of Car Gas Can
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Tire Tread Truck

Celebration

Clearance Tone

New Car Old Car

Piston Tire

Balloons and Confetti
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Confetti Confetti 2

Confetti and Candy Corner Stars

Pennant

Star 1

Ribbon 2

Star 2
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Stars and Stripe

Stars Italics Streamers

Sun and Stars Super Star

Star within Border
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Children

Baby Beads Diaper

Toys

3-Dot Corner Ball in Corner

Circle/Square Corner Ball

Corner Designs
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Corner Bar Configuration Corner Boxes

Corner Circles Corner Clocks

Corner Guard Corner Leaves

Corner Motif Corner Scroll
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Dashes & Dots Decorative Corners

Fancy Corners French Corners

Great Corners Hoop Corner

Lace Large Corner Design
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Rustic Sharp Corners

Siren Small Corner Design

Triangle Corner Design

Triangle Corner Frame Twisted Corners

Square Corner Indent
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Coupon Diagonal Dash

Coupon Bar/Dashed Line

Coupon Borders (Fancy)

Coupon Double Dash

Coupon Black/Dash Line

Coupon Line/DotCoupon Double Line

Coupon Round TopCoupon Rounded Bottom

Weave Corner
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Coupon Borders (Rounded)

Coupon 1-Point, Rounded Coupon 2-Point, Rounded

Coupon 3-Point, Rounded Coupon 4-Point, Rounded

Coupon 7-Point, Rounded Coupon 8-Point, Rounded

Coupon 5-Point, Rounded Coupon 6-Point, Rounded

Coupon White/Dash LineCoupon Short/Long Dash
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3-Point 4-Point

5-Point 6-Point

Coupon (Square)

1-Point 2-Point

Coupon 18-Point, Rounded

Coupon 12-Point, Rounded Coupon 15-Point, Rounded
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18-Point

12-Point 15-Point

7-Point 8-Point

Financial

Accounting Bundles of Money
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Certificate Computers

Dollar Signs Dollar Signs 2

Financial Hand with Certificates

Money
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Abstract Flower Abstract Flower 2

Block Flowers Cartoon Flowers

Dark Flower Double Flower

Double Morning Glory Flower

Flowers
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Flower Stalk Flowers & Buds

Flowers of Joy Flowers with Tulips

Flowers/Graphic FlowersFlowersFlowers

Gray Tone Flowers Lily of the Valley
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Rose Oval Rose with Leaf

Roses in the Corners Simple Flower

Tulip Sketch Tulips

Wildflowers
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Food

Banana and Peach Candy

Candy Variety Cooking Utensils

Fast Foods Fruit

Hamburger/Hot Dog Hot Dog
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Holidays

Picnic Basket

Pie Pizza

Strawberries Zig Zag Apple

Peanuts

A Christmas Wish Angel, Candy, Cookie
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Balloons and Clock Bunting and Stars

Candle and Holly Candy Cane, Gift, Santa, Tree

Christmas Bulbs Christmas Fruit, Decorative

Corner Hearts Corner Shamrock Hats
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Cross

Diamond Hearts Different Size Hearts

Double Snowflakes Dreidel

Easter Easter Eggs and Flowers

Twisted Corners
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Fireworks Four Leaf Clover

Gift Box and Holly

Hearts (Stenciled)

Hearts & Scroll 1

Hearts & Scroll 2 Hearts (Fancy)

Holly 1
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Holly 3

Holly 4 Holly 5

Holly 6 Just for Mom

Ornaments/Streamers Patriotic Stars & Stripes

Holly 2
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Presents

Reindeer and Tree Scroll Work

Shamrocks Small Double Tree

Snowflake Snowflakes

Poinsettia & Cardinal
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St. Patrick’s Day

Star of David Star of David 1

Star of David 2 Stars and Stripes

Stripes and Hearts Tree

Snowy Night
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Turkeys

Valentines

Brick Doorknob and Keyhole

Frame Molding Home

Home

Trees and Gifts
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House House with Fence

House/Leaves Plumbing

Sign Wood Motif

Home Improvement 1 Home Improvement 2
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Corner Fold Lines

Corner Indent Crosshatch

Deco 1 Deco 2

8-Stripe Bracket 1

Line Variations

Bracket 2
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Double Round 2

Double Round 3 Double Round 4

Double Corner Indent

Double Round 1

Dots and Dashes

Folded 1 Folded 2
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State Fair

Stripe-Thru Thinline Boxes

Frame 1 Piping

Ribbon Rounded Lines

Squared
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Buttons & Zig Zag Chain Link

Columns

Argyle Pattern Bubbles

Miscellaneous

Two-Tone Bar White Dashes

Curled Line
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Hearts and Apples

Microscope

Diamonds

Film Folded Stripes

Light Plaid

Diamond Shapes

Links
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Piano 2

Stamp

Photo Piano 1

Railroad 2

Railroad 1

Scroll Work

Stack
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Acorns Acorns and Leaves

Bones and Paws Butterfly

Nature/Animals

Stamp Edge Watches

Butterfly and Ribbon Dog’s Paw Print
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Maple

Palm Trees Seashell and Crabs

Ivy

Leaf/Buds Leaves 1

Leaves 2

Goldfish



356 Multi-Ad Creator2

Sun

Flag Sale Runner

Sale

Seashell and Starfish

Sale Tag Sales and Service

White Sale
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Pencils and Erasers School and Newspaper

ABCs Apple and Book

Apple and Newspaper Caps

School

Chalkboard and Apple Diploma & Mortarboard
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Notebook and Pencil Pencil

Scissors Tassel

Newspaper and Pencil NIE Newspaper
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Checkerboard Circle-Squares

Big Smiley Burst, Hollow

5-Point Star, Filled 6-Point Star, Filled

Arrows Big Checkers

Simple Patterns
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Large Checkers

Diamonds Egyptian

Hearts Inverse Plus

Large Diamonds

Large Dot Large Hearts
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Small Dot Small Hearts

Small Reverse Dot Spots

Small Checkers

Large Reverse Dot Little Smiley

Reverse Diamonds
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Basketball Pattern Bowling Balls

Camping Tents Football 1

Football 2 Football Helmets

Abstract Football Player Baseball Pattern

Sports/Recreation
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Factory

Hammer and Nails Handsaw

Tools/Industry

Graphics

Football Pattern Football Player

Golf Ball Pattern Horse and Rider
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Paint Stick

Plane Pliers

Pliers and Wrench Saw Blade

Hard Hat Level

Paint Brush
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Barbed Wire Branding Symbols

Southwest 1

Western

Rope

Scissors Screwdriver and Screw

Square and Tools
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Southwest 2 Western Corner

Wood Cut
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APPENDIX G: SCRIPTING
To let users take full advantage of the application,

fully supports AppleScript. AppleScript, an
application developed by Apple Computer Inc., lets you
record your actions and creates a file that can duplicate
them for later use. In essence, you make a list of things
you want to do, and then tell the computer to do them.

Scripts can direct to do many things. For
example, you can create a script to layout the basic
design of a page or import text from a word processor.

Recording a script
You create scripts with the Script Editor. The Script
Editor, which looks like a tape recorder, remembers the
actions you perform and places them in a list. You can
view or edit this list in the Editor window. You can also
view this list by pressing the Option key while choosing a
script name from the Script menu in .

You can record any action that changes a document. For
example, while you cannot record moving your mouse,
you can record drawing a line, because that changes the
document. You can record typing, too. When recording
text, the text you have typed does not immediately
appear in the Edito. You must wait until you perform
another action—like deleting a character or moving the
insertion point. The Script Editor does not record series
of alike actions until you perform a different action. 

Note: You cannot record scripts that change your prefer-
ences. 

Recording a script in Creator2

1. Double-click on the application. This
launches the application.

2. Choose the Hide Creator2 command in the
Application menu. This removes the 
Document Window from the screen and displays the
Finder.
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3. Locate and double-click the Script Editor icon. The
Script Editor window appears.

4. Click the Record button. Notice that a blinking cas-
sette icon appears over the Apple menu when you
enter record mode.

5. Choose the icon from the Application
menu to return to .

6. Perform the desired actions in .

7. Choose the Script Editor icon in the Application
menu to return to the Script Editor.

8. Click the Stop button. Notice that a list of your
actions appears in the scroll list at the bottom of the
window.

Note: If you receive an out of memory error while record-
ing a script, increase the amount of memory allo-
cated to the Script Editor. Do not increase

’s memory.

Running a Script
You can open and run a script in several ways. You can
use the Script Editor to open and run any script, except
those that you have saved as run-only scripts (refer to the
AppleScript read-me file for more information). 

Simply open the Script Editor. Then choose the Open
Script command from the File menu to open a directory
dialog box. Double-click on the script to open it. Finally,
click the Run button to run the script.
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You can also run a script from inside . To do this:

1. Place a script file in the Script menu folder in the
same location as the application. 

Note: The file you place in this location must be
an ordinary script file. You cannot run
run-only script files inside .

2. Open . Notice that a script icon appears
next to the View menu. This is the Script menu.

3. Pull down the Script menu. Notice that the name of
your script appears in the menu.

4. Choose the desired script to run.

If you wish to view a recorded script when in ,
press the Option key while selecting the script from the
Script menu. When you release the mouse button, the
Script Editor opens and loads the desired script.
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As you record a script, AppleScript builds a program code
that tells the computer how to recreate your actions.
Instead of hiding this code, it appears in the scroll list on
the bottom half of the Script Editor.

If you like, you can edit the code in this scroll list. What’s
more, you can even type your own scripts into the Script
Editor. If you press the Option key while opening the
Script menu and choosing a script, the Script Editor
opens and the selected script appears in the scroll list.

Editing Creator2 scripts

AppleScript Editing Techniques

One of the strengths of AppleScript is that you can edit a
script like any text document or program. This lets you
add or subtract features to scripts that you create. You
should find the available editing actions familiar, for they
include:

• Click
This action places an insertion point at the loca-
tion where you clicked.

• Click and drag
This action highlights all parts of the script con-
tained in the selection rectangle that you drag.

In this script, the code in the scroll list on the bottom half of the Script
Editor tells the program to draw a blue oval.
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• Double-click
This action highlights a single word.

• Triple-click
This action highlights an entire line.

• Option-Return
This action inserts a character (¬) that tells the
Script Editor that the sentence continues on the
next line.

• Shift-Return
This action moves the insertion point to the
beginning of the following line.

To modify a script, simply enter a new command line in
the scroll list area of the Script Editor. You can also
remove command lines from your script. If you have
questions about writing AppleScript, refer to your Apple
documentation. 

To check the accuracy of your changes, click the Check
Syntax button on the right-hand side above the scroll list
area. If the Script Editor encounters an error in a script,
a warning dialog box appears and the Editor doesn’t
apply any formatting to the script. If you have no errors
in your edited scripts, the Script Editor compiles the
AppleScript code.

For example, you may wish to reproduce your company
logo, a red square inside a blue oval, in . You
open the Script Editor, click the Record button and then
draw and color the elements. You name the script Logo
and save it in your Script Menu folder in the same folder
where you have the application. However,
after doing this, you decide that you want the script to
place the rectangle inside the oval, too. So you need to
edit the existing script.
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1. Press the Option key while pulling down on the Script
menu in .

2. Choose Logo from the Script menu. Do not release the
Option key. Pressing the Option key while choosing a
script name opens the Script Editor with the selected
script loaded.

3. Enter move rectangle of spread 1 of document 1 t o
beginning of oval of spread 1 of document 1 before the
end tell command. This command line tells 
to contain the rectangle of the current document page
inside the oval on the same page.

4. Click the Check Syntax button. A dialog box appears.

This means that you have not correctly identified
which rectangle you wish to move. Even though you
have only created one rectangle, the Script Editor



373Reference Manual

still identifies the rectangle as rectangle element 1 .
Likewise, it recognizes the oval you drew as oval ele -
ment 1 . Therefore, you must change your script to
reflect these names.

Your script now looks like this:

5. Click the Run button. This lets you test your script.
You see the application create the two shapes and fill
them with the right colors. However, the square dis-
appears. 

In , if you select the oval and choose the
Open Element… command from the Elements menu,
you see that the oval does, in fact, contain the square.
Although the square rests inside the circle, it hasn’t
moved from its point of origin. 

So, you need to edit your script once again. This time
you must to include information that tells 
how far it needs to move the square.

7. Choose the Script Editor option from the Application
menu.

8. Enter the coordinates where you wish to move the
square. Remember that the upper left-hand corner of
the screen represents coordinates 0, 0.
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The resulting script may look like this:

9. Click the Check Syntax button. This time, the Script
Editor finds no errors.

10. Save your changes to the script and quit the Script
Editor. You must quit and restart for your
changes to take effect.

11. Choose the Logo script from the Script menu. You see
draw the oval and square, fill them with

the appropriate colors, and place the square at the
proper location inside the oval. Your logo now looks
like this:
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Mask Graphic . . . . . . . . . 80, 103, 113-115

Adobe Photoshop™ masks . . . 80, 114
Mask as path element  . . . . . . . . . 113
Mask with bitmap  . . . . . . . . . 103, 115
Removing a mask  . . . . . . . . . . . . 114

Master Spreads…  . . . . 198, 200-201, 297
MasterJuggler  . . . . . . . . . . . . . . . . . . 308
Mac Easy Open  . . . . . 6, 16, 34, 299-300

MacLink Plus  . . . . . . . . . 16, 299-300
Method pop-up menu . . . . . . . . . . . . . . 27
Microsoft Word . . . . . . . . . . . . . . . . . . 300
Millimeters  . . . . . . . . . . . . . . . . . . . . . . 77
Misregistration  . . . . . . . . . . . . . . . . . . 107
Move Backward command  . . . . . . . . . 129
Move Forward command  . . . . . . . . . . 129
Moving elements  . . . . . . . . . . . . . . . . 252
Multi-Ad Search  . . . . . . 102, 190, 313-315

Copy Reference command . . . . . . 315
Placing an item 
with drag-and-drop . . . . . . . . . . . 314

Sending references . . . . . . . . 313-315
Multiple Master fonts  . . . . . . . . . 306, 307

N-O
New Document  . . . . . . . . . . . . . . . . . . 5-8
New Window command  . . . . . . . 236, 237
Newline equivalent  . . . . . . . . . . . . . . . 73
New… command  . . . . . . . . . . . . 5-8, 198
Next ¶ style  . . . . . . . . . . . . . . . . . . . . 176
Non-PostScript printers  . . . . . . . . . . . . 35
None option  . . . . . . . . . . . . . . . . . . . 298
Number of pages  . . . . . . . . . . . . . . . . . . 5
Offset command  . . . . . . . . . . . . . . . . 172
Offset Horiz  . . . . . . . . . . . . . . . . . . . . 161
Offset Vert  . . . . . . . . . . . . . . . . . . . . . 161
Offset…  . . . . . . . . . . . . . . . . . . . . . . . 147
Open CIF  . . . . . . . . . . . . . . . . . . see CIF
Open Element  . . . . . . . . . . . . . . 105, 262

Opening containers  . . . . . . . . . . . . . . 262
Opening line segments . . . . . . . . . . . . 273
Open…  . . . . . . . . . . . . . . . . . . . . . . . . . 9
OPI (Open Pre-press Interface)  . . . 31-32, 

50-51
Always add OPI comments
for TIFF files . . . . . . . . . . . . . . . . . 31

Omit PostScript for TIFF files  . . . . 31
Omit PostScript® for TIFF files  . . . 51
Substitute OPI comments

for EPS files  . . . . . . . . . . . . . 32, 51
Send OPI comments 

for all TIFF files  . . . . . . . . . . . . . . 51
Ornaments  . . . . . . . . . . . . . . 48, 156, 195
Outline . . . . . . . . . . . . . . . . . . . . . . . . 146
Outset text field  . . . . . . . . . . . . . . . . . . 97
Oval button  . . . . . . . . . . . . . . . . . . . . 120
Oval tool  . . . . . . . . . . . . . . . . . . . . . . 279
Overflowed text  . . . . . . . . . . . . . . . . . 225
Overprint  . . . . . . . 91, 93, 95, 97, 107-108

P
Page Border and Fill  . . . . . . . . . . . . . 297
Page Manager… . . . . . . . . . . . . . 197-200

Deleting pages  . . . . . . . . . . . . . . 200
Inserting pages  . . . . . . . . . . . . . . 199

Page number equivalent  . . . . . . . . . . . 73
Page Setup…  . . . . . . . . . 35-46, 196, 306

Custom paper size  . . . . . . . . . 38, 42
Default printer resolution  . . . . . . . . 39
Default screen frequency 
or density  . . . . . . . . . . . . . . . . . . 39

Flatness limiting  . . . . . . . . . . . 31, 43
Level 2 PostScript  . . . . . . . . . . . . . 39
Non-PostScript printers  . . . . . . . . . 35
Page size outlines  . . . . . . . . . . 35-36
Paper outlines  . . . . . . . . . 35-36, 196
PostScript Printer Description 
(PPD)  . . . . . . . . . . . . . . . . 39-40, 45

QuickDraw printers  . . . . . . 35-38, 306
Resolution limiting  . . . . . 30-31, 38, 43
Separation options . . . . . . . . . . . . . 39
Tiling  . . . . . . . . . . . . . . . . . . . . 39, 44

Page size outlines  . . . . . . . . . . . . . 35-36
Paint  . . . . . . . . . . . . . . . . . . . . . . 15, 115
PANTONE color system  . . . . . . . . . . . 208
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Paper outlines  . . . . . . . . . . . . 35-36, 196
Paragraph styles  . . . . . . . . 164, 175-179, 

181-184, 218, 289
Adding paragraph formats  . . . . . . 179
Creating paragraph styles  . . . . . . 175
Editing paragraph 
and type styles . . . . . . . . . . . . . . 178

Paragraph…  . . . . . . . . . . . . 163-164, 174
Adding space 
before/after paragraphs  . . . . . . . 164

Paste  . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Paste Type Specs  . . . . . . . . . . . . . . . . 64
Paste ¶ Specs  . . . . . . . . . . . . . . . . 65, 67
Pasteboard area size  . . . . . . . . . . . . 188
Path element . . . . . 112-113, 273, 281-282

A mask as a path element  . . . . . . 113
Close a path element  . . . . . . . . . . 273
Path editing  . . . . . . . . . . . . . . . . . 273
Opening line segments  . . . . . . . . 273

Path tool  . . . . . . . . . . . . . . . . . . . . . . 281
Pen Weight… . . . . . . . . . . . . . . . . . . . 115
Photoshop files  . . . . . . . . . . . . . . . . 13-14
Picas  . . . . . . . . . . . . . . . . . . . . . . . . . . 77
PICT  . . . . . . . . . . . . 13-15, 104, 117-118, 

125, 287, 304
Place Graphic…  . . . . 13-17, 19, 286, 287

Place by hand  . . . . . . . . . . . . . . . . 19
Place with cursor  . . . . . . . . . . . 15, 17
Placing a graphic file  . . . . . . . . . . . 14
Placing a graphic file 

from the desktop  . . . . . . . . . . . . . 16
Place text . . . . . . . . . . . . . see Import Text
Plain Text  . . . . . . . . . . . . . . . . . 146, 158
Points  . . . . . . . . . . . . . . . . . . . . . 77, 271
PostScript  . . . . . . . . . . 26, 28, 46, 49-51, 

287, 304-306
PostScript device  . . . . 35, 39-40, 43, 239
PostScript Printer Description 
(PPD)  . . . . . . . . . . . . . . . . . . . . 39-40, 45
Pre-press definitions  . . . . . . . . . . . . . 107
Preferences…  . . . . . . . . . . 28, 76-87, 98, 

189, 191
Document Sizes  . . . . . . . . . . . . . . 81
General  . . . . . . . . . . . . . . . . . . 76-78
Status Labels  . . . . . . . . . . . . . . . . 86
Text panel  . . . . . . . 28, 83-84, 98, 191

Text overflow  . . . . . . . . . . . . . . 28

Preview Depth  . . . . . . . . . . . . . . . . . . . 80
Preview Resolution  . . . . . . . . . . . . . . . 79
Preview Type pop-up menu  . . . . . . . . . 27
Printer driver  . . . . . . . . . . . . . . . . . 35, 47
Printer’s Points  . . . . . . . . . . . . . . . . . . 77
Print…  . . . . . . . . . . . 30-32, 35, 38, 47-51, 

156, 195
Color PostScript  . . . . . . . . . 30, 49-50
Creator2 print  . . . . . . . . . . . . . . . . 50
OPI (Open Pre-press

Interface)  . . . . . . . . . . 31-32, 50-51
Ornaments  . . . . . . . . . . 48, 156, 195
Print color bars  . . . . . . . . . . . . . . . 49
Print crop marks  . . . . . . . . . . . . . . 49
Print document description  . . . . . . 48
Print EPS spot colors 

as process  . . . . . . . . . . . . . . . . . 49
Print plate information  . . . . . . . . . . 49
Print registration marks  . . . . . . . . . 48
Print selected items only  . . . . . . . . 48
Print text blocks only  . . . . . . . . . . . 48
Printer driver  . . . . . . . . . . . . . . 35, 47
Screen  . . . . . . . . . . . . . . . . . . 38, 44
Separation plates  . . . . . . . . . . . . . 48

Process option  . . . . . . . . . . . . . . . . . 210
Proportional  . . . . . . . . . . . . . . . . . 58, 168

Q-R
Quad Leader  . . . . . . . . . . . . . . . . . . . 165
QuickDraw printers  . . . . . . . . . 35-38, 306
Quit  . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Rectangle corners  . . . . . . . . . . . . 266-267
Rectangle tool  . . . . . . . . . . . . . . . . . . 279
Redo command  . . . . . . . . . . . . . . . . . . 53
Reduce command  . . . . . . . . . . . . . . . 239
Reformatting characters  . . . . . . . . . . 155
Registration marks . . . . . . . . . 48, 195-196
Replacing graphics  . . . . . . . . . . . . . . 233
Returns and Newlines (invisible)  . . . . 188
Reshape tool  . . . . . . . . 111-113, 265-267, 

270-273
Reshaping path elements . . . . . . . 272
Reshaping rectangles  . . . . . . 266-267
Reshaping starbursts . . . . . . . 267-272

Alternation field  . . . . . . . . . . . 271
Randomization  . . . . . . . . 271-272
Round Peaks  . . . . . . . . . . . . 270
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Round Valleys  . . . . . . . . . . . . 270
Path editing in Reshape mode  . . . 273

Close a path element  . . . . . . 273
Opening line segments  . . . . . 273
Toggling point types  . . . . . . . 273

Smoothing 
control points . . . . . . . . . 272

Unsmoothing 
control points . . . . . . . . . 272

Resizing elements  . . . . . . . . . . . . . . . 252
Resizing text blocks/shapes  . . . . . . . . 260
Resolution limiting  . . . . . . . . 30-31, 38, 43
Rich Text Format (RTF)  . . . . . . 33-34, 300
Right command  . . . . . . . . . . . . . . . . . 151
Right Indent  . . . . . . . . . . . . . . . . . . . . 164
RGB . . . . . . . . . . . . . . . . . . . . . . 207, 210
RIFF  . . . . . . . . . . . . 13, 31, 113, 287, 303
Rotation  . . . . . . . . . . . . . 89, 56, 274-275
Rotate tool  . . . . . . . . . . . . . . . . . 274-275
Rows  . . . . . . . . . . . . . . . . . . . . . . 57, 143
Rulers  . . . . . . . . . . . . . . 77, 241-242, 171

Setting Measurement Units  . . . . . . 77
Setting zero points  . . . . . . . . . . . . 242

S
Save As…  . . . . . . . . . . . . . . . . . . . . . . 11
Save Default Document Settings  . . . 8, 12
Save…  . . . . . . . . . . . . . . . . . . . . . . 10-11
Scale Horiz  . . . . . . . . . . . . . . . . . . . . 161
Scale text  . . . . . . . . . . . . . . . . . . . . . . 57
Scale to Fit . . . . . . . . . . . . . . 58, 168, 263
Scale Vert  . . . . . . . . . . . . . . . . . . . . . 161
Screen Margins  . . . . . . . . . . . . . . . . . . 77
Script Editor  . . . . . . . . . . . . . . . . 367-374

AppleScript  . . . . . . . . . . 367, 370-371
Editing a script . . . . . . . . . . . . . . . 370
Running a script  . . . . . . . . . . 368-369
Recording a script  . . . . . . . . . . . . 367
Script menu  . . . . . . . . . . . . . 372, 374

Search  . . . . . . . . . . . see Multi-Ad Search
Searching for special characters  . . . . . 73
Select All  . . . . . . . . . . . . . . . . . . . . . . . 55
Send to Back  . . . . . . . 129, 134, 248, 292
Separation options  . . . . . . . . . . . . . . . . 39
Separation submenu  . . . . . . . . . 239-240
Setup Guides…  . . . . . . 139-141, 144, 242

Setting custom guides  . . . . . . . . . 141

Setting grids . . . . . . . . . . . . . . . . . 140
Shadow Color  . . . . . . . . . . . . . . . . . . 162
Shadow  . . . . . . . . . . . . . . . . . . . . . . . 146
Shadow Gradient…  . . . . . . . . . . . . . . 126
Shadow Options…  . . . . . . . . . . . . . . . 125
Shadow Texture…  . . . . . . . . . . . . . . . 125
Sharing Setup control panel  . . . . . . . . 77
Show Preview  . . . . . . . . . . . . . . . . . . . 15
SimpleText  . . . . . . . . . . . . . . . . . . . 33-34
Size menu  . . . . . . . . . . . . . . . . . . . 4, 148
Size pop-up menu  . . . . . . . . . . . . 25, 293
Size/Leading…  . . . . . . . 85, 157, 169, 192

Leading text field  . . . . . . . . . 157, 192
Setting interval value pt.  . . . . . . . . 85

Skew tool . . . . . . . . . . . . . . . . . . . . . . 276
“Smart Quotes” . . . . . . . . . . 154, 158, 192
Smoothing control points  . . . . . . . . . . 272
Space After ¶  . . . . . . . . . . . . . . . . . . . 164
Space Before ¶  . . . . . . . . . . . . . . . . . 164
Spacing  . . . . . . . . . . . . . . . . . . . . . . . . 57
Spelling  . . . . . . . . . . . . . . . . . . . 152, 228
Spelling Rules…  . . . . . . . . . . . . . 227-229
Spot color  . . . . . . . . . . . . . . 81, 210, 240
Spread  . . . . . . . . . . . . . . . . . . . . . . . 108
Spread Knockout  . . . . 91, 93, 95, 97, 110
Standard Advertising Unit (SAU)  . . . . . . 6
Starburst tool  . . . . . . . . . . . . . . . . . . . 280
Startup attributes  . . . . . . . . . . . . . . . . . 79
Style buttons  . . . . . . . . . . . . . . . . . . . 293
Style menu  . . . . . . . . . . . . . . . 4, 145-147
Style models  . . . . . . . . 177-178, 181-184, 

218, 289-291, 289
Assigning a type style, 
paragraph style, or style model . . . 289
Assigning element styles  . . . . . . . 291
Assigning paragraph styles  . . . . . 290
Assigning style models . . . . . . . . . 291
Assigning type styles  . . . . . . . . . . 289
Creating new style models  . . . . . . 177
Modifying style models . . . . . . . . . 178

Style name  . . . . . . . . . . . . . . . . 174, 176
Styles command  . . . . . . . . . . . . . . . . 246
Styles palette  . . . . . . . 106, 177, 185-186, 

220-222, 246, 250, 289-291
Element Styles icon  . . . . 220, 291
Paragraph Styles icon  . . 220, 290
Style Models icon . . . . . . 220, 291
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Type Styles icon . . . . . . . 220, 289
Subscript command  . . . . . . . . . . . . . . 147
Suitcase . . . . . . . . . . . . . . . . . . . . . . . 308
Superior command  . . . . . . . . . . . . . . 147
Superscript command  . . . . . . . . . . . . 147

T
Tab equivalent  . . . . . . . . . . . . . . . . . . . . 3
Tabs and Quads (invisibles)  . . . . . . . . 188
Tags  . . . . . . . . . . . . . . . . . . . 84, 181-286

Applying tags 
from the Files palette  . . . . . . . . . 186

Applying tags 
while breaking text  . . . . . . . . . . . 185

Applying tags 
while placing a text file  . . . . . . . . 185

Inserting tags into text  . . . . . . . . . 186
Making a tag  . . . . . . . . . . . . . . . . 181
Tag delimiters  . . . . . . . . . . . . . . . . 84

Television Magazine Advertising Unit
(TMAU)  . . . . . . . . . . . . . . . . . . . . . . . . . 7
Text blocks  . . . . . . . . . . . . . 104, 253-256

Background color  . . . . . . . . . . . . 104
Creating text blocks 
of different shapes  . . . . . . . . . . . 256

Text color  . . . . . . . . . . . . . . . . . . . . . . 162
Text counts  . . . . . . . . . . . . . . . . . . . . . 99
Text files . . . . . . . . . . . . . . . . . 22, 84, 181

Placing text by hand  . . . . . . . . . . . 19
Text shapes  . . . . . . . . . . . . . . . . . . . . 256
Text Styles…  . . . . . . . . 174, 180, 218-222

Creating a text style  . . . . . . . . . . . 220
Deleting a text style  . . . . . . . . . . . 222
Editing a text style  . . . . . . . . . . . . 221
Exporting a text style  . . . . . . . . . . 219
Importing a text style  . . . . . . . . . . 219

Text tool . . . . . . . . . 2, 145, 150, 153, 155, 
163, 253, 259

Keyboard shortcut  . . . . . . . . . . . . . . 2
Text-Only fill  . . . . . . . . . . . . . . . . . . . 299
Text overflow  . . . . . . . . . . . . . . . . . . . . 28
Texture  . . . . . . . 90, 92-96, 117, 118, 125
Thin space  . . . . . . . . . . . . . . . . . . 73, 188
TIFF  . . . . . . . . . . . . . . . 13-15, 22, 31, 51, 

113, 115, 287, 301-304
Tiling  . . . . . . . . . . . . . . . . . . . . . . . 39, 44
Tools palette  . . . . . . . . 105, 113-114, 145, 

244, 250-253, 256, 259, 
261-265, 277-281

Arrow tool  . . . . . . . . . . . . . . . . . . 251
Border tool . . . . . . . . . . . . . . . . . . 278
Containment tool  . . 105, 113-114, 261
Cropping tool  . . . . . . . . . . . . . . . . 265
Flip tool  . . . . . . . . . . . . . . . . . . . . 277
Freehand Drawing tool . . . . . . . . . 280
Line tool . . . . . . . . . . . . . . . . . . . . 278
Oval tool  . . . . . . . . . . . . . . . . . . . 279
Path tool  . . . . . . . . . . . . . . . . . . . 281
Rectangle tool  . . . . . . . . . . . . . . . 279
Reshape tool . . . . . . . . . . . . . 111-113, 

265-267, 272
Rotate tool . . . . . . . . . . . . . . . . . . 274
Skew tool . . . . . . . . . . . . . . . . . . . 276
Starburst tool  . . . . . . . . . . . . . . . . 280
Text tool . . . . . . . . 145, 150, 153, 155, 

163, 253, 259
Tracking…  . . . . . . . . . . . . . . . . . 146, 170

Setting tracking  . . . . . . . . . . . . . . 170
Keyboard shortcut  . . . . . . . . . . . . . 85

Translation Manager  . . . . 16, 34, 299-300
MacLink Plus  . . . . . . . . . 16, 299-300

Trapping  . . . . . . . . . . . 79, 91, 93, 95, 97, 
107-110, 248

Elements and trapping  . . . . . . . . . 110
Trapping options  . . . . . . . . . . 107-109
Trapping palette  . . . . . . . . . . 107, 248

TrueType fonts  . . . . . . . . . . . . . . 306, 309
TrueType GX fonts . . . . . . . . . . . . . . . 307
Type 1 Enabler . . . . . . . . . . . . . . 307, 309
Type 1 fonts . . . . . . . . . . . . . 305-307, 309
Type 3 fonts  . . . . . . . . . . . . . . . . . . . . 306
Type notation  . . . . . . . . . . . . . . . . . . . 296
Type pop-up menu  . . . . . . . . . . . . . . 101
Type Specification Increment  . . . . . . . . 85
Type styles  . . . . . . . . . . . . . 156, 173-179, 

181-184, 192, 218, 289
Adding type styles  . . . . . . . . . . . . 179
Creating Type Styles  . . . . . . . . . . 173
Editing paragraph  

and type styles . . . . . . . . . . . . . . 178

U-Z
Underline command  . . . . . . . . . . . . . 146
Undo command  . . . . . . . . . . . . . . . . . . 52
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Ungroup command  . . . . . . . . . . . . . . 137
Unlock command  . . . . . . . . . . . . . . . . 27
Unsmoothing control points  . . . . . . . . 272
Upper Case command  . . . . . . . . . . . . 147
User Dictionaries…  . . . . . . . 224, 227-229
User Name  . . . . . . . . . . . 76-77, 114, 189

Author field  . . . . . . . . . . . . . . 76, 189
Entering your User name  . . . . . . . 76

Variable paper sizes support  . . . . . . . . 39
Vertical offset  . . . . . . . . . . . . 85, 158, 172

Setting the vertical offset  . . . . . . . 172
Setting interval value  . . . . . . . . . . . 85

Vertical Scale  . . . . . . . . . . . . . . . . 98, 103
View menu  . . . . . . . . . . . . . . . . . . . . 236
Widget  . . . . . . . . . . . . . . . . . . . . . . . . 253
Wrap Text… command  . . . . . . . . 132-133
WriteNow  . . . . . . . . . . . . . . . . . . . . . . 300
Zero points  . . . . . . . . . . . . . . . . . . . . 242
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